Version 6.0

This Computer program (including software design, programming structure, graphics, manual, and on-line help) was created and published by STRUCTUREPOINT, formerly the Engineering Software Group of the Portland Cement Association (PCA), for engineering design and investigation of reinforced concrete sections subject to axial and flexural loads.

While STRUCTUREPOINT has taken every precaution to utilize the existing state-of-the-art and to assure the correctness of the analytical solution techniques used in this program, the responsibilities for modeling the structure, inputting data, applying engineering judgment to evaluate the output, and implementing engineering drawings remain with the structural engineer of record. Accordingly, STRUCTUREPOINT does and must disclaim any and all responsibility for defects or failures of structures in connection with which this program is used.

Neither this manual nor any part of it may be reproduced, edited, or altered by any means electronic or mechanical or by any information storage and retrieval system, without the written permission of STRUCTUREPOINT LLC.

All products, corporate names, trademarks, service marks, and trade names referenced in this material are the property of their respective owners and are used only for identification explanation without intent to infringe. spColumn® is a registered trademark of STRUCTUREPOINT LLC.

Copyright © 2002 – 2017, STRUCTUREPOINT LLC All Rights Reserved.
Chapter 1: INTRODUCTION

1.1 Introduction..........................................................................................................................10
1.2 Program Features ...............................................................................................................10
1.3 Program Capacity ..............................................................................................................11
1.4 System Requirements ........................................................................................................11
1.5 Terms ..................................................................................................................................12
1.6 Conventions .......................................................................................................................12
1.7 Installing, Purchasing and Licensing spColumn.............................................................13

Chapter 2: METHOD OF SOLUTION

2.1 Definitions and Assumptions ............................................................................................16
2.2 Conventions .......................................................................................................................23
2.3 Section Investigation Mode ...............................................................................................26
   2.3.1 Loading Options .......................................................................................................26
   2.3.2 Interaction Diagram Options ....................................................................................30
2.4 Section Design Mode ........................................................................................................31
2.5 Moment Magnification at Ends of Compression Member ................................................32
2.6 Moment Magnification along Length of Compression Member .......................................35
2.7 Moments Magnification Ratio ...........................................................................................40
2.8 References ..........................................................................................................................41

Chapter 3: spColumn INTERFACE

3.1 spColumn Interface .........................................................................................................44
3.2 File Menu ..........................................................................................................................45
3.3 Input Menu .......................................................................................................................47
3.4 Solve Menu .......................................................................................................................49
3.5 View Menu ........................................................................................................................50
3.6 Options Menu ....................................................................................................................52
3.7 Help Menu ........................................................................................................................53

Chapter 4: OPERATING spColumn

4.1 Introduction .......................................................................................................................57
4.2 Creating New File .............................................................................................................57
4.3 Opening File ......................................................................................................................57
4.4 Saving File .........................................................................................................................58
  4.4.1 Save the data with the same file name ......................................................................59
  4.4.2 Change format or rename the file .............................................................................59
4.5 Most Recently Used Files (MRU) .....................................................................................60
4.6 Importing ...........................................................................................................................60
  4.6.1 Importing Data ........................................................................................................60
  4.6.2 Importing DXF Files ...............................................................................................61
4.7 Exporting ...........................................................................................................................63
4.8 Revert ...................................................................................................................................64
4.9 Printing ...................................................................................................................................64
  4.9.1 Print Screen .............................................................................................................64
  4.9.2 Print Report ............................................................................................................65
4.10 General Information .......................................................................................................66
4.11 Material Properties .......................................................................................................66
4.12 Section / Rectangular .................................................................................................67
  4.12.1 Input for the Investigation Option: .......................................................................67
  4.12.2 Input for the Design Option: ..............................................................................67
4.13 Section/Circular ...........................................................................................................68
  4.13.1 Input for the Investigation Option: .......................................................................68
  4.13.2 Input for the Design Option: ..............................................................................68
4.14 Reinforcement/All Sides Equal .....................................................................................68
  4.14.1 Input for the Investigation Option: .......................................................................68
  4.14.2 Input for the Design Option: ..............................................................................69
4.15 Reinforcement/Equal Spacing .......................................................................................69
  4.15.1 Input for the Investigation Option: .......................................................................69
  4.15.2 Input for the Design Option: ..............................................................................69
4.16 Reinforcement/Sides Different ......................................................................................70
  4.16.1 Input for the Investigation Option: .......................................................................70
  4.16.2 Input for the Design Option: ..............................................................................70
4.17 Reinforcement/Irregular Pattern ...................................................................................71
4.18 Reinforcement/Confinement .........................................................................................72
4.19 Reinforcement / Design Criteria ..................................................................................73
4.20 Slenderness / Factors ...................................................................................................74
4.21 Slenderness / Design Column ......................................................................................74
4.22 Slenderness / Columns Above and Below ....................................................................75
4.23 Slenderness / X-Beams ...............................................................................................76
4.24 Slenderness / Y-Beams ...............................................................................................77
4.25 Loads / Factored ............................................................................................................77
Chapter 5: EXAMPLES

5.1 Example 1 - Capacity of a Square Column

5.1.1 Problem Formulation

5.1.2 Preparing Input

5.1.3 Assigning Properties

5.1.4 Solving

5.1.5 Viewing and Printing Results

5.2 Example 2 - Investigation of a Slender Column - Nonsway Frame

5.2.1 Problem Formulation

5.2.2 Preparing Input

5.2.3 Assigning Properties

5.2.4 Solving

5.2.5 Viewing and Printing Results
5.3 Example 3 - Design of a Slender Column - Sway Frame ................................................115
  5.3.1 Problem Formulation ..........................................................................................115
  5.3.2 Preparing Input ...............................................................................................115
  5.3.3 Assigning Properties .......................................................................................116
  5.3.4 Solving ............................................................................................................120
  5.3.5 Viewing and Printing Results .........................................................................120
5.4 Example 4 - Investigation of Concrete Shear Wall Capacity ......................................126
  5.4.1 Problem Formulation .......................................................................................126
  5.4.2 Assigning Properties .......................................................................................131
  5.4.3 Solving ............................................................................................................132
  5.4.4 Viewing and Printing Results .........................................................................132
5.5 Example 5 - Capacity of an Irregular Section ...............................................................137
  5.5.1 Problem Formulation .......................................................................................137
  5.5.2 Preparing Input ...............................................................................................138
  5.5.3 Assigning Properties .......................................................................................138
  5.5.4 Solving ............................................................................................................140
  5.5.5 Viewing and Printing Results .........................................................................140
5.6 Example 6 - Investigation of a Rectangle Short Column ..............................................146
  5.6.1 Problem Formulation .......................................................................................146
  5.6.2 Preparing Input ...............................................................................................146
  5.6.3 Assigning Properties .......................................................................................146
  5.6.4 Solving ............................................................................................................148
  5.6.5 Viewing and Printing Results .........................................................................148

Chapter 6: spSection MODULE

6.1 Introduction ...........................................................................................................154
6.2 Main Menu ...........................................................................................................155
6.3 View Menu ..........................................................................................................155
6.4 Toolbar - General ................................................................................................158
6.5 Toolbar - Modify ..................................................................................................158
6.6 Toolbar - Draw ......................................................................................................159
6.7 Toolbar - Reinforcement ......................................................................................159
6.8 Toolbar - Reshape .................................................................................................160
6.9 Toolbar - Misc ......................................................................................................160
6.10 Toolbar - DXF .....................................................................................................161
Chapter 7: spReporter MODULE

7.1 Introduction ..................................................................................................................164
7.2 Toolbar ..........................................................................................................................165
7.3 Export / Print Panel .......................................................................................................166
7.4 Explorer panel ...............................................................................................................167

Chapter 8: spResults MODULE

8.1 Introduction ..................................................................................................................170
8.2 Toolbar ..........................................................................................................................170
8.3 Explorer panel ...............................................................................................................172

Chapter: APPENDIX

A.1 Import File Formats ......................................................................................................174
A.1.1 Service Loads Data: .................................................................................................174
A.1.2 Factored Loads Data: ...............................................................................................174
A.1.3 Reinforcement Data: ...............................................................................................175
A.1.4 Geometry Data: .......................................................................................................175
A.2 spColumn Text Input (CTI) file format .........................................................................176
A.3 Conversion Factors - English to SI ...............................................................................191
A.4 Conversion Factors - SI to English .............................................................................192
A.5 Material Strength Value Limits ....................................................................................193
A.6 Contact Information ....................................................................................................194
1.1 Introduction

spColumn is a software program for the design and investigation of reinforced concrete sections subject to axial and flexural loads. The section can be rectangular, round or irregular, with any reinforcement layout or pattern. Slenderness effects can be considered.

The program offers investigation of irregularly shaped, reinforced concrete column sections that may contain openings or boundary elements. Widely used for design of shear walls, bridge piers as well as typical framing elements in buildings, spColumn can investigate sections that are impossible to find on design charts or do by hand calculations. You can obtain the P-M interaction diagrams from both uniaxial and biaxial runs, as well as the $M_x$-$M_y$ moment contour plots from biaxial runs for even the most irregular column and shear wall sections. Slenderness effects producing magnified moments may be included in the investigation.

1.2 Program Features

- Code support for ACI 318-14, ACI 318-11, ACI 318-08, ACI 318-05, ACI 318-02
- Code support for CSA A23.3-14, CSA A23.3-04, and CSA A23.3-94
- English and SI units
- Design and investigation run options
- Uniaxial or biaxial flexure combined with axial load
- Rectangular, circular, and irregular section geometry
- Non-slender and sway or nonsway slender columns
- Complete P-M and $M_x$-$M_y$ interaction diagrams
- Customizable view of interaction diagrams
- Superposition of interaction diagram from a different run
- Factored, unfactored, axial, and control points loading
- Binary (COL) and text (CTI) input file formats
- Graphical input for irregular sections
- Imports geometry, reinforcement, and loads from text files
- Imports section shape and reinforcement from DXF files
- Exports section shape and reinforcement to DXF files
• spSection module for creating and modifying irregular sections
• spResults module for viewing and exporting input and output data
• spReporter module for generating, viewing, exporting and printing results
• Exports graphical reports (screen printouts) to EMF files
• Exports P-M diagrams, Mx-My diagrams, and 3D failure surface to TXT and CSV files
• GUI (Graphical User Interface) and batch mode (command prompt) runs
• Reports neutral axis location and maximum steel strain corresponding to section capacity
• Reports neutral axis location, net tensile steel strain, and strength reduction factors in text output

1.3 Program Capacity

• 10,000 reinforcing bars within a section.
• 10,000 exterior points that define the geometric outline of the cross section (spSection module).
• 10,000 interior points that define an opening in the cross section (spSection module).
• 10,000 factored load entries, each consisting of an axial load, a moment about the x-axis, and a moment about the y-axis.
• 50 service load entries, each consisting of dead, live, wind, earthquake, and snow axial loads, moments at column top about the x and y axes, and moments at column bottom about the x and y axes.
• 50 load combinations.

1.4 System Requirements

Any computer running Microsoft Windows Vista SP2, Windows 7, Windows 8, or Windows 10 operating system with 32 or 64 bit processing is sufficient to run the spColumn program. For instructions on how to troubleshoot system specific installation and licensing issues, please refer to support pages on StructurePoint website at www.StructurePoint.org.
1.5  Terms

The following terms are used throughout this manual. A brief explanation is given to help familiarize you with them.

**Windows** refers to the Microsoft Windows environment as listed in System Requirements.

[ ] indicates metric equivalent

**Click on** means to position the cursor on top of a designated item or location and press and release the left-mouse button (unless instructed to use the right-mouse button).

**Double-click on** means to position the cursor on top of a designated item or location and press and release the left-mouse button twice in quick succession.

1.6  Conventions

To help you locate and interpret information easily, the spColumn manual adheres to the following text format.

*Italic* indicates a glossary item, or emphasizes a given word or phrase.

**Bold** indicates the name of a menu or a menu item command such as File or Save.

**Mono-space** indicates something you should enter with the keyboard. For example “c:\*.txt”.

**KEY + KEY** indicates a key combination. The plus sign indicates that you should press and hold the first key while pressing the second key, then release both keys. For example, “ALT + F” indicates that you should press the “ALT” key and hold it while you press the “F” key. then release both keys.

**SMALL CAPS** Indicates the name of an object such as a dialog box or a dialog box component. For example, the OPEN dialog box or the CANCEL or MODIFY buttons.
1.7 Installing, Purchasing and Licensing spColumn

For instructions on how to install, purchase, and license StructurePoint software please refer to support pages on StructurePoint website at www.StructurePoint.org.
CHAPTER 2

METHOD OF SOLUTION

2.1 Definitions and Assumptions ......................................................... 16
2.2 Conventions ......................................................................................... 23
2.3 Section Investigation Mode ................................................................. 26
  2.3.1 Loading Options ........................................................................ 26
  2.3.2 Interaction Diagram Options ......................................................... 30
2.4 Section Design Mode .......................................................................... 31
2.5 Moment Magnification at Ends of Compression Member .................. 32
2.6 Moment Magnification along Length of Compression Member .......... 35
2.7 Moments Magnification Ratio .............................................................. 40
2.8 References ......................................................................................... 41
2.1 Definitions and Assumptions

1. The analysis of the reinforced concrete section performed by spColumn conforms to the provisions of the Strength Design Method\(^1\) and Unified Design Provisions\(^2\) and is based on the following assumptions.

   a) All conditions of strength satisfy the applicable conditions of equilibrium and strain compatibility\(^3\)

   b) Strain in the concrete and in the reinforcement is directly proportional to the distance from the neutral axis\(^4\). In other words, plane sections normal to the axis of bending are assumed to remain plane after bending.

   c) The maximum usable (ultimate) strain at the extreme concrete compression fiber is assumed equal to 0.003 for ACI codes\(^5\) and 0.0035 for CSA codes\(^6\) unless otherwise specified by the user.

   d) A uniform rectangular concrete stress block is used. For ACI code\(^7\), the maximum uniform concrete compressive stress, \(f_c\), is \(0.85f'_c\) by default and the block depth is \(\beta_1c\), where \(c\) is the distance from the extreme compression fiber to the neutral axis and \(\beta_1\) is described in item 4 below. For CSA\(^8\), \(f_c\) is taken as:

   \[
   f_c = (0.85 - 0.0015f'_c)f'_c \geq 0.68f'_c, \text{ where } f'_c \text{ is in MPa}
   \]

   Both \(f_c\) and \(\beta_1\) can be modified by the user.

   e) Concrete displaced by the reinforcement in compression is deducted from the compression block\(^9\)

---

1. For CSA A23.3-04 (Ref. [6]) and CSA A23.3-94 (Ref.[7])
2. For ACI 318-14 (Ref. [1]), ACI 318-11 (Ref. [1]), ACI 318-08 (Ref. [2]), ACI 318-05 (Ref. [3]) and ACI 318-02 (Ref. [4]); also see notes on ACI 318-08, 8.1.2 in Ref. [9] and notes on ACI 318-11, 8.1.2 in Ref. [13]
3. ACI 318-14, 4.5.1, 22.2.1.1, 13.2.6.2; ACI 318-11, 10.2.1; ACI 318-08, 10.2.1; ACI 318-05, 10.2.1; ACI 318-02, 10.2.1; CSA A23.3-3/4, 10.1.1; CSA A23.3-3/4, 10.1.1
4. ACI 318-14, 22.1.2, 22.2.1.2; ACI 318-11, 10.2.2; ACI 318-08, 10.2.2; ACI 318-05, 10.2.2; ACI 318-02, 10.2.2; CSA A23.3-3/4, 10.1.2; CSA A23.3-3/4, 10.1.2
5. ACI 318-14, 22.2.2.1; ACI 318-11, 10.2.3; ACI 318-08, 10.2.3; ACI 318-05, 10.2.3; ACI 318-02, 10.2.3
6. CSA A23.3-3/4, 10.1.3; CSA A23.3-3/4, 10.1.3; CSA A23.3-94, 10.1.3
7. ACI 318-14, 22.2.2.3; ACI 318-11, 10.2.6; ACI 318-08, 10.2.6, 10.2.7; ACI 318-05, 10.2.6, 10.2.7; ACI 318-02, 10.2.6, 10.2.6
8. CSA A23.3-14, 10.1.1; CSA A23.3-3/4, 10.1.1; CSA A23.3-3/4, 10.1.1
9. For consistency with Eq. 10-1 and 10-2 in ACI codes (Refs. [1], [3], [4]) and with Eq. 10-10 in CSA codes (Refs. [6], [7])
f) For the reinforcing steel, the elastic-plastic stress-strain distribution is used. Stress in the reinforcing steel below the yield strength, $f_y$, is directly proportional to the strain. For strains greater than that corresponding to the yield strength, the reinforcement stress remains constant and equal to $f_y$. Reinforcing steel yield strength must be within customary ranges.

g) Tensile strength of concrete in axial and flexural calculations is neglected.

h) Reinforcement bars are located within section outline.

i) Irregular sections must be composed of a closed polygon without any intersecting sides.

j) Members with very large cross sectional area, multiple openings, and unusual geometry must be carefully evaluated in light of above assumption for solution stability and reliability of results.

2. The modulus of elasticity of concrete, $E_c$, is computed as follows (unless otherwise specified by the user):

$$E_c = 57,000 \sqrt{f'_c},$$

for the ACI code where $f'_c$ and $E_c$ are in psi,

$$E_c = 4,700 \sqrt{f'_c},$$

for the ACI code where $f'_c$ and $E_c$ are in MPa.

For the CSA standard, $E_c = 3,518 + 7,355$, where $f'_c$ and $E_c$ are in MPa.

3. The modulus of elasticity of reinforcing steel, $E_s$, is taken as 29,000 ksi (200,000 MPa) unless otherwise specified by the user. The computed compression controlled strain limit cannot exceed 0.005 and is reset to 0.002 for user input $f_y$ values in excess of 145 ksi.

---

10. ACI 318-14, 20.2.2.1; ACI 318-11, 10.2.4; ACI 318-08, 10.2.4; ACI 318-05, 10.2.4; ACI 318-02, 10.2.4; CSA A23.3-14, 8.5.3.2; CSA A23.3-04, 8.5.3.2; CSA A23.3-94, 8.5.3.2

11. ACI 318-14, 22.2.2.2; ACI 318-11, 10.2.5; ACI 318-08, 10.2.5; ACI 318-05, 10.2.5; ACI 318-02, 10.2.5; CSA A23.3-14, 10.1.5; CSA A23.3-04, 10.1.5; CSA A23.3-94, 10.1.5

12. ACI 318-14, 19.2.2.1; ACI 318-11, 8.5.1; ACI 318-08, 8.5.1; ACI 318-05, 8.5.1; ACI 318-02, 8.5.1

13. ACI 318M-14, 19.2.2.1; ACI 318M-11, 8.5.1; ACI 318M-08, 8.5.1; ACI 318M-05, 8.5.1; ACI 318M-02, 8.5.1

14. CSA A23.3-14, 8.6.2.2, Eq. 8.1, CSA A23.3-04, 8.6.2.2, Eq. 8.1 and CSA A23.3-94, 8.6.2.3, Eq. 8-6 (with $\gamma_c = 2400$ kg/m$^3$)

15. ACI 318-14, 20.2.2.2; ACI 318-11, 8.5.2; ACI 318-08, 8.5.2; ACI 318-05, 8.5.2; ACI 318-02, 8.5.2; ACI 318M-05, 8.5.2; ACI 318M-02, 8.5.2; CSA A23.3-14, 8.5.4.1; CSA A23.3-04, 8.5.4.1; CSA A23.3-94, 8.5.4.1
4. The ratio of the concrete compression block depth to the distance between the extreme compression fiber and the neutral axis, $\beta_1$, is computed as follows (unless otherwise specified by the user):

\[
0.65 \leq \beta_1 = 1.05 - 0.05 f'_c \leq 0.85, \text{ for the ACI code}^{16} \text{ where } f'_c \text{ is in ksi,}
\]

\[
0.65 \leq \beta_1 = \frac{149 - f'_c}{140} \leq 0.85, \text{ for the ACI code}^{17} \text{ where } f'_c \text{ is in MPa.}
\]

For the CSA standard\(^{18}, \beta_1 = 0.97 - 0.0025 f'_c \geq 0.67, \text{ where } f'_c \text{ is in MPa.}

5. Stress in the reinforcement is computed based on the strain at the centroid of each reinforcing bar.

6. All moments are referenced to the geometric centroid of the gross concrete section (neglecting the reinforcement).

---

16. ACI 318-14, 22.2.2.4.3; ACI 318-11, 10.2.7.3; ACI 318-08, 10.2.7.3; ACI 318-05, 10.2.7.3; ACI 318-02, 10.2.7.3
17. ACI 318M-14, 22.2.2.4.3; ACI 318M-11, 10.2.7.3; ACI 318M-08, 10.2.7.3; ACI 318M-05, 10.2.7.3; ACI 318M-02, 10.2.7.3
18. CSA A23.3-14, 10.1.7(c); CSA A23.3-04, 10.1.7(c); CSA A23.3-94, 10.1.7(c)
7. For the ACI codes, the nominal (unreduced) capacity of the section is first computed. Then, the nominal capacity is reduced to the design capacity using the strength reduction factor, $\phi$, the value of which is calculated based on the net tensile steel strain, $\varepsilon_t$, in the following way:\(^\text{19}\).

- For columns with spiral reinforcement per ACI 318-14, ACI 318-11, and ACI 318-08

\[
\phi = \begin{cases} 
0.9 & \text{if } \varepsilon_t \geq 0.005 \text{ (tension controlled section)} \\
0.75 + \frac{0.15(\varepsilon_t - f_y/E_s)}{0.005 - f_y/E_s} & \text{if } f_y/E_s < \varepsilon_t < 0.005 \text{ (transition section)} \\
0.75 & \text{if } \varepsilon_t \leq f_y/E_s \text{ (compression controlled section)} 
\end{cases}
\]

- For columns with spiral reinforcement per ACI 318-05 and ACI 318-02

\[
\phi = \begin{cases} 
0.9 & \text{if } \varepsilon_t \geq 0.005 \text{ (tension controlled section)} \\
0.70 + \frac{0.20(\varepsilon_t - f_y/E_s)}{0.005 - f_y/E_s} & \text{if } f_y/E_s < \varepsilon_t < 0.005 \text{ (transition section)} \\
0.70 & \text{if } \varepsilon_t \leq f_y/E_s \text{ (compression controlled section)} 
\end{cases}
\]

- For other columns per ACI 318-14, ACI 318-11, ACI 318-08, ACI 318-05, and ACI 318-02

\[
\phi = \begin{cases} 
0.9 & \text{if } \varepsilon_t \geq 0.005 \text{ (tension controlled section)} \\
0.65 + \frac{0.25(\varepsilon_t - f_y/E_s)}{0.005 - f_y/E_s} & \text{if } f_y/E_s < \varepsilon_t < 0.005 \text{ (transition section)} \\
0.65 & \text{if } \varepsilon_t \leq f_y/E_s \text{ (compression controlled section)} 
\end{cases}
\]

\(^{19}\)ACI 318-14, 21.2; ACI 318-11, 9.3.2, 10.3.3, 10.3.4; ACI 318-08, 9.3.2, 10.3.3, 10.3.4; ACI 318-05, 9.3.2, 10.3.3, 10.3.4; ACI 318-02, 9.3.2, 10.3.3, 10.3.4
**Figure 2-2 Reduction factors for Flexural and Axial Capacity per ACI Code**

Figure 2-2 illustrates variation of the strength reduction factor with net tensile strain in extreme tension steel and the impact of the strength reduction factor on the axial and flexural capacity interaction diagram. It is worth noting that in the transition between compression controlled and tension controlled zones, the nominal axial capacity, $P_n$, decreases whereas the value of net tensile strain increases and so does the strength reduction factor, $\phi$. Consequently, the resulting factored axial capacity (i.e. the product of nominal axial capacity and the strength reduction factor), $\phi P_n$, may either increase or decrease in the transition zone depending on the rates of axial force decrease and strength reduction increase for the section under consideration. Typically, the rate of axial capacity decrease dominates over the rate of strength reduction increase and thus the factored axial load capacity decreases as well.

For certain classes of sections (e.g. sections having a narrowing in the middle such as hollow core section, T-shaped, L-shaped, and I-shaped sections), however, the reverse may be true resulting in the factored axial load capacity increase in the transition zone between compression controlled and tension controlled zones. This unusual increase in axial load capacity is not illustrated by interaction diagrams produced by the program and is not considered for design and investigation of cross-sections. It will be flagged to inform the user, however, when the program is run using Control Points as the load type.

Where unsymmetrical members (e.g. C-shaped or U-shaped sections) are investigated under biaxial bending, the Mx-My contour diagram occasionally crosses the X or Y axes more than once. This presents an unusual situation where a load point may exist outside of the Mx-My
contour while appearing within the P-Mx or P-My contour views. It is suggested the Mx-My contours be investigated carefully for each factored axial load level.

For the CSA standards, the program calculates the factored resistance directly using the factored compressive concrete strength$^{20}$, $\phi_c f'_c$, and the factored forces in reinforcement bars$^{21}$, $\phi_s S_t$. The material resistance factors are:

\[
\begin{align*}
\phi_c &= 0.60 \text{ for CSA A23.3-94} \\
&= 0.65 \text{ for CSA A23.3-04/14 (cast-in-place)} \\
&= 0.70 \text{ for CSA A23.3-04/14 (precast)} \\
\phi_s &= 0.85 \text{ for CSA A23.3-94/04/14}
\end{align*}
\]

For all ACI and CSA A23.3-94/04 standards, the design axial capacity is capped$^{22}$ at 0.85 of the maximum axial capacity for sections with spiral reinforcement or at 0.80 for sections with tie reinforcement.

Additionally, for CSA A23.3-14 the design axial capacity is capped$^{23}$ at 0.90 of the maximum axial capacity for sections with spiral reinforcement or at \((0.2+0.002h) \leq 0.80\) for sections with tie reinforcement where \(h\) is the wall thickness or the minimum column dimension.

---

20. CSA A23.3-14, 8.4.2, 16.1.3; CSA A23.3-04, 8.4.2, 16.1.3; CSA A23.3-94, 8.4.2
21. CSA A23.3-14, 8.4.3; CSA A23.3-04, 8.4.3; CSA A23.3-94, 8.4.3
22. ACI 318-14, 22.4.2.1; ACI 318-11, 10.3.6; ACI 318-08, 10.3.6; ACI 318-05, 10.3.6; ACI 318-02, 10.3.6; CSA A23.3-14, 10.10.4; CSA A23.3-04, 10.10.4; CSA A23.3-94, 10.10.4
23. CSA A23.3-14, 10.10.4
Figure 2-3 Shapes of P-M interaction diagram for ACI code and CSA standard

8. In the investigation mode the program will calculate capacity for any provided area of reinforcement. However, if the reinforcement area falls below the code-specified minimum of 0.01 times the gross area, $A_g$, then two options, Architectural or Structural, are available.

24. ACI 318-14, 10.6.1.1; ACI 318-11, 10.9.1; ACI 318-08, 10.9.1; ACI 318-05, 10.9.1; ACI 318-02, 10.9.1; CSA A23.3-14, 10.9.1; CSA A23.3-04, 10.9.1; CSA A23.3-94, 10.9.1
By default *Architectural* option is selected for which the capacity of the section is reduced. For the ACI codes, the reduction results from multiplying the maximum concrete stress, $f'_c$, by the ratio of reinforcement area to $0.01A_g$. This produces the same effect as reducing the effective concrete area \(^{25}\) to achieve ratio of reinforcement area to gross concrete area equal to 0.01. For the CSA standards \(^{26}\), the factored axial and flexural resistances are multiplied by ratio \(0.5(1 + \rho_t / 0.01)\) for the 04 edition and \(\rho_t / 0.01\) for the 94 edition.

For *Structural* option, the section is treated “as is” without any reductions in capacity. This option is provided for informational purposes only, since per all codes supported by spColumn, capacity of compression members with reinforcement area less than $0.01A_g$ has to be reduced and areas below $0.005A_g$ are not allowed.

9. Under the Design option, the reinforcement ratio cannot be less than 1.0% if *Structural* column type is selected in design criteria and 0.5% in case of *Architectural* column type. For *Architectural* type, the capacity of the designed column is reduced as described above. Additionally, *User Defined* type is provided in the design criteria, which allows designs with reinforcement ratios not less than 0.1%. No reduction in capacity is applied for *User Defined* column type.

10. Maximum reinforcement ratio \(^{27}\) for *Structural* and *Architectural* options in both Investigation and Design modes is 8%. For *User Defined* type in the Design mode the maximum reinforcement ratio is set to 20%.

11. Reinforcement design strength for standard materials is limited to the value permitted for design calculations \(^{28}\) by ACI to 80 ksi and CSA to 500 MPa.

### 2.2 Conventions

1. Positive axial forces are compressive and negative axial forces are tensile.
2. Looking in plan at the section with z-axis pointing outwards, the positive x-axis points to the right and the positive y-axis points up. For this section, vectors of positive bending moments have the same orientation as their corresponding axes x and y. Thus, a positive bending moment about the x-axis, $M_x$, produces tension at the top face of the section and

---

25. ACI 318-14, 10.3.1.2; ACI 318-11, 10.8.4; ACI 318-08, 10.8.4; ACI 318-05, 10.8.4; ACI 318-02, 10.8.4
26. CSA A23.3-14, 10.10.5; CSA A23.3-04, 10.10.5; CSA A23.3-94, 10.10.5
27. ACI 318-14, 10.6.1.1; ACI 318-11, 10.9.1; ACI 318-08, 10.9.1; ACI 318-05, 10.9.1; ACI 318-02, 10.9.1; CSA A23.3-14, 10.9.2; CSA A23.3-04, 10.9.2; CSA A23.3-94, 10.9.2
28. ACI 318-14, Table 20.2.2.4a; CSA A23.3-14, 8.5.1
compression at the bottom face. A positive bending moment about the y-axis, $M_y$, produces tension at the left face of the section and compression at the right face.

![Figure 2-4 Positive axial force and bending moments (internal forces)](image)

3. If service loads are input, moment loads at the upper (top) and lower (bottom) ends of the column are needed. Top and bottom moment loads of opposite signs produce single curvature bending. Top and bottom moment loads of the same sign produce double curvature bending.

Positive moment loads at the upper end of the column coincide with positive bending moments. However, at the lower end, positive moment loads produce effects opposite to positive bending moments. Therefore, spColumn changes the sign of the service moment at the lower end to convert it from a moment load to a bending moment.

Axial load is assumed to be constant so it is input only as for the upper end where positive axial load coincides with positive axial force.

4. If factored loads are input, they are considered to be applied at a section pointing upwards so that they have the same orientations as positive axial force and positive bending moments.
5. The convention for the slenderness input of beam and column dimensions and their orientation is presented in Figure 2-6. Beams above the columns are shown. Same convention applies to beam below the column.
2.3 Section Investigation Mode

2.3.1 Loading Options

The computations performed when investigating a section depend on the selected load mode:

a) Factored loads – for the axial load of each load point, the moment capacity and the ratio of design-to-applied moment are computed. For a biaxial run, the computed $M_x$ and $M_y$ moment capacities are at the same angle as that produced by the applied $M_x$ and $M_y$ moments. In uniaxial case the program also reports the depth of neutral axis and maximum steel strain corresponding to the calculated moment capacity. For the ACI code, the value of strength reduction factor is also reported.

spColumn allows defining up to 50 load combinations. The user has full control over the combinations. The program contains predefined (built into the program) default primary load combinations for the supported codes. These default combinations are created when starting a new project. The default load combinations of the Dead (D), Live (L), Wind (W), Earthquake (E) and Snow (S) loads considered by the program are shown below. For the ACI 318-14, 11, 08, 05, and 02 codes:

<table>
<thead>
<tr>
<th>$U_i$</th>
<th>Equation</th>
</tr>
</thead>
<tbody>
<tr>
<td>U1</td>
<td>1.4D</td>
</tr>
<tr>
<td>U2</td>
<td>1.2D + 1.6L + 0.5S</td>
</tr>
<tr>
<td>U3</td>
<td>1.2D + 1.0L + 1.6S</td>
</tr>
<tr>
<td>U4</td>
<td>1.2D + 0.8W + 1.6S</td>
</tr>
<tr>
<td>U5</td>
<td>1.2D + 1.0L + 1.6W + 0.5S</td>
</tr>
<tr>
<td>U6</td>
<td>0.9D + 1.6W</td>
</tr>
<tr>
<td>U7</td>
<td>1.2D – 0.8W + 1.6S</td>
</tr>
<tr>
<td>U8</td>
<td>1.2D + 1.0L – 1.6W + 0.5S</td>
</tr>
<tr>
<td>U9</td>
<td>0.9D – 1.6W</td>
</tr>
<tr>
<td>U10</td>
<td>1.2D + 1.0L + 1.0E – 0.2S</td>
</tr>
<tr>
<td>U11</td>
<td>0.9D + 1.0E</td>
</tr>
<tr>
<td>U12</td>
<td>1.2D + 1.0L – 1.0E + 0.2S</td>
</tr>
<tr>
<td>U13</td>
<td>0.9D – 1.0E</td>
</tr>
</tbody>
</table>

For the CSA A23.3-94 code:

29. ACI 318-14, 5.3; ACI 318-11, 9.2; ACI 318-08, 9.2; ACI 318-05, 9.2; ACI 318-02, 9.2; (assuming W based on service-level wind load and E based on ultimate-level forces)
30. CSA A23.3-94, 8.3.2 (conservatively assuming storage and assembly occupancies)
U1 = 1.25D
U2 = 1.25D + 1.5L
U3 = 1.25D + 1.5L + 1.5S
U4 = 1.25D + 1.05L + 1.05W
U5 = 1.25D + 1.05L + 1.05W + 1.05S
U6 = 1.25D + 1.5W
U7 = 0.85D + 1.5W
U8 = 1.0D + 1.0L + 1.0E
U9 = 1.0D + 1.0L + 1.0E + 1.0S
U10 = 1.0D + 1.0E
U11 = 1.25D + 1.05L – 1.05W
U12 = 1.25D + 1.05L – 1.05W + 1.05S
U13 = 1.25D – 1.5W
U14 = 0.85D – 1.5W
U15 = 1.0D + 1.0L – 1.0E
U16 = 1.0D + 1.0L – 1.0E + 1.0S
U17 = 1.0D – 1.0E

For the CSA A23.3-04 code\(^{31}\):

U1 = 1.4D
U2 = 1.25D + 1.5L
U3 = 1.25D + 1.5L + 0.5S
U4 = 1.25D + 1.5L + 0.4W
U5 = 1.25D + 1.5L – 0.4W
U6 = 0.9D + 1.5L
U7 = 0.9D + 1.5L + 0.5S
U8 = 0.9D + 1.5L + 0.4W
U9 = 0.9D + 1.5L – 0.4W
U10 = 1.25D + 1.5S
U11 = 1.25D + 0.5L + 1.5S
U12 = 1.25D + 0.4W + 1.5S

---

\(^{31}\) CSA A23.3-14, 8.3.2; CSA A23.3-14, Annex C, Table C1; NBCC 2005 [8], Table 4.1.3.2.A; CSA A23.3-04, 8.3.2; CSA A23.3-04, Annex C, Table C1; NBCC 2005 [8], Table 4.1.3.2
U13 = 1.25D – 0.4W + 1.5S
U14 = 0.9D + 1.5S
U15 = 0.9D + 0.5L + 1.5S
U16 = 0.9D + 0.4W + 1.5S
U17 = 0.9D – 0.4W + 1.5S
U18 = 1.25D + 1.4W
U19 = 1.25D + 0.5L + 1.4W
U20 = 1.25D + 1.4W + 0.5S
U21 = 1.25D – 1.4W
U22 = 1.25D + 0.5L – 1.4W + 0.5S
U23 = 1.25D – 1.4W + 0.5S
U24 = 0.9D + 1.4W + 0.5S
U25 = 0.9D – 1.4W
U26 = 0.9D – 1.4W + 0.5S
U27 = 0.9D + 1.0E
U28 = 0.9D + 0.5L + 1.0E + 0.25S
U29 = 0.9D – 1.0E
U30 = 1.0D + 1.0E
U31 = 1.0D + 0.5L + 1.0E + 0.25S
U32 = 1.0D – 1.0E
U33 = 1.0D + 0.5L – 1.0E + 0.25S

For the CSA A23.3-14 code:
U1 = 1.4D
U2 = 1.25D + 1.5L
U3 = 1.25D + 1.5L + 1.0S
U4 = 1.25D + 1.5L + 0.4W
U5 = 1.25D + 1.5L – 0.4W
U6 = 0.9D + 1.5L
U7 = 0.9D + 1.5L + 1.0S
U8 = 0.9D + 1.5L + 0.4W

32. CSA A23.3-14 Annex C, Table C1; NBCC 2010 [8], Table 4.1.3.2A; CSA A23.3-04, Annex C, Table C1; NBCC 2005 [8], Table 4.1.3.2
U9 = 0.9D + 1.5L – 0.4W
U10 = 1.25D + 1.5S
U11 = 1.25D + 1.0L + 1.5S
U12 = 1.25D + 0.4W + 1.5S
U13 = 1.25D – 0.4W + 1.5S
U14 = 0.9D + 1.5S
U15 = 0.9D + 1.0L + 1.5S
U16 = 0.9D + 0.4W + 1.5S
U17 = 0.9D – 0.4W + 1.5S
U18 = 1.25D + 1.4W
U19 = 1.25D + 0.5L + 1.4W
U20 = 1.25D + 1.4W + 0.5S
U21 = 1.25D – 1.4W
U22 = 1.25D + 0.5L – 1.4W + 0.5S
U23 = 1.25D – 1.4W + 0.5S
U24 = 0.9D + 0.5L + 1.4W
U25 = 0.9D + 0.5L + 1.4W
U26 = 0.9D + 1.4W + 0.5S
U27 = 0.9D – 1.4W
U28 = 0.9D + 0.5L – 1.4W
U29 = 0.9D – 1.4W + 0.5S
U30 = 1.0D + 1.0E
U31 = 1.0D + 0.5L + 1.0E + 0.25S
U32 = 1.0D – 1.0E
U33 = 1.0D + 0.5L – 1.0E + 0.25S

b) Service loads – the program calculates the factored loads using the input load combinations. If slenderness effects are to be checked and the column is found to be slender, the applied moments are magnified according to Procedures 2.5 and 2.6. For each calculated factored load, the same computations described in (a) above are performed.

c) Control points – for several key points on the interaction diagram, the program calculates axial load and moment capacity together with the neutral axis depth and maximum steel strain corresponding to the respective moment capacity. For ACI code, strength reduction factor is also reported. The following key points are used by the
program: maximum compression, allowable compression, point where steel stress is zero, point where steel stress is \(0.5f_y\), balanced point, pure flexure and maximum tension. For ACI code, an additional control point is introduced where maximum steel strain is equal to 0.005 (tension control limit).

d) Axial loads – for each input axial load, the program calculates the positive and negative moment capacities together with the corresponding neutral axis depths and maximum steel strains. For ACI code, strength reduction factors are also reported.

2.3.2 Interaction Diagram Options

The program also computes the interaction diagram (uniaxial runs) or the three-dimensional failure surface (biaxial runs) of the input section. The values of maximum compressive axial load capacity and maximum tensile load capacity are computed. These two values set the range within which the moment capacities are computed for a predetermined number of axial load values.

a) For uniaxial runs, positive and negative moment capacities about only the selected axis are computed. Moment capacities about the orthogonal axis are ignored. To compute the moment capacity at a certain level of axial load, the neutral axis angle is held constant, parallel to the selected axis. The neutral axis depth is adjusted to arrive at the desired axial load capacity. This is done for all the predetermined values of axial load.

b) For biaxial runs, the same predetermined values of axial load are utilized. For each level of axial load, the section is rotated in 10-degree increments from 0 degrees to 360 degrees and the \(M_x\) and \(M_y\) moment capacities are computed. Thus for each level of axial load, an \(M_x-M_y\) contour is developed. Repeating this for the entire range of axial loads, the three-dimensional failure surface is computed. A three-dimensional visualization of the resulting entire nominal and factored failure surface is provided to support enhanced understanding of the section capacity.

Also for each point on the interaction diagram or on the three-dimensional failure surface, the program calculates the location of the neutral axis (expressed in terms of depth and angle of the neutral axis), maximum steel strain, and (for ACI codes only) the strength reduction factor. These results are reported for the maximum capacity of the section based on the ultimate limit states and not for the given loading input. The information can however be used to draw conclusions or make additional calculations for a given loading condition.
2.4 Section Design Mode

1. Based on the specified minimum, maximum and increment specified for the section and the reinforcing bars, the program selects the smallest section with the least amount of reinforcement for which the load-moment capacity exceeds the applied loads. If service loads are input, they are factored using the input load combinations. Depending on the
design criteria the user selects, the least amount of reinforcement the program searches for means either the smallest number of bars or the smallest steel area.

2. The program starts the design by trying the smallest section (minimum dimensions) and the least amount of reinforcing bars. The program verifies that the ratio of provided reinforcement is always within the specified minimum and maximum ratios. Furthermore, unless otherwise specified by the user\(^{33}\), the bar spacing is always kept greater than or equal to the larger of 1.5 times the bar diameter or 1.5 in. [40 mm] for ACI\(^{34}\) and 1.4 times the bar diameter or 1.2 in [30 mm] for CSA\(^{35}\).

3. A section fails the design if, for the design axial load, the ratio of design-to-applied moment is less than 1.0 (unless otherwise specified in the Design Criteria dialog box).

4. Once a section passes the design, its capacity is computed and the calculations explained in Procedure 2.3 above are performed.

5. For members with large cross sectional area spColumn sometimes warns the user with the following message “Cannot achieve desired accuracy”. This results when the program cannot meet the predefined convergence criteria and the corresponding point on the interaction diagram may be slightly off. The convergence criteria is more stringent than required in engineering practice, however, the shape of the interaction diagram should be verified to be relatively smooth and free of unexpected discontinuity.

### 2.5 Moment Magnification at Ends of Compression Member

This procedure accounts for moment magnification due to second-order effects at ends of columns in sway frames\(^{36}\).

1. If properties of framing members are input, spColumn computes the effective length factor, \(k_s\), for sway condition using the following equation\(^{37}\):

\[
\left(\frac{\pi}{k_s}\right)^2 \psi_A \psi_B - 1 \tan \frac{\pi}{k_s} - \left(\frac{\psi_A + \psi_B}{6}\right) k_s = 0
\]

\(^{33}\) The user may select spacing greater than the default value to take into account tolerances for reinforcement placement (see ACI 117-06, Ref [5]) and other project specific considerations.

\(^{34}\) ACI 318-14, 25.2.3; ACI 318-11, 7.6.3; ACI 318-08, 7.6.3; ACI 318-05, 7.6.3; ACI 318-02, 7.6.3

\(^{35}\) CSA A23.3-14, Annex A, 6.6.5.2; CSA A23.3-04, Annex A, 6.6.5.2; CSA A23.3-94, Annex A, A12.5.2

\(^{36}\) ACI 318-14, 6.6.4.6.1; ACI 318-11, 10.10.7; ACI 318-08, 10.10.7; ACI 318-05, 10.13; ACI 318-02, 10.13; CSA A23.3-14, 10.16; CSA A23.3-04, 10.16; CSA A23.3-94, 10.16

\(^{37}\) Exact formula derived in Ref. [12] pp. 851 for Jackson and Moreland alignment chart
where \( \psi \) is the ratio of \( \sum (EI/\ell_c) \) of columns to \( \sum (EI/\ell) \) of beams in a plane at one end of the column, \( \psi_A \) and \( \psi_B \) are the values of \( \psi \) at the upper end and the lower end of the column. For a hinged end, \( \psi \) is very large. This happens in the case where \( \sum (EI/\ell) \) of beams is very small (or zero) relative to the \( \sum (EI/\ell_c) \) of columns at that end. In this case, the program outputs 999.9 for the value of \( \psi \). The moment of inertia used in computing \( \psi \) is the gross moment of inertia multiplied by the cracked section coefficients\(^{38}\) (specified in the Slenderness Factors dialog box).

2. For the ACI code\(^{39}\), slenderness effects will be considered if \( k \ell_u/r \geq 22.0 \). For the CSA standards, all sway columns are designed for slenderness effects.

3. If the ratio \( k \ell_u/r \) exceeds 100, slenderness effects cannot be accounted for using moment magnification procedure\(^{40}\). A more exact method must be used. In this case, the program issues a warning message and aborts design or investigation procedure except for calculations per ACI 318-14, ACI 318-11, and ACI 318-08 where limit of \( k \ell_u/r < 100 \) does not explicitly apply and the program continues calculations after showing the warning message.

4. Factored moments, \( M_{ns,top} \) and \( M_{ns,bot} \) due to dead, live, and snow loads assumed to cause no appreciable sidesway\(^{41}\), are calculated at the top and bottom ends of the column.

5. Factored moments, \( M_{s,top} \) and \( M_{s,bot} \) due to lateral loads (wind and earthquake) assumed to cause appreciable sidesway\(^{42}\), are calculated at the top and bottom ends of the column.

6. Flexural stiffness \( EI \) is calculated as\(^{43}\):

\[
EI = \frac{0.2E_cI_g + E_sI_{se}}{1 + \beta_{ds}}
\]

where \( E_c \) is the modulus of elasticity of concrete, \( E_s \) is the modulus elasticity of steel, \( I_g \) is the gross moment of inertia of the concrete section, \( I_{se} \) is the moment of inertia of

---

\(^{38}\) ACI 318-14, 6.6.3.1.1, 6.6.4.2, 6.7.1.3, 6.8.1.4; ACI 318-11, 10.10.4.1; ACI 318-08, 10.10.4.1; ACI 318-05, 10.11.1, 10.13.1; ACI 318-02, 10.11.1, 10.13.1; CSA A23.3-14, 10.14.1.2, 10.16.1; CSA A23.3-04, 10.14.1.2, 10.16.1; CSA A23.3-94, 10.14.1.1, 10.16.1

\(^{39}\) ACI 318-14, 6.2.5; ACI 318-11, 10.10.1; ACI 318-08, 10.10.1; ACI 318-05, 10.13.2; ACI 318-02, 10.13.2

\(^{40}\) ACI 318-05, 10.11.5; ACI 318-02, 10.11.5; CSA A23.3-14, 10.13.2; CSA A23.3-04, 10.13.2; CSA A23.3-94, 10.13.2

\(^{41}\) ACI 318-14, 2.1; ACI 318-11, 2.1; ACI 318-08, 2.1; ACI 318-05, 2.1; ACI 318-02, 10.0; CSA A23.3-14, 3.2; CSA A23.3-04, 2.3; CSA A23.3-94, 10.0

\(^{42}\) ACI 318-14, 2.1; ACI 318-11, 2.1; ACI 318-08, 2.1; ACI 318-05, 2.1; ACI 318-02, 10.0; CSA A23.3-04, 2.3; CSA A23.3-94, 10.0

\(^{43}\) ACI 318-14, 6.6.4.4.4, Eq. 6.6.4.4b; ACI 318-11, 10.10.6 Eq. 10-14; ACI 318-08, 10.10.6 Eq. 10-14; ACI 318-05, 10.12.3 Eq. 10-11; ACI 318-02, 10.12.3. Eq. 10-10; CSA A23.3-14, 10.16.3.2, 10.15.3 Eq. 10-19; CSA A23.3-04, 10.16.3.2, 10.15.3 Eq. 10-18; CSA A23.3-94, 10.16.3.2, 10.15.3.1 Eq. 10-18
reinforcement. Assuming that shear due to lateral loads is not sustained in most frames\(^{44}\),
the \(\beta_{ds}\) is taken as zero (with the exception of strength and stability of the structure as a whole under factored gravity loads described in Step 11).

7. The critical buckling load, \(P_c\), is computed as\(^{45}\).

\[
P_c = \frac{\pi^2 EI}{(k l_a)^2}
\]

8. The sway moment magnification factor, \(\delta_s\), is computed as\(^{46}\):

\[
\delta_s = \frac{1.0}{1 - \frac{\sum P_u}{\phi_k \sum P_c}} \geq 1.0
\]

where the stiffness reduction factor, \(\phi_K\), is equal to 0.75.

\(\sum P_u\) is taken as the factored axial load for the load combination under consideration times the ratio \(\sum P_u / P_u\), i.e.\(^{47}\) \(\sum P_u = P_u (\sum P_u / P_u)\).

\(\sum P_c\) is taken as the critical buckling load for the load combination under consideration times the ratio \(\sum P_c / P_c\), i.e. \(\sum P_c = P_c (\sum P_c / P_c)\).

\(\phi_K\) and the ratios \(\sum P_u / P_u\) and \(\sum P_c / P_c\) may be modified using the Slenderness Factors input box.

9. The magnified moments at the top and bottom ends of the compression member are computed as\(^{48}\):

\[
M_{top} = M_{ns,top} + \delta_s M_{s,top}
\]

\[
M_{bot} = M_{ns,bot} + \delta_s M_{s,bot}
\]

10. The smaller and the larger factored end moments are then determined based on absolute values of magnified top and bottom end moments

\(^{44}\)ACI 318-14, R6.6.4.6.2(b); ACI 318-11, R10.10.7.4; ACI 318-08, R10.10.7.4; ACI 318-05, R10.13.4.1, R10.13.4.3; ACI 318-02, R10.13.4.1, R10.13.4.3; Ref. [10] pp 586 (first paragraph from the bottom)

\(^{45}\)ACI 318-14, 6.6.4.4.2, Eq. 6.6.4.4.2; ACI 318-11, 10.10.6 Eq. 10-13; ACI 318-08, 10.10.6 Eq. 10-13; ACI 318-05, 10.12.3 Eq. 10-10; ACI 318-02, 10.12.3 Eq. 10-10; CSA A23.3-14, 10.16.3.2, 10.15.3.1 Eq. 10-17; CSA A23.3-94, 10.16.3.2, 10.15.3 Eq. 10-18

\(^{46}\)ACI 318-14, 6.6.4.6.2, Eq. 6.6.4.6.2b; ACI 318-11, 10.10.7.4 Eq. 10-21; ACI 318-08, 10.10.7.4 Eq. 10-21; ACI 318-05, 10.13.4.3 Eq. 10-18; ACI 318-02, 10.13.4.3 Eq. 10-18; CSA A23.3-14, 10.16.3.2 Eq. 10-24; CSA A23.3-94, 10.16.3.2 Eq. 10-23

\(^{47}\)To minimize required input, the program uses one value of ratio \(\sum P_u / P_u\) for all load combinations. However, the ratio can vary depending on the combination under consideration. In this case, it will be conservative to use the highest value of the ratio.

\(^{48}\)ACI 318-14, 6.6.4.6.1; ACI 318-11, 10.10.7; ACI 318-08, 10.10.7; ACI 318-05, 10.13.3; ACI 318-02, 10.13.3; CSA A23.3-14, 10.16.2; CSA A23.3-04, 10.16.2; CSA A23.3-94, 10.16.2
METHOD OF SOLUTION

While design codes define moment $M_2$ as always positive and the sign of moment $M_1$ depending on single or double curvature bending\textsuperscript{49}, spColumn retains actual signs of moments $M_1$ and $M_2$. This revision ensures proper comparison against negative and positive moment capacities of unsymmetrical sections (see Figure 2-8).

11. Strength and stability of the structure as a whole under factored gravity loads\textsuperscript{50} is ensured by checking that the value of the moment magnification factor, $\delta_c$, is positive and does not exceed 2.5.

The program performs this check for all load combinations that include only gravity loads with the exception of the ACI 318-14/11/08 codes for which the check is not performed and CSA A23.3-94 where the check is performed only for the load combination of 1.25 dead load plus 1.5 live load plus (1.5 snow or 0.0 snow), if this combination is present (default). The $\beta_d$ factor for the load combination under consideration is equal to the maximum sustained factored axial load to the maximum factored axial load.

2.6 Moment Magnification along Length of Compression Member

This procedure accounts for moment magnification due to second-order effect along the length of compression members that are part of either nonway\textsuperscript{51} or sway frames\textsuperscript{52}. In nonway frames, moment magnification along length is neglected by the program if the condition in Step 3 is satisfied.

\textsuperscript{49} ACI 318-14, 2.1; ACI 318-11, 2.1; ACI 318-08, 2.1; ACI 318-05, 2.1; ACI 318-02, 10.0; CSA A23.3-14, 3.2; CSA A23.3-04, 2.3; CSA A23.3-94, 10.0
\textsuperscript{50} ACI 318-05, 10.13.6; ACI 318-02, 10.13.6; CSA A23.3-14, 10.16.5; CSA A23.3-04, 10.16.5; CSA A23.3-94, 10.16.5
\textsuperscript{51} ACI 318-14, 6.6.4.4.2, 6.6.4.5.1, 6.6.4.5.2; ACI 318-11, 10.10.6; ACI 318-08, 10.10.6; ACI 318-05, 10.12; ACI 318-02, 10.12; CSA A23.3-14, 10.15; CSA A23.3-04, 10.15; CSA A23.3-94, 10.15
\textsuperscript{52} ACI 318-14, 6.6.1.1; ACI 318-11, 10.10.2.2; ACI 318-08, 10.10.2.2; ACI 318-05, 10.13.5; ACI 318-02, 10.13.5; CSA A23.3-14, 10.16.4; CSA A23.3-04, 10.16.4; CSA A23.3-94, 10.16.4
In sway frames designed per ACI 318-02/05 and CSA A23.3-94/04/14, the magnification along the length is neglected if\(^53\):
\[
\frac{\ell_u}{r} \leq \frac{35}{\sqrt{\frac{P_u}{f_c A_g}}}
\]
By rearranging and introducing \(k' = \sqrt{\frac{P_u}{f_c' A_g}}\), this condition can be succinctly expressed as \(k' \ell_u / r \leq 35\). For columns designed per ACI 318-14, ACI 318-11, and ACI 318-08 codes, moment magnification along length is to be considered for all slender compression members, i.e. columns in either nonsway or sway frames regardless of the \(k' \ell_u / r\) ratio. Since various published examples of columns designed per ACI 318-14, ACI 318-11, and ACI 318-08 do not combine moment magnification at ends and along length of columns in sway frames\(^54\), spColumn optionally allows not considering moment magnification along the length of a column in a sway frame based on engineering judgment of the user.

When moment magnification along the length of a compression member is considered, the following procedure is followed:

1. The effective length factor, \(k\), is either entered by the user or calculated by the program. The value of \(k\) must be between 0.5 and 1.0 for moment magnification along length and the recommended\(^55\) value is 1.0. Smaller values can be used if justified by analysis. If properties of framing members are input, spColumn computes the effective length factor, \(k\), for nonsway condition from the following equation\(^56\):

\[
\frac{\psi_A \psi_B \left(\frac{\pi^2}{k^2}\right)}{4} + \left(\psi_A + \psi_B\right) \left(1 - \frac{\pi}{k} \tan\left(\frac{\pi}{k}\right)\right) + \frac{2}{\pi} \frac{\pi}{k} \tan\left(\frac{\pi}{2k}\right) = 1
\]

Where \(\psi\) is the ratio of \(\sum EI / I_c\) of columns to \(\sum (EI / I)\) of beams in a plane at one end of the column, \(\psi_A\) and \(\psi_B\) are the values of \(\psi\) at the upper end and the lower end of the column, respectively. Moments of inertia used in computing \(\psi\) factors are gross moments of inertia multiplied by the cracked section coefficients\(^57\) (specified in the Slenderness

\(^{53}\) ACI 318-05, Eq. 10-19; ACI 318-02, Eq. 10-19; CSA A23.3-04, Eq. 10-26; CSA A23.3-04, Eq. 10-25; CSA A23.3-94, Eq. 10-25
\(^{54}\) See Example 11.2 in Ref. [9], Example 12.4 in Ref. [11], and Example 12.3 in Ref. [10]
\(^{55}\) ACI 318-14, 6.6.4.4.3, R6.6.4.4.3; ACI 318-11, 10.10.6.3; R10.10.6.3; ACI 318-08, 10.10.6.3, R10.10.6.3; ACI 318-05, 10.12.1; ACI 318-02, 10.12.1; CSA A23.3-14, 10.15.1; CSA A23.3-04, 10.15.1; CSA A23.3-94, 10.15.1
\(^{56}\) Exact formula derived in Ref. [12] pp. 848 for Jackson and Moreland alignment chart
\(^{57}\) ACI 318-14, 6.6.3.1.1, 6.6.4.2, 6.7.1.3, 6.8.1.4; ACI 318-11, 10.10.4.1; ACI 318-08, 10.10.4.1; ACI 318-05, 10.11.1, 10.12.1; ACI 318-02, 10.11.1, 10.12.1; CSA A23.3-14, 10.14.1.2, 10.15.1; CSA A23.3-04, 10.14.1.2, 10.15.1; CSA A23.3-94, 10.14.1, 10.15.1
Factors dialog box).

2. Moments at column ends, $M_1$ and $M_2$, are calculated, where $M_1$ is the moment with the smaller absolute value and $M_2$ is the moment with the larger absolute value. For columns in nonsway frames, the end moments will be equal to the factored applied first order moment. For columns in sway frames, the end moments will be the moments $M_1$ and $M_2$ calculated in the procedure for moment magnification at ends of compression member. While design codes define moment $M_2$ as always positive and the sign of moment $M_1$ depending on single or double curvature bending\(^{58}\), spColumn retains actual signs of moments $M_1$ and $M_2$ to ensure proper comparison of resulting magnified moments against negative and positive moment capacities of unsymmetrical sections (see Figure 2-8). This revised interpretation does not affect results of the moment magnification along length procedure because the procedure relies on the $M_1/M_2$ ratio. spColumn follows the code definition which assumes the ratio to be positive if the member is bent in single curvature and negative if bent in double curvature. If both moments are equal to zero, the program conservatively assumes the ratio of $M_1/M_2=1.0$.

3. Second-order effects along length for columns in nonsway frames can be ignored if:

$$\frac{k \ell_u}{r} \leq 34 - 12 \frac{M_1}{M_2} \leq 40$$

for ACI codes\(^{59}\),

and

$$\frac{k \ell_u}{r} \leq \frac{25 - 10(M_1/M_2)}{\left(\sqrt{P_f/\left(\frac{f'_c A_g}{\ell_u}\right)}\right)}$$

for the CSA standards\(^{60}\),

where $\ell_u$ is the unsupported column length, $r = \sqrt{I_g/A}$ is the radius of gyration, and the ratio $M_1/M_2$ is always taken as greater than or equal to $-0.5$.

4. If the ratio $k \ell_u/r$ exceeds 100, slenderness effects cannot be accounted for using moment magnification procedure\(^{61}\). A more exact method must be used. In this case, the program issues a warning message and aborts design or investigation procedure except for calculations per ACI 318-14, ACI 318-11, and ACI 318-08 where limit of $k \ell_u/r < 100$ does not explicitly apply and the program continues calculations after showing the warning message.

\(^{58}\) ACI 318-14, 2.1; ACI 318-11, 2.1; ACI 318-08, 2.1; ACI 318-05, 2.1; ACI 318-02, 10.0; CSA A23.3-14, 3.2; CSA A23.3-04, 2.3; CSA A23.3-94, 10.0

\(^{59}\) ACI 318-14, 6.2.5; ACI 318-11, 10.10.1; ACI 318-08, 10.10.1; ACI 318-05, 10.12.2; ACI 318-02, 10.12.2

\(^{60}\) CSA A23.3-14, 10.15.2; CSA A23.3-04, 10.15.2; CSA A23.3-94, 10.15.2

\(^{61}\) ACI 318-05, 10.11.5; ACI 318-02, 10.11.5; CSA A23.3-14, 10.13.2; CSA A23.3-04, 10.13.2; CSA A23.3-94, 10.13.2
5. The factor $C_m$ is computed as:

$$C_m = 0.6 + 0.4 \frac{M_1}{M_2}$$

and for codes other than ACI 318-14, ACI 318-11, and ACI 318-08, $C_m$ is taken as not less than 0.4.

If $M_1 = M_2 = 0$, the program assumes $C_m$ to be equal to 1.0. This is consistent with the assumption made above (in Step 2).

6. The sustained load factor $\beta_{dns}$ ($\beta_d$ for ACI 318-05/02 and CSA A23.3-14/04/94) is computed as the ratio of maximum factored axial sustained load to the maximum factored axial load for the load combination under consideration for compression members either in nonsway or sway frames. The value of $\beta_{dns}$ is not taken greater than 1.0.

7. Flexural stiffness $EI$ is computed as:

$$EI = \frac{0.2E_c I_g + E_s I_{se}}{1 + \beta_{dns}}$$

where $E_c$ is the modulus of elasticity of concrete, $E_s$ is the modulus of elasticity of steel, $I_g$ is the gross moment of inertia of the concrete section, and $I_{se}$ is the moment of inertia of reinforcement.

8. The critical buckling load, $P_c$ is computed as:

$$P_c = \frac{\pi^2 EI}{(k u)^2}$$

9. The magnification factor for moment along length, $\delta$, is computed as:

62. ACI 318-14, 6.6.4.5.3; ACI 318-11, 10.10.6.4; ACI 318-08, 10.10.6.4; ACI 318-05, 10.12.3.1; ACI 318-02, 10.12.3.1; CSA A23.3-14, 10.15.3.2; CSA A23.3-04, 10.15.3.2; CSA A23.3-94, 10.15.3.1

63. ACI 318-14, 6.6.4.5.4; ACI 318-11, 10.10.6.5; ACI 318-08, 10.10.6.5; ACI 318-05, 10.12.3.2; ACI 318-02, 10.12.3.2

64. ACI 318-14, 6.6.4.4.4; ACI 318-11, 10.10.6.2; ACI 318-08, 10.10.6.2; ACI 318-05, 10.11.1; ACI 318-02, 10.0; CSA A23.3-14, 3.2; CSA A23.3-04, 2.3; CSA A23.3-94, 10.0

65. ACI 318-14, 6.6.1.1; ACI 318-11, 10.10.2.2, 10.10.6.2; ACI 318-08, 10.10.2.2, 10.10.6.2; ACI 318-05, 10.13.5; ACI 318-02, 10.13.5; CSA A23.3-14, 10.14.1.3(a), 10.16.4; CSA A23.3-04, 10.14.1.3(a), 10.16.4; CSA A23.3-94, $\beta_d$ definition (a) in 10.0, 10.16.4

66. ACI 318-14, 6.6.4.4.4 Eq. 6.6.4.4.4(b); ACI 318-11, 10.10.6.1 Eq. 10-14; ACI 318-08, 10.10.6.1 Eq. 10-14; ACI 318-05, 10.12.3 Eq. 10-11; ACI 318-02, 10.12.3. Eq. 10-10; CSA A23.3-14, 10.15.3 Eq. 10-19; CSA A23.3-04, 10.15.3 Eq. 10-18; CSA A23.3-94, 10.15.3.1 Eq. 10-18

67. ACI 318-14, 6.6.4.4.2, Eq. 6.6.4.4.2; ACI 318-11, 10.10.6 Eq. 10-13; ACI 318-08, 10.10.6 Eq. 10-13; ACI 318-05, 10.12.3 Eq. 10-10; ACI 318-02, 10.12.3 Eq. 10-10; CSA A23.3-14, 10.15.3.1 Eq. 10-18; CSA A23.3-04, 10.15.3.1 Eq. 10-17; CSA A23.3-94, 10.15.3 Eq. 10-17
\[ \delta = \frac{C_m}{1 - \frac{P_u}{\phi_k P_c}} \geq 1.0 \]

where the stiffness reduction factor, \( \phi_k \), is equal to 0.75 (may be modified using the Slenderness Factors input box) and \( P_u \) is the factored axial load for the load combination under consideration.

10. The moment due to minimum eccentricity, \( e_{\text{min}} \) is computed as:

\[ M_{\text{min}} = P_u e_{\text{min}} \]

where

\[ e_{\text{min}} = 0.6 + 0.03h \], with \( h \) in inches,

\[ e_{\text{min}} = 15 + 0.03h \], with \( h \) in mm,

and \( h \) is the section dimension (diameter for circular sections) in the direction being considered.

11. The factored magnified moment along the length of a compression member, \( M_c \), is the larger of \( \delta M_2 \) and \( \delta M_{\text{min}} \). The program also calculates moment \( M_c \) based on the smaller end moment, \( M_1 \), to account for scenario when \( M_1 \) and \( M_2 \) are of different sign (double curvature bending). For an unsymmetrical section, the smaller moment, \( M_1 \), may govern the design when the moment capacity on the negative side of the interaction diagram is smaller than the moment capacity on the positive side (see Figure 2-8).

---

68. ACI 318-14, 6.6.4.5.2; ACI 318-11, 10.10.6 Eq. 10-12; ACI 318-08, 10.10.6 Eq. 10-12; ACI 318-05, 10.12.3 Eq. 10.9; ACI 318-02, 10.12.3 Eq. 10.9; CSA A23.3-14, 10.15.3.1 Eq. 10-17; CSA A23.3-04, 10.15.3.1 Eq. 10-16; CSA A23.3-94, 10.15.3 Eq. 10-16

69. ACI 318-14, 6.6.4.5.4; ACI 318-11, 10.10.6.5; ACI 318-08, 10.10.6.5; ACI 318-05, 10.12.3.2; ACI 318M-05, 10.12.3.2; ACI 318-02, 10.12.3.2; ACI 318M-02 10.12.3.2; CSA A23.3-14, 10.15.3.1; CSA A23.3-04, 10.15.3.1; CSA A23.3-94, 10.15.3.

70. ACI 318-14, 6.6.4.5.4; ACI 318-11, 10.10.6.5; ACI 318-08, 10.10.6.5; ACI 318-05, 10.12.3.2; ACI 318-02, 10.12.3.2; CSA A23.3-14, 10.15.3.1; CSA A23.3-04, 10.15.3.1; CSA A23.3-94, 10.15.3
2.7 Moments Magnification Ratio

For calculations in accordance with ACI 318-14/11/08, the value of total magnified moment including second-order effects (combined magnification at ends and along length of compression member) cannot exceed 1.4 times the corresponding moment due to first order effects\(^7\). Columns with second-order moment to first-order moment ratios exceeding 1.4 do not meet requirements of ACI 318-14/11/08.

The ratio of second-order moment, \(M_{2nd}\), to first-order moment \(M_{1st}\) is calculated for both values \((i = 1, 2)\) of magnified moment along length, \(M_{ci}\), i.e. based on \(M_1\) and \(M_2\):

\[\frac{M_{2nd}}{M_{1st}} = \frac{\delta M_1}{M_1} + \frac{\delta M_2}{M_2}\]

\(^{7}\) ACI 318-14, 6.2.6; ACI 318-11, 10.10.2.1; ACI 318-08, 10.10.2.1
Cutoff value of $M_{min}$ is applied to $M_{u_i}$ in order to avoid unduly large ratios in cases where $M_{u_i}$ moments are smaller than $M_{min}$.

If only magnification at ends is considered (i.e. when user chooses to bypass provision 10.10.2.2 of ACI 318-14/11/08 and ignores second order effects along the length of a compression member in a sway frame), the ratio of second-order moment, $M_{2nd_i}$, to first-order moment, $M_{1st_i}$, is calculated at both ends ($i = 1, 2$) as:

$$\frac{M_{2nd_i}}{M_{1st_i}} = \begin{cases} \frac{M_{i}}{M_{u_i}} & \text{if } |M_{u_i}| \geq |M_{\text{min}}| \\ \frac{M_{i}}{M_{\text{min}}} & \text{if } |M_{u_i}| < |M_{\text{min}}| \end{cases}$$

where $M_i$ are the magnified end moments $M_1$ and $M_2$, and $M_{u_i}$ are the corresponding factored applied moment composed of the part that causes no appreciable sidesway, $M_{\text{ins}}$, and the part that causes appreciable sidesway, $M_{\text{is}}$. If both $M_{2nd_i}$ and $M_{1st_i}$ moments are equal to zero, the program will report the ratio equal to 1.0. If only $M_{1st_i}$ moment is equal to zero, the program will report the ratio as a large value.

2.8 References

[1] Building Code Requirements for Structural Concrete (ACI 318-14) and Commentary (ACI 318R-14), American Concrete Institute, 2014
[2] Building Code Requirements for Structural Concrete (ACI 318-11) and Commentary (ACI 318R-11), American Concrete Institute, 2011
[3] Building Code Requirements for Structural Concrete (ACI 318-08) and Commentary (ACI 318R-08), American Concrete Institute, 2008
[4] Building Code Requirements for Structural Concrete (ACI 318-05) and Commentary (ACI 318R-05), American Concrete Institute, 2005
[5] Building Code Requirements for Structural Concrete (ACI 318-02) and Commentary (ACI 318R-02), American Concrete Institute, 2002
[7] A23.3-04, Design of Concrete Structures, Canadian Standards Association, 2004
[15] Building Code Requirements for Structural Concrete (ACI 318-14) and Commentary (ACI 318R-14), American Concrete Institute, 2014
[16] A23.3-14, Design of Concrete Structures, Canadian Standards Association, 2014
3.1 spColumn Interface .......................................................................................... 44
3.2 File Menu ........................................................................................................... 45
3.3 Input Menu ........................................................................................................ 47
3.4 Solve Menu ....................................................................................................... 49
3.5 View Menu ......................................................................................................... 50
3.6 Options Menu ................................................................................................... 52
3.7 Help Menu ......................................................................................................... 53
3.1 spColumn Interface

The spColumn Interface will appear after the program is started as shown below. The spColumn Interface consists of a Control Menu, Title Bar, Menu Bar, Toolbar, Information Bar, Graphics Bar, and a Status Bar. The program name and current data file name is shown in the Title Bar. All the menu commands can be accessed from the Menu Bar and some frequently used commands also can be accessed from the buttons in the Toolbar. The Status Bar shows the current state of the program.

![Main Window](image)

**Figure 3-1 Main Window**

**Control Menu**

The Control menu is located in the upper-left corner of the window and includes commands for sizing, moving, enlarging, restoring, and closing the window, as well as switching to other applications. To access the Control menu using the mouse, click the left mouse button on the box; using the keyboard, press ALT+ SPACEBAR.

**Title Bar**

The Title Bar displays the name of the application (spColumn in this case), along with the name of the current data file in use. If the data has not been saved into a file, the word Untitled is displayed in the Title Bar.
Menu Bar

The **Menu Bar** is located directly beneath the **Title Bar**. It lists the available menus. There is a total of 6 distinct drop-down menus accessible from the **Menu Bar**. The majority of commands appearing in the drop-down menus are also accessible via the program’s **Main Window** area.

Toolbar

The **Toolbar** is located directly below the **Menu** bar. It contains a collection of buttons (or icons) that provide a shortcut to accessing the menu commands. The **Toolbar** buttons can only be accessed using the mouse.

Information Bar

The **Information** bar is located on the left side of the spColumn window. The top part displays the column cross section. The bottom part is a list of selected input data echo.

Graphics Area

The **Graphics Area** covers most of the window. This is where the interaction diagram is shown.

Status Bar

The **Status Bar** is located directly beneath the program’s **Main Window** area. It displays important information such as units, design code, cursor position, and helpful messages.

### 3.2 File Menu

The **File** menu gives access to file operations, printing operations and to exiting the spColumn program.

**New (CTRL+N)**

Clears any input data and returns the data to the default values so that a new data file may be input.

**Open (CTRL+O)**

Opens an existing data file.

**Save (CTRL+S)**

Saves the changes you have made to the current input file under that same filename.
Save As

Enables you to name or rename a data file.

Import

Reads geometry, reinforcement or loads data from an ASCII (TXT) file, or imports section geometry and reinforcement from a DXF file.

Export

Exports interaction diagram and 3D failure surface to Comma-Separated Values (CSV) files (readable by most spreadsheet programs) or Tab-Delimited Text (TXT) files. Exports a column section to Drawing Exchange Format (DXF) file (readable by most CAD programs). Exports graphical report (screen printout) to Enhanced Metafile Format (EMF) file (readable by most graphics and word processing programs).

Revert

Discards any changes to the data file and returns to the most recently saved version of the data file. This option will only be available if the data file has been previously saved and there have been modifications done on the data file since. Do not save the data file immediately prior to reverting otherwise this command will have no effect.

Print Report

Provides the option to print Default report or Customize the report before printing.

Print Screen (CTRL+P)

Prints the graphical image displayed in the Graphics/Input Area of the Main Window. Displays Print dialog box and prints the results similarly as they appear on the screen.

Recent Data File List

Provides quick access to up to four recently open data files.

Exit

Ends the spColumn program. If you have made any changes to your data and have not saved them, spColumn will prompt you whether you want to save or abandon any changes you have made before you exit.
3.3 Input Menu

The Input Menu includes commands used to input the data needed to define a problem. The Input Menu contains the following commands: General Information, Material Properties, Section, Reinforcement, Slenderness, Loads, and Flip/Rotate Section.

General Information

The General Information command allows you to enter the project, column and engineer names. It also allows the selection of units, run options, run axis and slenderness consideration.

Material Properties

The Material Properties command enables you to input material properties for concrete and reinforcing steel.

Section

Rectangular: Input the dimensions of a rectangular section.

Circular: Input the diameter of a circular section.

Irregular: Initiates spSection module to define an irregularly shaped section. Available under investigation option only. See Chapter 6 for spSection module.

Reinforcement

All Sides Equal: Input a reinforcement pattern in which all the bars are of one size, and the number of bars is the same on all four sides of a rectangular layout or are equally spaced for a circular layout. Number of bars should be enter as multiple of four (4). Available for rectangular and circular sections.

Equal Spacing: Input a reinforcement pattern in which all bars are of one size and are uniformly spaced on all four sides of a rectangular layout. Number of bars should be entered as multiple of four (4). Available for rectangular sections only.

Sides Different: Input a reinforcement pattern in which each one of the four sides of a rectangular section has a certain number of bars and a certain bar size. Available for rectangular sections only.

Irregular Pattern: Input a reinforcement pattern in such a way that bars of any size can be placed anywhere within the column section.
**Confinement:** Input confinement-related data such as the capacity reduction factors and the size of ties associated with the longitudinal bar size.

**Design Criteria:** Input parameters that govern the design of the section such as column type, minimum and maximum reinforcement ratio, bar selection criterion, minimum clear spacing, and design/required ratio.

**Slenderness**

**Design Column:** Input data needed for slenderness related to the column being considered.

**Column Above/Below:** Input data needed for slenderness related to the columns above and below the design column.

**X-Beams:** Input data needed for slenderness related to beams perpendicular to the x-axis framing into the design column at top and bottom joints.

**Y-Beams:** Input data needed for slenderness related to beams perpendicular to the y-axis framing into the design column at top and bottom joints.

**Factors:** Slenderness factors related to stiffness reduction factor and cracked-section coefficients. Code defaults are selected by default. However, user-defined selection is also available.

**Loads**

**Factored:** Input factored axial loads and moments. *This option is available for non-slender columns only.*

**Service:** Input service-level (dead, live, wind, earthquake, and snow) axial loads and moments about the active axis. Moments are input at the top and at the bottom of the column. *This option is available for both slender and non-slender columns.*

**Control Points:** If chosen, the program will compute key points on the interaction diagram. In addition, the splice regions are shown on the interaction diagram. *This option is available for non-slender columns under the investigation option only. Also the splice lines are only shown for uniaxial runs.*

**Axial Loads:** Input a group of axial loads with an initial value, a final value, and an increment. *This option is available for uniaxial non-slender columns under the investigation option only.*

**Load Combinations:** Input the load factors and combinations used to combine the service loads.

**Flip/Rotate Section**

Flip an unsymmetrical section about an axis or rotate an irregular section (created in spSection).
3.4 Solve Menu

The Solve Menu contains the command to execute the design or investigation calculations along with options that control inclusion of nominal capacity calculations, tracing through the design process, and creating the classic results file. The Solve Menu contains the following commands: Execute, Include Nominal Diagram, Design Trace, and Results File.

Execute (F5)

Executes the Solver.

Include Nominal Diagram

Toggles INCLUDE NOMINAL DIAGRAM option on and off.

Design Trace

Toggles DESIGN TRACE option on and off.

Classic Results File

Toggles CLASSIC RESULTS FILE option on and off.
The **View** menu commands can be used to customize the display screen to suit your viewing needs and enable you to view the result diagrams. The **View** menu contains the following commands: **Results, Reporter, Redraw, Copy Diagram to Clipboard, Information Bar, Tool Bar, Status Bar, Grid, Mx-My Diagram, P-M Diagram - Full, P-M Diagram - M Positive, P-M Diagram - M Negative, P-M Diagram - 3D, Next Load, Previous Load, Next Angle, Previous Angle, Show Load Point Labels, Show Splice Lines, Show Normal Diagram, Superimpose...**

**Results (F6)**

Executes the spResults module to view the input and output data after a successful run has been performed.

**Reporter (F7)**

Executes the spReporter module to generate and print reports after a successful run has been performed.

**Redraw**

Redraws the displayed diagrams or contours.

**Copy Diagram to Clipboard (CTRL+C)**

Copies the displayed diagram or contour to clipboard so that it can be pasted in other applications.

**Information Bar**

Shows or hides the **Information Bar**.

**Tool Bar**

Shows or hides the **Tool Bar**.

**Status Bar**

Toggles the **Status Bar** at the bottom of the screen on or off.
Grid

Shows or hides the Grid.

Mx-My Diagram

View a contour of the failure surface sliced at a constant axial load.

P-M Diagram - Full

View an interaction diagram sliced at a constant $(M_x, M_y)$ angle drawn for both positive and negative moments.

P-M Diagram - M positive

View an interaction diagram sliced at a constant $(M_x, M_y)$ angle drawn for the positive moments only.

P-M Diagram - M negative

View an interaction diagram sliced at a constant $(M_x, M_y)$ angle drawn for the negative moments only.

P-M Diagram – 3D

View a three dimensional visualization of the complete nominal and factored failure surface for sections subject to biaxial bending.

Next Load (Ctrl + Arrow Up)

View an $M_x$-$M_y$ interaction diagram for the factored load next to the one displayed currently on the interaction diagram.

Previous Load (Ctrl + Arrow Up)

View an $M_x$-$M_y$ interaction diagram for the factored load previous to the one displayed currently on the interaction diagram.

Next Angle

View a P-M interaction diagram for the $(M_x, M_y)$ angle next to the one currently displayed on the interaction diagram.

Previous Angle

View a P-M interaction diagram for the $(M_x, M_y)$ angle previous to the one currently displayed on the interaction diagram.
**Show Load Point Labels**

Show/Hide Load Point labels of loads input.

**Show Splice Lines**

Show the P-M splice lines corresponding to $f_s = 0$ and $f_s = 0.5f_y$.

**Show Nominal Diagram**

Show nominal (unfactored) capacity interaction diagram in addition to the design (factored) capacity interaction diagram. Available only when **Include Nominal Diagram** option is selected in the **Solve** menu.

**Superimpose**

Superimpose an interaction diagram from a previously saved run over the current interaction diagram.

### 3.6 Options Menu

The **Options** menu allows you to change the startup options of the spColumn program to suit your needs. The **Options** menu contains the following commands: **Startup Defaults** and **Reinforcement**.

**Startup Defaults**

The **Startup Defaults** command allows you to change the default system of units, design code, reinforcement database, and the data directory which is where the program looks for data when it is executed.

**Reinforcement**

View or Edit reinforcing bar set.
3.7 Help Menu

The Help menu includes commands that enable you to obtain online help for the program and show the copyright and registration information about your software.

spColumn Info

Opens information page for the current version of spColumn being used in the default browser. Internet connection is required.

Submit a Question

Opens “Submit a Question” page where you can ask questions on Technical, Licensing, Sales, Pricing or other topics via e-mail. Internet connection is required.

Manual

Opens spColumn Manual in the default browser. Internet connection is required.

Help

Uses the default browser to open spColumn Help. It provides access to all available help topics. Click on any topic and a help screen will appear with information about that item. Internet connection is required.

Tutorial Videos

Uses the default browser to open a page containing spColumn tutorial videos. Internet connection is required.

Design Examples

Uses the default browser to open a page containing design examples for StructurePoint software. Internet connection is required.

Check for Updates

Checks if a newer version of spColumn is available. Internet connection is required.

Release Notes

Uses default browser to open a page containing release notes for the version of spColumn being used. Internet connection is required.
About spColumn

Shows the version number of the program, the licensing information, and the copyright information. In the case of a trial license, the expiration date is given as well as the locking code which is needed to obtain a standalone license.
4.1 Introduction

In this chapter, the sections follow the order in which commands and options appear beginning with those found under the File menu and ending with those under the Help menu.

Many of the commands and options that appear under these menus are also accessible by other methods. Consequently, these other methods are also explained.

4.2 Creating New File

When spColumn is loaded, the program is ready to begin receiving input for a new project. Until you save the file, the data will not have a filename associated with it, and the title bar will display the word Untitled as illustrated here:

- From the File menu, choose New. This clears the screen in preparation for a new project or data entry file and returns the program to its default settings.
- If existing data on an open project has been changed prior to executing the New command, the program will display the following message box inquiring whether you wish to save the data on the open project or data file before creating a new file:

4.3 Opening File

spColumn allows you to open data files that were saved at an earlier time including files from previous versions of spColumn as well as pcaColumn. Note that the extension name of a
pcaColumn and spColumn file is .COL. spColumn also opens files with the spColumn Text Input, .CTI, extension.

- From the **File** menu, choose **Open** and a dialog box will appear.
- All files with the COL extension contained in the current drive and directory are displayed in the **FILE NAME** list box. To view files with the .CTI extension use the file type drop-down menu to choose the .CTI extension.
- To open a file that exists in another drive or directory, select the drive or directory you want from the **LOOK IN** drop-down list.
- From the **FILE NAME** list box, select the file to be opened, or simply type its name in the text box.
- Choose the OK button.
- Alternatively, an input file can be opened by spColumn if the file is drag-and-dropped onto the program window or if the file pathname is provided as a command line parameter when invoking spColumn from the command prompt.

![](image)

**4.4 Saving File**

spColumn files are saved in a binary format with .COL or .CTI extensions.

---

72 For more information see "spColumn Text Input (CTI) file format" on page 176.
4.4.1 Save the data with the same file name

- At any time while editing a data file that has previously been saved under a file name, choose File and Save to save the changes under the same file name, overwriting the old file. From the File menu, select the Save command before giving the data file a name displays the Save As dialog box.

4.4.2 Change format or rename the file

- From the File menu, select Save As, and a dialog box will appear.
- All files with .COL extensions contained in the current drive and directory are displayed in the FILE NAME list box.
- To save the file to a drive or directory other than the default, select a different drive or directory drive from the SAVE IN drop-down list.
- Use FILE TYPE list box to select either spColumn Input File, .COL, or spColumn Text Input File, .CTI.
- In the FILE NAME text box, type a new file name. If no file extension is specified, an extension will be appended to the specified file name based on the selected file type.
- Choose the OK button.
4.5 Most Recently Used Files (MRU)

The Most Recently Used Files (MRU) list shows the four data files that were opened most recently. Selecting a data file from this list makes it easier and faster to open the file. The list is empty when the program is executed for the first time.

4.6 Importing

4.6.1 Importing Data

Geometry, reinforcement or load data may be imported from a text file. The import file must be saved in pure ASCII (text) format.

- Select File | Import | Import Data… or press CTRL + I keyboard shortcut to display IMPORT DATA dialog box.

- Select the type of data you want to import: SERVICE LOADS, FACTORED LOADS, REINFORCEMENT OR GEOMETRY.

- Choose the OK button. The Open Import file box is displayed.

- All files with the TXT extension contained in the current drive and directory are displayed in the FILE NAME list box.

- To open a file that exists in another drive or directory, select the drive or directory you want from the LOOK IN drop-down list.

- From the File Name list box, select the file to be opened, or simply type its name in the text box.

- Choose the OPEN button.

73. For more information see “spColumn Text Input (CTI) file format” on page 176.
4.6.2 Importing DXF Files

- Select File | Import | Import DXF... to display Open Import file box.
- All files with the DXF extension contained in the current drive and directory are displayed in the File Name list box.
- To open a file that exists in another drive or directory, select the drive or directory you want from the Look In drop-down list.
- From the File Name list box, select the file to be opened, or simply type its name in the text box.
- Choose the Open button.
- The basic IMPORT MODEL FROM DXF FILE dialog box is displayed.

![Image of basic IMPORT MODEL FROM DXF FILE dialog box]

- Press OK button.

The advanced IMPORT MODEL FROM DXF FILE dialog box can be displayed by clicking Advanced >> button in the basic view and is shown below.
If the DXF file (or selected layer) contains a closed polyline entity (either LWPOLYLINE or POLYLINE) it will be interpreted as the section outline. If multiple closed polylines are present then the first two will be automatically recognized as the outline and the opening and the rest will be ignored.

Reinforcing bars are derived from DXF circle entities (CIRCLE). If no closed polylines are present then the first circle entity will be interpreted as a circular shape of the column and the rest will be interpreted as reinforcing bars.

Dimensions of imported entities will be automatically converted to current project units based on DXF header variable $INSUNITS if the “Use unit from DXF file” option is checked otherwise the DXF file will be assigned the user defined length units and unit system which will then be converted to the current project units.
Once a successful run has been performed you may export results data of the following:

1. Points from the interaction diagram or 3D failure surface to a Comma-Separated Values (CSV) file or to a Tab Delimited Text file (TXT). These files can be read by most spreadsheet and mathematical programs where data produced by spColumn can be further analyzed and processed as needed by the user. Coordinates of the points \((P, M_x, M_y)\) are saved together with corresponding location of the neutral axis (depth and angle), maximum steel strain, and (for ACI code) strength reduction factor.

2. The column section can be exported to a file in Drawing Exchange Format (DXF) format that is readable by most CAD programs.

3. A graphical report can be exported to a file in Enhanced Metafile Format (EMF) that is readable by most graphics and word processing programs. The file will include column section, column information, and the interaction diagram currently displayed on the screen presented the same way as in the printout created by the default printer using the File | Print Screen command. The following steps are used to export various output data:

   • Select File | Export | Factored Interaction Diagram to export P-M or \(M_x-M_y\) diagram currently displayed on the screen.

   • Select File | Export | Factored 3D Failure Surface to export 3D failure surface (biaxial runs only).

   • Select File | Export | Nominal Interaction Diagram to export nominal (unfactored) P-M or \(M_x-M_y\) diagram corresponding to the one currently displayed on the screen.

   • Select File | Export | Nominal 3D Failure Surface to export nominal (unfactored) 3D failure surface (biaxial runs only).

   • Select File | Export | Column Section to DXF File to export column section to DXF file

   • Select File | Export | Graphical Report to EMF File to export graphical report to EMF file.

   • For interaction diagrams and 3D failure surface, use FILE TYPE list box to select either Comma-Separated Values (CSV) file or Tab Delimited Text file (TXT). For sections, only DXF format is available and for graphical reports, only EMF format is available.

   • In the FILE NAME text box, type the file name. If no file extension is specified, an extension will be appended to the specified file name based on the selected file type.
• Choose the SAVE button.

4.8 Revert

Discards any changes to the data and returns to the last version of saved data. This option will only be available if the file has been modified since the last file save.

4.9 Printing

Once a successful run has been performed you may print the diagram displayed on the screen using File | Print Screen command. You may print the report using File | Print Report | Default Report. If you select File | Print Report | Customized Report you will be taken to the spReporter module.

4.9.1 Print Screen

• Select File | Print Screen. A dialog box appears.
• Select the printer to send the diagram displayed on the screen to.
• Use Print dialog controls to set up the printer options.
• Choose the OK button to start the printing or choose the CANCEL to terminate the print job.
4.9.2 Print Report

- Select the printer to send the report to.
- Use the PROERTIES button to access and modify the printer options if required.
- choose the OK button to start printing or CANCEL to terminate the print job.
4.10 General Information

The General Information command allows you to define or change options that will affect the rest of the input.

- Select **Input | General Information**. A dialog box appears.
- Enter the PROJECT, COLUMN, and ENGINEER labels.
- Select the units of measure, ENGLISH or METRIC.
- Select the axis about which the column capacity is to be computed: ABOUT X-AXIS, ABOUT Y-AXIS, or BAXIAL.
- Select a design code to conform to: ACI 318-14, ACI 318-11, ACI 318-08, ACI 318-05, ACI 318-02, CSA A23.3-14, CSA A23.3-04 or CSA A23.3-94.
- Choose a run option: INVESTIGATION or DESIGN.
- Specify whether slenderness effects are to be considered or not by checking either YES or NO under the CONSIDER SLENDERNESS? option.
- Choose the OK button.

4.11 Material Properties

- Select **Input | Material Properties**. A dialog box appears.
- Enter the concrete compressive strength, \( f'_c \) under STRENGTH, \( f'_c \). The modulus of elasticity, \( E_c \), under ELASTICITY, \( E_c \); the constant stress intensity, \( f'_c \) at the maximum usable strain used to calculate the force on concrete, under MAX STRESS, \( f_c \); the factor used to determine the depth of the stress block, under BETA(1); and the maximum usable strain at the extreme concrete compression fiber, at the ULTIMATE STRAIN are automatically computed and displayed. Modify any of the values if different than computed.
- For the reinforcing steel, enter the yield strength, \( f_y \) under STRENGTH, \( f_y \). The modulus of elasticity, \( E_s \) under the ELASTICITY, \( E_s \), as well as Compression-controlled strain limit, Eps_yt are automatically computed and displayed. Modify any of the values if different than computed.
• Choose the OK button to accept standard or modified values based on user’s judgment.

4.12 Section / Rectangular

4.12.1 Input for the Investigation Option:
• Select Input | Section | Rectangular. A dialog box appears.
• Enter the width and depth of the rectangular section using WIDTH (ALONG X) and DEPTH (ALONG Y) respectively. Note that width is measured along the x-axis and depth is measured along the y-axis.
• Choose the OK button

4.12.2 Input for the Design Option:
• Select Input | Section | Rectangular. A dialog box appears.
• Enter the starting and ending values for each dimension (width and depth) along with an increment for each dimension under START, END and INCREMENT columns along WIDTH (ALONG X) and DEPTH (ALONG Y). Note that the starting and ending values may be the same (in which case the increment must be zero).
• Choose the OK button.
4.13 Section/Circular

4.13.1 Input for the Investigation Option:

- Select Input | Section | Circular. A dialog box appears.
- Enter the diameter of the column section.
- Choose the OK button.

4.13.2 Input for the Design Option:

- Select Input | Section | Circular. A dialog box appears.
- Enter the starting and ending values of the diameter along with an increment. Note that the starting and ending values may be the same (in which case the increment must be zero).
- Choose the OK button.

4.14 Reinforcement/All Sides Equal

The Input | Reinforcement | All Sides Equal command allows you to enter the total number of bars in the column section. The program attempts to place equal number of bars on each side of a rectangular layout then equally space them on each side. For a circular layout, the program attempts to equally space the bar.

4.14.1 Input for the Investigation Option:

- Select Input | Reinforcement | All Sides Equal. A dialog box appears.
- Enter the total number of bars in the section NO. OF BARS (Must be at least 4 and a multiple of 4).
- Select the bar size.
- Enter the clear cover and specify whether it is to the transverse bars (ties) or to the longitudinal bars.
- Select a bar layout, CIRCULAR or RECTANGULAR. The default is CIRCULAR for a circular section and RECTANGULAR for a rectangular section.
• Choose the OK button

4.14.2 Input for the Design Option

• Select Input | Reinforcement | All Sides Equal. A dialog box appears.

• Enter the minimum and maximum total number of bars in the section (*must be at least 4 and a multiple of 4 for a rectangular layout*).

• Select the minimum and maximum bar sizes along with the clear cover.

• Enter the clear cover and specify whether it is to the transverse bars (ties) or to the longitudinal bars.

• Select a bar layout, Circular or Rectangular. The default is CIRCULAR for a circular section and RECTANGULAR for a rectangular section.

• Choose the OK button.

4.15 Reinforcement/Equal Spacing

The Input | Reinforcement | Equal Spacing command allows you to enter the total number of bars in the column section. The program attempts to place the bars equally spaced on all four sides of a rectangular layout. This command is only applicable for rectangular sections.

4.15.1 Input for the Investigation Option:

• Select Input | Reinforcement | Equal Spacing. A dialog box appears.

• Enter the total number of bars in the section NO. OF BARS. (*Must be at least 4 and a multiple of 4*).

• Select the bar size.

• Enter the clear cover and specify whether it is to the transverse bars (ties) or to the longitudinal bars.

• Choose the OK button.

4.15.2 Input for the Design Option:

• Select Input | Reinforcement | Equal Spacing. A dialog box appears.
• Enter the minimum and maximum total number of bars in the section under MINIMUM and MAXIMUM corresponding to NO. OF BARS. (*must be at least 4 and a multiple of 4*).

• Select the minimum and maximum bar sizes.

• Enter the clear cover and specify whether it is to the transverse (ties) or to the longitudinal bars.

• Choose the OK button.

### 4.16 Reinforcement/Sides Different

#### 4.16.1 Input for the Investigation Option:

• Select **Input | Reinforcement | Sides Different**. A dialog box appears.

• Enter the number of bars to be placed on each of the top, bottom (*on the top and bottom, number of bars needs to be at least 2*), left and right sides (*on the left and right, the number of bars may be any number*) of the rectangular section. *Note that corner bars are associated with the top and bottom sides.*

• Select the bar size and enter the clear cover for each of the top, bottom, left and right sides of the section.

• Specify whether the clear cover entered is to the transverse (ties) or to the longitudinal bars.

• Choose the OK button.

#### 4.16.2 Input for the Design Option:

• Select **Input | Reinforcement | Sides Different**. A dialog box appears.
• In the Top and Bottom Group
  – Enter the minimum and maximum **total** number of bars to be placed on the top and bottom sides.
  – The number of bars must be greater than 4 and a multiple of 2. Corner bars are associated with the top and bottom sides.
  – Select the minimum and maximum bar size and enter the clear cover.

• In the Left and Right Group
  – Enter the minimum and maximum **total** number of bars to be placed on the Left and Right sides. The minimum and maximum number of bars can be set to zero (0) or must be multiple of 2.
  – The minimum and maximum bar size entries are inactivated, therefore, follows the entries for Top and Bottom Group.
  – Enter the clear cover.

![Sides Different window](image)

• Specify whether the clear cover entered is to the transverse (ties) or to the longitudinal bars.
• Choose the OK button.

### 4.17 Reinforcement/Irregular Pattern

The **Input | Reinforcement | Irregular Pattern** command allows you to specify any number of bars (up to 10,000) to be placed anywhere within the column section. Each bar may have any cross-sectional area. *This command is available with the Investigation option only.*
• Select **Input | Reinforcement | Irregular Pattern.** If the section is irregular, The spSection window, where the section reinforcement may be graphically input, is displayed. Otherwise, a dialog box appears.

• Enter the bar area, along with its x- and y-coordinates.

• Choose the INSERT button. The data are added to the list box.

• Repeat the steps above for each entry.

• To edit an entry, select it from the list box, modify its values in the text boxes, and choose the MODIFY button. To change the area for several bars at once, select those bars from the list box, enter the new area in the AREA text box, and choose MODIFY.

• To delete a bar entry, select it from the list box and choose the DELETE button.

• Choose the OK button.

### 4.18 Reinforcement/Confinement

• Select **Input | Reinforcement | Confinement.** A dialog box appears.

• Select the type of bar confinement: TIED (default), SPIRAL, or Other. The capacity reduction factors change depending on the selection.

• To modify the capacity reduction factors, choose OTHER for confinement type.

For the ACI code:

\[ \Phi(a) \text{ is the reduction factor for allowable compression,} \]
\[ \Phi(b) \text{ is the strength reduction factor for tension controlled failure,} \]
\[ \Phi(c) \text{ is the reduction factor for compression controlled failure.} \]

For the CSA code:

\[ \Phi(a) \text{ is the reduction factor for allowable compression,} \]
Phi(s) is the material resistance factor for steel,

Phi(c) is the material resistance factor for concrete.

• Specify the tie size associated with the particular longitudinal bar sizes. The code requirements are used as defaults.
• Choose the OK button.

Note that if confinement is selected as TIED or SPIRAL then the program will automatically adjust the factors when the user changes the design code. However, if OTHER confinement is selected, the factors will not be adjusted.

For CSA A23.3-14, the reduction factor for allowable compression is variable (shown as VAR) and for irregular sections the wall thickness or minimum column dimension must also be specified.

4.19 Reinforcement / Design Criteria

• Select Input | Reinforcement | Design Criteria. A dialog box appears. This command is available with the Design option only.
• Specify whether the column is to be considered STRUCTURAL (default), ARCHITECTURAL, or OTHER. Notice that the minimum and maximum reinforcement ratios change depending on the selection.
• Choose whether bar selection is to be based on MINIMUM NUMBER OF BARS (default) or on MINIMUM AREA OF STEEL.
• To modify the limiting reinforcement ratios, choose OTHER. Enter the minimum and maximum reinforcement ratios in the corresponding text boxes.
• Enter the minimum clear bar spacing and the design-to-required ratio.
• Choose the OK button.
4.20 Slenderness / Factors

- Select Input | Slenderness | Factors. A dialog box appears. Note: this command is available for slender columns only.

- The default values, per the design code, for the stiffness reduction factor (used to compute the moment magnification factors) and the cracked section coefficients for beams and columns are displayed. To modify these values, select the USER-DEFINED option and enter your values.

- Choose the OK button.

4.21 Slenderness / Design Column

- Select Input | Slenderness | Design Column. A dialog box appears. The x-axis or y-axis data groups may be disabled depending on the active run axis. Note: this command is available for slender columns only.

- Enter the clear column height in the corresponding text box.

- Specify whether the column is braced against sidesway or not by selecting or clearing the NONSWAY FRAME option.

- For a sway column, enter the ratio of the sum of the critical load of all story columns to the critical load of the column under consideration, (SUM Pc)/Pc. Also, enter the ratio of the sum of the factored axial load of all story columns to the factored axial load of the column under consideration, (SUM Pu)/Pu. Check 2ND ORDER EFFECTS ALONG LENGTH option to consider 2nd order effects along length. Note: this option is available for ACI 318-14, ACI 318-11, and ACI 318-08 codes only. For more information see "Moment Magnification along Length of Compression Member" on page 35.

- In the EFFECTIVE LENGTH FACTORS group, specify whether the k factor(s) are to be user-input or computed by the program, by selecting the corresponding option.
• If you chose **INPUT K FACTORS**, enter the effective length factors for nonsway and sway conditions, \( k(\text{ns}) \) and \( k(\text{s}) \), respectively.

• Repeat the steps above for each active axis.

• Choose the OK button.

### 4.22 Slenderness / Columns Above and Below

• Select **Input | Slenderness | Columns Above/Below**. A dialog box appears. *Note: this command is available for slender columns only for which the COMPUTE K FACTORS option is selected in the DESIGN COLUMN dialog box.*

![Columns Above and Below dialog box](image)

• In the **COLUMN ABOVE** group, specify whether or not a column above the design column exists, by selecting or clearing the **NO COLUMN SPECIFIED** OPTION.

• If a column above exists; enter the center-to-center height, the width (along the x-axis), the depth (along the y-axis), the concrete compressive strength, and the concrete modulus of elasticity of the column above in the corresponding text boxes. For circular sections, enter zero for the DEPTH and input the section diameter in the WIDTH box. If zero is entered for both Width and Depth, the dimensions of the design column will be automatically used.

• Repeat the same for the column below or, if the column above and the column below are the same, choose the **COPY TO COLUMN BELOW** button.

• Choose the OK button.
4.23 Slenderness / X-Beams

- Select **Input | Slenderness | X-Beams**. A dialog box appears. Beams defined using this command span perpendicular to the x-axis. *Note: this command is available for slender columns only for which the COMPUTE K FACTORS option is selected in the DESIGN COLUMN dialog box and the RUN AXIS is BIAXIAL or uniaxial ABOUT X-AXIS.*

- From the **Beam Location** group, choose the appropriate option. The data group below updates depending on the selection.

- For the selected beam, specify whether or not a beam exists, by selecting or clearing the **NO BEAM SPECIFIED** option.

- If a beam exists; enter the center-to-center span length, width, depth, concrete compressive strength, concrete modulus of elasticity, and moment of inertia (if different than computed) of the beam.

- Repeat the steps above for the beams **ABOVE RIGHT**, **BELOW LEFT**, and **BELOW RIGHT**.

- Choose the **OK** button.
4.24 Slenderness / Y-Beams

- Select Input | Slenderness | Y-Beams. A dialog box appears. Beams defined using this command span perpendicular to the y-axis. Note: this command is available for slender columns only for which the COMPUTE K FACTORS option is selected in the DESIGN COLUMN dialog box and the RUN AXIS is BIAXIAL or uniaxial ABOUT Y-AXIS.

- From the BEAM LOCATION group, choose the appropriate option. The data group below updates depending on the selection.

- For the selected beam, specify whether or not a beam exists, by selecting or clearing the NO BEAM SPECIFIED option.

- If a beam exists; enter the center-to-center span length, width, depth, concrete compressive strength, concrete modulus of elasticity, and moment of inertia (if different than computed) of the beam.

- Repeat the steps above for the beams ABOVE RIGHT, BELOW LEFT, and BELOW RIGHT.

- Choose the OK button.

4.25 Loads / Factored

When designing or investigating a non-slender column, factored loads consisting of applied axial loads and moments about the active axis may be input. This command is not available for slender columns.
- Select Input | Loads | Factored. A dialog box appears.
- Enter the factored axial load in the LOAD text box.
- Based on the active axis, enter the factored moment about the x-axis, X-MOMENT, the factored moment about the y-axis, Y-MOMENT, or both.
- Choose the INSERT button. The data are added to the list box.
- Repeat the steps above for each factored load entry.
- To edit an entry, select it from the list box, modify its values in the text boxes, and choose the MODIFY button.
- To delete an entry, select it from the list box and choose the DELETE button.
- Choose the OK button.

4.26 Loads / Service

When designing or investigating a non-slender or slender column, service level loads consisting of dead, live, lateral (wind and earthquake), and snow axial loads and moments at both column ends about the active axis may be input. These loads are then factored and combined based on the load combinations.

- Select Input | Loads | Service. A dialog box appears.
- For each of the load cases: Dead, Live, Wind, Earthquake (EQ), and Snow, enter the axial load and the applicable moment (about x or y) at the column top and bottom.
- Enter the percentage of the sustained part of the load in each load case (by default only Dead Load is assumed to be 100% sustained). These percentages will be used to arrive at sustained axial load ratio $\beta_{dns}$ to calculate moment magnification factor along length of the column$^{74}$.
- Choose the INSERT button. The data are added to the list box.
- Repeat the steps above for each entry.

---

$^{74}$For moment magnification at ends of a column in a sway frame, the value of $\beta_{ds}$ is assumed to be zero and is not affected by sustained load factors (For more information see "Moment Magnification at Ends of Compression Member" on page 32.)
• To edit an entry, select it from the list box, modify its values in the text boxes, and choose the MODIFY button.
• To delete an entry, choose it from the list box and choose the DELETE button.
• Choose the OK button.

4.27 Loads / Control Points

A non-slender column may be investigated without inputting any loads. The capacity of the section is computed along with other section capacity parameters. This command is not available for slender columns or under the Design option.

• Select Input | Loads | Control Points.

In the output file, key points (e.g. balanced point and pure bending) on the interaction diagram are listed. For each point, the axial load and bending moment capacities, along with the corresponding neutral axis depth, distance from extreme compression fiber to centroid of extreme layer of longitudinal tension steel, net tensile strain in extreme layer of longitudinal tension steel at nominal strength, and strength reduction factor (ACI only) are listed. For a biaxial run, these points are listed for bending about positive and negative X and Y axes.
For ACI code, the program flags the unusual increase in axial load capacity in transition zone between the balanced point and the tension control point.

For uniaxial runs, the bar splice requirements for columns\(^\text{75}\) are indicated on the interaction diagram.

### 4.28 Loads / Axial Loads

When investigating a non-slender column (uniaxial runs only), grouped factored applied axial loads may be input. The corresponding moment capacity for each load is computed and output. *This command is not available under the DESIGN option, for biaxial runs, or if the column is slender.*

- Select **Input | Loads | Axial Loads**. A dialog box appears.
- To input a range of axial loads, enter the initial, final and increment values in the corresponding text boxes. To input a discrete (single) axial load, enter its value in the **INITIAL** text box, and enter zero in the **FINAL** and **INCREMENT** text boxes.
- Choose the **INSERT** button. The data are added to the list box.
- Repeat the steps above for each axial load entry you may have.
- To edit an entry, select it from the list box, modify its values in the text boxes, and choose the **MODIFY** button.
- To delete an entry, choose it from the list box and choose the **DELETE** button.
- Choose the **OK** button.

---

75. ACI 318-14, Fig. R10.7.5.2; ACI 318-11, Fig. R12.17; ACI 318-08, Fig. R12.17; ACI 318-05, Fig. R12.17; ACI 318-02, Fig. R12.17; CSA A23.3-14, 12.17.3; CSA A23.3-04, 12.17.3; CSA A23.3-94, 12.17.3
4.29 Loads / Load Combinations

spColumn allows you to specify up to 50 load combinations. The service load input under the load cases (dead, live, wind, earthquake, and snow) are combined based on these combinations. A minimum of one combination must be input.

- Select Input | Loads | Load Combinations. A dialog box appears. For a new file, the default combinations per the selected code are shown in the list box.

- To add a new combination, enter the load factors or multipliers for each load case, DEAD, LIVE, WIND, Earthquake (EQ), and SNOW.

- Choose the INSERT button. The data are added to the list box.

- Repeat the steps above for each load combination. Up to fifty combinations may be defined.

- To edit an entry, select it from the list box, modify its values in the text boxes, and choose the MODIFY button.

- To delete an entry, choose it from the list box and choose the DELETE button.

- Choose OK when done.

4.30 Flipping / Rotating the Section

This command is available for Irregular sections and for sections with Sides Different or Irregular reinforcement.
Select **Input | Flip/Rotate Section**. A dialog box appears.

Select one of the options: **Flip section about X-axis**, **Flip section about Y-axis**, or **Rotate section**. The last option is available for irregular sections only.

If **Rotate section** is selected, enter the angle of rotation (clockwise is positive).

Choose the OK button.

### 4.31 Executing a Run

#### 4.31.1 From the program

Select **Solve | Classic Results File**. This is an option that may be turned ON or OFF by choosing it again. With this option ON, an output file will be created while the program is solving. The output file is a text file that contains an echo of the input along with slenderness calculation output, load combinations, and the critical points on the interaction diagram.

Select **Solve | Include Nominal Diagram**. This is an option that may be turned ON or OFF by choosing it again. With this option ON, calculations of nominal (unfactored) capacity interaction diagram will also be included in the calculations so that the nominal diagram can be viewed and exported in addition to the design (factored) capacity diagram.

Select **Solve | Design Trace** (*design option only*). This is an option that may be turned ON or OFF by choosing it again. With this option ON, if designing a column section, the program will pause at each cross section and reinforcement layout it tries, and display the cross section with its bars in the Information bar.

Select **Solve | Execute**. If more data are needed to solve the problem, an error box appears and you will be prompted for the required data. If all the needed data are input, the solver portion of spColumn will start executing. The Solving box appears with a progress indicator. Click Cancel to terminate the solution process. After a successful run, the interaction diagram or the contour plot is displayed in the Graphics area of the window.
4.31.2 From the command prompt

spColumn run can also be executed in batch mode from the command line prompt. Input data file, output data file, and run options can be passed to the program via parameters. For instance typing `spColumn /i:Examples\Example01.col` will run spColumn and solve the column defined in input file Example01.col.

Multiple cross-sections can be designed and analyzed by executing spColumn with multiple input files using batch (BAT) files (see Examples.bat in the spColumn program folder). Combined with Column Text Input files (CTI), this feature can be used for automation spColumn runs for projects involving large numbers of cross-sections.

Help on how to use command line parameters can be obtained by typing `spColumn /?` at the command prompt.
4.32 Viewing Results

Once a successful run has been performed, you may view the results file.

- Select View | Results. spColumn executes the spResults module. Alternatively you can also access spResults by pressing the F6 key.
• Use the explorer, options in the toolbar or the “PAGEUP” and “PAGEDOWN” buttons to navigate through the data tables.
• You can click the CLOSE button in the top right corner to exit spResults window.

4.33 Changing Startup Defaults

You can change some default settings that spColumn uses when it is started or when the File | New command is executed.

• Select Options | Startup Defaults. A dialog box appears.
• Enter the full path of the directory to which spColumn defaults when opening a data file.
• Select the system of units, design code, and reinforcement to be used as defaults whenever a new file is started.
• Enter the number of lines per page to be used in formatting the classic results file.
• Choose the SAVE button to save these options in the registry.
4.34 Changing Reinforcement Bar Set

- Select **Options | Reinforcement**. A dialog box appears.

**4.34.1 Select a different set**

- From the **BAR SET** drop-down list, select the set to be used.
- Choose the OK button.

**4.34.2 Create or modify a user-defined set**

- From the **BAR SET** drop-down list, select **USER-DEFINED**. The **ADD**, **DELETE** and **MODIFY** buttons are enabled.
- To edit an entry, select it from the list box, modify its values, and choose the **MODIFY** button.
- To delete an entry, select it from the list box and choose the **DELETE** button.
- To add an entry, enter the bar size, diameter, area and unit weight in the corresponding text box, and choose the **ADD** button. The data are added to the list box.
- A user-defined set may be saved to disk for use in other files. To do so, choose the **SAVE** button after inputting the bars. The bar set is saved to the file specified by the user. To retrieve a saved set, choose the **READ** button.
- Choose the OK button.

**4.35 Superimposing Diagrams**

After executing a run and selecting the **File | Save** command, the program saves the diagram data in a separate file that has the same file name as the input file, with an IAD extension. If calculations of nominal interaction diagram are included, the program stores also the nominal diagram data in an additional IAD file named as the input file name suffixed with “-nominal.iad”.
The IAD interaction diagram file may be later read by the program and two diagrams (of different files) may be superimposed for the purpose of comparison. Note that the RUN AXIS (uniaxial or biaxial) of the two files must be the same.

- Select View | Superimpose option. The open dialog box appears.
- All files with the IAD extension contained in the current drive and directory are displayed in the FILE NAME list box. To open a file that exists in another drive or directory, select a different drive or directory drive from the LOOK IN drop-down list.
- From the FILE NAME list box, select the file to be opened, or simply type its name in the text box.
- Choose the OK button. If the data is successfully read, the diagram from the IAD file (shown dotted) is superimposed over the currently displayed diagram.
- To clear the superimposed diagram, uncheck the View | Superimpose option.

### 4.36 Viewing 2D Diagrams

By default, the program displays diagrams based on the design (factored) section capacity. Display of diagrams based on the nominal (unfactored) strength is controlled by the View | Show Nominal Diagram option which is available when calculations of nominal diagram are activated using the Solve | Include Nominal Diagram option.

For a uniaxial run, the program computes and displays the P-M interaction diagram. For a biaxial run, the program computes the three-dimensional failure surface \((P, M_x, M_y)\). The failure surface can be viewed in one of two ways:

a) P-M interaction diagram (vertical slice at an angle measured from \(M_x\))

b) \(M_x-M_y\) contour curve (horizontal slice at a constant axial load).

Whenever the mouse cursor moves over the Graph area, the axial load, moment, and eccentricity are displayed in the Status bar.
4.36.1 Viewing P-M Interaction Diagram

- Select View | P-M Diagram - Full. A dialog box appears.
- You may also select View | P-M Diagram – M positive or View | P-M Diagram – M negative to view the interaction diagram only for positive or negative moments.
- Specify whether you want to enter an angle or the values of the moments that produce a view angle by selecting either the ANGLE or MOMENTS option, respectively.
- If the ANGLE option was selected, select an angle from the list, use the scroll bar to pick an angle, or simply enter the value in the text box.
- If the MOMENTS option was selected, enter the values of M_x and M_y which define the view angle. The value of that view angle is computed and shown in the ANGLE text box.
- To display all load points and their numbers check the LIST POINT NUMBERS option. To display unique angle values only, leave the option unchecked.
- Choose the OK button.
- You may browse through the angles by using View | Next angle and View | Previous angle respectively.

4.36.2 Viewing M_x-M_y Contours

- Select View | Mx-My Diagram. A dialog box appears.
- Select an axial load from the list, use the scroll bar to pick a load, or simply enter the value in the text box.
- To display all load points and their numbers check the LIST POINT NUMBERS option. To display unique axial load values only, leave the option unchecked.
- Choose the OK button.
- You may browse through the loads by using View | Next Load and View | Previous Load respectively.
4.37 Viewing 3D Failure Diagrams

- Select View | P-M Diagram - 3D. A dialog window appears launching the spColumn 3D viewer.

4.37.1 Main Menu

Export as Image

Exports the image as a PNG file to supplement calculation or reports.

Exit

Exits the 3D View window.

4.37.2 View Menu

Toolbar

Provides five options to determine the location and size of the toolbar.

Settings

Provides the user with options to modify general and color settings.

In General Settings, user controls are provided for general, failure surface, planes, and camera options.

In Colors Settings, user controls are provided for factored surface, nominal surface, load points, main axes angles, axis, and cutter plane options.
**View Controls**

Shows or hides the view controls. Arrows in the upper right corner provide controls for the location or the tool and extent of functions. The icons show in blue when active. View controls provide the following operator functions:

- Show and hide 3D rotation cube.
- Rotate section in 3D (shift + middle mouse button)
- Zoom to workspace
- Zoom in (mouse wheel)
- Zoom out (mouse wheel)
- Pan (middle mouse button)

**Status Bar**

Shows or hides the status bar. Status bar is located at the bottom of the screen and displays the design code, the load values at the cursor location, and the units.
4.37.3 Toolbar - General

Exit

Exits the 3D View window.

Export

Exports the image as a PNG file to supplement calculation or reports.

4.37.4 Toolbar - Tools

Cut Horiz. - Create horizontal cross section tool

Allows to cut the failure surface at desired height and investigate the inside of it.

Cut Vertical - Create vertical cross section tool

Allows to cut the failure surface at desired angle and investigate the inside of it.

4.37.5 Toolbar - Options

Pointer

Allows to investigate the failure surface and read column’s load capacity.

Nominal Surface

Shows or hides nominal surface.

Factored Surface

Shows or hides factored surface.

Load Points

Shows or hides load points.

Settings

Modifies settings for general, and colors. Refer to View Menu for more information on settings.
spColumn 3D View
spColumn 3D View - Failure surface horizontal cross section

spColumn 3D View - Failure surface vertical cross section
5.1 Example 1 - Capacity of a Square Column ............................................................. 97
  5.1.1 Problem Formulation...................................................................................... 97
  5.1.2 Preparing Input ........................................................................................... 97
  5.1.3 Assigning Properties .................................................................................... 98
  5.1.4 Solving ......................................................................................................... 98
  5.1.5 Viewing and Printing Results ..................................................................... 99
5.2 Example 2 - Investigation of a Slender Column - Nonsway Frame .............. 104
  5.2.1 Problem Formulation.................................................................................... 104
  5.2.2 Preparing Input ........................................................................................... 104
  5.2.3 Assigning Properties .................................................................................... 105
  5.2.4 Solving ......................................................................................................... 107
  5.2.5 Viewing and Printing Results ..................................................................... 107
5.3 Example 3 - Design of a Slender Column - Sway Frame .............................. 115
  5.3.1 Problem Formulation.................................................................................... 115
  5.3.2 Preparing Input ........................................................................................... 115
  5.3.3 Assigning Properties .................................................................................... 116
  5.3.4 Solving ......................................................................................................... 120
  5.3.5 Viewing and Printing Results ..................................................................... 120
5.4 Example 4 - Investigation of Concrete Shear Wall Capacity ....................... 126
  5.4.1 Problem Formulation.................................................................................... 126
  5.4.2 Assigning Properties .................................................................................... 131
  5.4.3 Solving ......................................................................................................... 132
  5.4.4 Viewing and Printing Results ..................................................................... 132
5.5 Example 5 - Capacity of an Irregular Section ............................................... 137
  5.5.1 Problem Formulation.................................................................................... 137
5.5.2 Preparing Input .............................................................. 138
5.5.3 Assigning Properties .................................................. 138
5.5.4 Solving ......................................................................... 140
5.5.5 Viewing and Printing Results ..................................... 140
5.6 Example 6 - Investigation of a Rectangle Short Column .... 146
5.6.1 Problem Formulation .................................................. 146
5.6.2 Preparing Input .......................................................... 146
5.6.3 Assigning Properties .................................................. 146
5.6.4 Solving ......................................................................... 148
5.6.5 Viewing and Printing Results ..................................... 148
5.1 Example 1 - Capacity of a Square Column

5.1.1 Problem Formulation

For a column section\textsuperscript{76} which is 16” x 16” and reinforced with 4-#8 bars, calculate the load moment capacities for the following load conditions:

Case 1: Bar stress near tension face of member equal to zero, \( f_s = 0 \).
Case 2: Bar stress near tension face of member equal to 0.5\( f_y \), \( f_s = 0.5f_y \)
Case 3: At limit for compression controlled sections. \( \varepsilon_s = 0.002 \)
Case 4: At limit for tension controlled sections. \( \varepsilon_s = 0.005 \)

Given a concrete of 4 ksi and reinforcing steel of 60 ksi.

5.1.2 Preparing Input

- From the File menu, choose New. Any input data is cleared and the default values are restored.
- From the Input menu, choose General Information.
  - Input the PROJECT header.
  - Select ENGLISH units and ACI 318-14 code.
  - Select About X-axis for run axis, Investigation for run option and No for Consider slenderness?
  - Choose OK.

### 5.1.3 Assigning Properties

- From the **Input** menu, choose **Material Properties**.
  - Accept the default properties as they match those in the problem statement
  - Choose OK.

- From the **Input** menu, choose **Section | Rectangular**.
  - For the section **WIDTH (ALONG X)**, input 16
  - For the section **DEPTH (ALONG Y)**, input 16.
  - Choose OK.

- From the **Input** menu, choose **Reinforcement | All Sides Equal**
  - Input 4-#8 bars under **NO. OF BARS**.
  - Input 1.5 in for the **CLEAR COVER** and select **TRANSVERSE BARS** under **COVER TO**.
  - Choose OK.

- From the **Input** menu, choose **Loads | Control Points**.

### 5.1.4 Solving

- From the **Solve** menu, choose **Execute**.
  - The P-M<sub>X</sub> contour is displayed in the Graphics area.
5.1.5 Viewing and Printing Results

- From the View menu, choose Results.
  - Use the explorer in the spResults module or the Previous Table and Next Table buttons in the toolbar to navigate through the tables.
  - Use the close button at the top right corner of the spResults windows to quit the spResults module and get back to spColumn.
- From the File menu, choose Print Report | Default Report.
  - Select the printer to send the default report to.
  - Choose PRINT.
- From the File menu, choose Print Screen.
  - Select the printer to send the graphical results to.
  - Choose PRINT
EXAMPLES

16 x 16 in

Code: ACI 318-14
Units: English
Run axis: About X-axis
Run option: Investigation
Slenderness: Not considered
Column type: Structural
Bars: ASTM A615
Date: 11/20/17
Time: 14:48:39

File: C:\Program Files (x86)\StructurePoint\spColumn\Examples\Examples-Manual\Example01.col
Project: spColumn Manual Example 1

Column: PCANotes 6.4
Engineer: SP
f_c = 4 ksi  f_y = 60 ksi  A_g = 256 in^2  4 #6 bars
E_c = 3605 ksi  E_s = 29000 ksi  A_s = 3.16 in^2  \rho = 1.23%
\epsilon_u = 3.4 ksi  \epsilon_{yt} = 0.00206897 in/in  X_0 = 0.00 in  I_x = 5461.33 in^4
\epsilon_{u} = 0.003 in/in  Y_0 = 0.00 in  I_y = 5461.33 in^4
Beta1 = 0.85  Min clear spacing = 10.25 in  Clear cover = 1.88 in
Confinement: Tied
\phi(a) = 0.8, \phi(b) = 0.9, \phi(c) = 0.65
1. General Information

<table>
<thead>
<tr>
<th>File Name</th>
<th>C:\Program Files (x86)\StructurePoint\Examples\Example01.col</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project</td>
<td>spColumn Manual Example 1</td>
</tr>
<tr>
<td>Column</td>
<td>PCANotes 6.4</td>
</tr>
<tr>
<td>Engineer</td>
<td>SP</td>
</tr>
<tr>
<td>Code</td>
<td>ACI 318-14</td>
</tr>
<tr>
<td>Bar Set</td>
<td>ASTM A615</td>
</tr>
<tr>
<td>Units</td>
<td>English</td>
</tr>
<tr>
<td>Run Option</td>
<td>Investigation</td>
</tr>
<tr>
<td>Run Axis</td>
<td>X-axis</td>
</tr>
<tr>
<td>Slenderness</td>
<td>Not Considered</td>
</tr>
<tr>
<td>Column Type</td>
<td>Structural</td>
</tr>
</tbody>
</table>

2. Material Properties

2.1. Concrete

<table>
<thead>
<tr>
<th>Type</th>
<th>Standard</th>
</tr>
</thead>
<tbody>
<tr>
<td>f'c</td>
<td>4 ksi</td>
</tr>
<tr>
<td>Ec</td>
<td>3605 ksi</td>
</tr>
<tr>
<td>f'c</td>
<td>3.4 ksi</td>
</tr>
<tr>
<td>εu</td>
<td>0.003 in/in</td>
</tr>
<tr>
<td>βc</td>
<td>0.85</td>
</tr>
</tbody>
</table>

2.2. Steel

<table>
<thead>
<tr>
<th>Type</th>
<th>Standard</th>
</tr>
</thead>
<tbody>
<tr>
<td>fy</td>
<td>60 ksi</td>
</tr>
<tr>
<td>Es</td>
<td>29000 ksi</td>
</tr>
<tr>
<td>εyt</td>
<td>0.00206897 in/in</td>
</tr>
</tbody>
</table>

3. Section

3.1. Shape and Properties

<table>
<thead>
<tr>
<th>Type</th>
<th>Rectangular</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>16 in</td>
</tr>
<tr>
<td>Depth</td>
<td>16 in</td>
</tr>
<tr>
<td>Ix</td>
<td>5461.33 in^4</td>
</tr>
<tr>
<td>Iy</td>
<td>5461.33 in^4</td>
</tr>
<tr>
<td>rx</td>
<td>4.6188 in</td>
</tr>
<tr>
<td>ry</td>
<td>4.6188 in</td>
</tr>
<tr>
<td>Xo</td>
<td>0 in</td>
</tr>
<tr>
<td>Yo</td>
<td>0 in</td>
</tr>
</tbody>
</table>
3.2. Section Figure

![Rectangular 16 x 16 in](image)

Figure 1: Column section

4. Reinforcement

4.1. Bar Set: ASTM A615

<table>
<thead>
<tr>
<th>Bar</th>
<th>Diameter (in)</th>
<th>Area (in²)</th>
</tr>
</thead>
<tbody>
<tr>
<td>#3</td>
<td>0.38</td>
<td>0.11</td>
</tr>
<tr>
<td>#6</td>
<td>0.75</td>
<td>0.44</td>
</tr>
<tr>
<td>#9</td>
<td>1.13</td>
<td>1.00</td>
</tr>
<tr>
<td>#14</td>
<td>1.69</td>
<td>2.25</td>
</tr>
<tr>
<td>#4</td>
<td>0.50</td>
<td>0.20</td>
</tr>
<tr>
<td>#7</td>
<td>0.88</td>
<td>0.60</td>
</tr>
<tr>
<td>#10</td>
<td>1.27</td>
<td>1.27</td>
</tr>
<tr>
<td>#18</td>
<td>2.26</td>
<td>4.00</td>
</tr>
</tbody>
</table>

4.2. Confinement and Factors

<table>
<thead>
<tr>
<th>Confinement type</th>
<th>Tied</th>
</tr>
</thead>
<tbody>
<tr>
<td>For #10 bars or less</td>
<td>#3 ties</td>
</tr>
<tr>
<td>For larger bars</td>
<td>#4 ties</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Capacity Reduction Factors</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Axial compression, (a)</td>
<td>0.8</td>
</tr>
<tr>
<td>Tension controlled failure, (b)</td>
<td>0.9</td>
</tr>
<tr>
<td>Compression controlled failure, (c)</td>
<td>0.65</td>
</tr>
</tbody>
</table>

4.3. Arrangement

<table>
<thead>
<tr>
<th>Pattern</th>
<th>All sides equal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bar layout</td>
<td>Rectangular</td>
</tr>
<tr>
<td>Cover to</td>
<td>Transverse bars</td>
</tr>
<tr>
<td>Clear cover</td>
<td>1.5 in</td>
</tr>
<tr>
<td>Bars</td>
<td>4 #8</td>
</tr>
</tbody>
</table>

| Total steel area, A_s | 3.16 in² |
5. Control Points

<table>
<thead>
<tr>
<th>About Point</th>
<th>P (kip)</th>
<th>X-Moment (k-ft)</th>
<th>Y-Moment (k-ft)</th>
<th>NA Depth (in)</th>
<th>dₜ Depth (in)</th>
<th>ε</th>
<th>φ</th>
</tr>
</thead>
<tbody>
<tr>
<td>X @ Max compression</td>
<td>682.0</td>
<td>0.00</td>
<td>0.00</td>
<td>43.90</td>
<td>13.83</td>
<td>-0.00207</td>
<td>0.65000</td>
</tr>
<tr>
<td>X @ Allowable comp.</td>
<td>545.6</td>
<td>72.20</td>
<td></td>
<td>15.81</td>
<td>13.83</td>
<td>-0.00041</td>
<td>0.65000</td>
</tr>
<tr>
<td>X @ tₜ = 0.0</td>
<td>467.6</td>
<td>102.64</td>
<td></td>
<td>13.63</td>
<td>13.63</td>
<td>0.00000</td>
<td>0.65000</td>
</tr>
<tr>
<td>X @ tₜ = 0.5 tₜ</td>
<td>331.8</td>
<td>135.43</td>
<td></td>
<td>10.13</td>
<td>13.63</td>
<td>0.000103</td>
<td>0.65000</td>
</tr>
<tr>
<td>X @ Balanced point</td>
<td>238.9</td>
<td>148.49</td>
<td></td>
<td>8.06</td>
<td>13.63</td>
<td>0.000207</td>
<td>0.65000</td>
</tr>
<tr>
<td>X @ Tension control</td>
<td>188.7</td>
<td>172.04</td>
<td></td>
<td>5.11</td>
<td>13.63</td>
<td>0.000500</td>
<td>0.90000</td>
</tr>
<tr>
<td>X @ Pure bending</td>
<td>0.0</td>
<td>91.03</td>
<td></td>
<td>2.24</td>
<td>13.63</td>
<td>0.01528</td>
<td>0.90000</td>
</tr>
<tr>
<td>X @ Max tension</td>
<td>-170.6</td>
<td>0.00</td>
<td></td>
<td>0.00</td>
<td>13.63</td>
<td>9.99999</td>
<td>0.90000</td>
</tr>
</tbody>
</table>

| X @ Max compression | 682.0 | 0.00 | 0.00 | 43.90 | 13.83 | -0.00207 | 0.65000 |
| X @ Allowable comp. | 545.6 | -72.20 | | 15.81 | 13.83 | -0.00041 | 0.65000 |
| X @ tₜ = 0.0 | 467.6 | -102.64 | | 13.63 | 13.63 | 0.00000 | 0.65000 |
| X @ tₜ = 0.5 tₜ | 331.8 | -135.43 | | 10.13 | 13.63 | 0.000103 | 0.65000 |
| X @ Balanced point | 238.9 | -148.49 | | 8.06 | 13.63 | 0.000207 | 0.65000 |
| X @ Tension control | 188.7 | -172.04 | | 5.11 | 13.63 | 0.000500 | 0.90000 |
| X @ Pure bending | 0.0 | -91.03 | | 2.24 | 13.63 | 0.01528 | 0.90000 |
| X @ Max tension | -170.6 | 0.00 | | 0.00 | 13.63 | 9.99999 | 0.90000 |
5.2 Example 2 - Investigation of a Slender Column - Nonsway Frame

5.2.1 Problem Formulation

Determine the adequacy of a 14” x 20” column\textsuperscript{77} with 6-#11 bars in a nonsway frame with a clear height of 22’6”. Use $k=1.0$.

The concrete used is 4.5 ksi and the reinforcing steel is 50 ksi.

The factored load values for the column under consideration are as follows:

- $P$ (kip): 115 kips
- Top $M_{uy}$ (kip-ft): 279 k-ft
- Bottom $M_{uy}$ (kip-ft): -279 ft-kips

5.2.2 Preparing Input

From the \textbf{File} menu, choose \textbf{New}. Any input data is cleared and the default values are restored.

- From the \textbf{Input} menu, choose \textbf{General Information}.
  - Input the PROJECT header.
  - Select ENGLISH units and ACI 318-14 code.
  - Select Biaxial for run axis, Investigation for run option and Yes for Consider Slenderness?
  - Choose OK.

\textsuperscript{77} Based on Example 15.8.5 from Reinforced Concrete Design by Chu-Kia Wang, Charles G. Salmon, and Jose A. Pincheira, Seventh Edition, 2007, John Wiley and Sons, Inc.
5.2.3 Assigning Properties

- From the Input menu, choose Material Properties.
  - Input 4.5 for the CONCRETE STRENGTH. Change the REINFORCING STEEL STRENGTH to 50. Other properties are computed and will be accepted.
  - Choose Ok.
- From the Input menu, choose Section | Rectangular.
  - Input 20 and 14 for the section width (along X) and depth (along Y).
  - Choose OK.
- From the Input menu, choose Reinforcement | Sides Different.
  - Input 2-#11 bars for TOP and BOTTOM and 1-#11 for LEFT and RIGHT. Input 1.5 in for the cover and select LONGITUDINAL BARS.
  - Choose OK.
- From the Input menu, choose Slenderness | Design Column.
  - Input 22.5 for the column CLEAR HEIGHT.
  - Check NONSWAY FRAME and select INPUT ‘k’ FACTORS. Input 1 for k.
  - Press COPY TO Y-AXIS.
  - Choose OK.
• From the **Input** menu, choose ** Loads | Service.**

  - Under **LIVE**, input 71.875 for the **AXIAL LOAD**, 0 for the **X-MOMENTS @TOP**, 0 for the **X-MOMENTS @BOT**, 174.375 for the **Y-MOMENTS @TOP** and -174.375 for the **Y-MOMENTS @BOTTOM**, respectively.

  - In column **SUSTAINED LOAD** keep default setting for dead load equal 100%.

  - Choose **INSERT** to add the entry to the list box.

  - Choose **OK**.
• From the Input menu, choose Loads | Load Combinations.
  - If the list displays thirteen combinations, choose only the second load combination U2 and delete all the others by selecting them and using DELETE. Choose OK.

5.2.4 Solving

• From the Solve menu, choose Execute.
  - The solver of the program is started and, upon completion, displays the interaction diagram of the section with the load point plotted within the diagram.

5.2.5 Viewing and Printing Results

• From the View menu, choose Results.
  - Use the explorer in the spResults module or the Previous Table and Next Table buttons in the toolbar to navigate through the tables.
  - Use the close button at the top right corner of the spResults windows to quit the spResults module and get back to spColumn.
• From the File menu, choose Print Report | Default Report.
  - Select the printer to send the default report to.
  - Choose PRINT.
• From the File menu, choose Print Screen.
  - Select the printer to send the graphical results to.
  - Choose PRINT.
Code: ACI 318-14
Units: English
Run axis: Biaxial
Run option: Investigation
Slenderness: Considered
Column type: Structural
Bars: ASTM A615
Date: 11/21/17
Time: 13:16:15

File: C:\Program Files (x86)\StructurePoint\spColumn\Examples\Examples-Manual\Example02.col
Project: spColumn Manual Example 2
Column: Wang 15.18.5

\( f_c = 4.5 \text{ ksi} \quad f_y = 50 \text{ ksi} \)
\( E_c = 3824 \text{ ksi} \quad E_s = 29000 \text{ ksi} \)
\( f_c = 3.825 \text{ ksi} \quad e_{yt} = 0.00172414 \text{ in/in} \)
\( e_u = 0.003 \text{ in/in} \)
\( \beta_1 = 0.825 \)
Confinement: Tied

\( \phi(a) = 0.8, \phi(b) = 0.9, \phi(c) = 0.65 \)
\( k_x(\text{nonsway}) = 1 \quad k_x(\text{sway}) = \text{N/A} \)
\( k_y(\text{nonsway}) = 1 \quad k_y(\text{sway}) = \text{N/A} \)
EXAMPLES

20 x 14 in

Code: ACI 318-14
Units: English
Run axis: Biaxial
Run option: Investigation
Slenderness: Considered
Column type: Structural
Bars: ASTM A615
Date: 11/21/17
Time: 13:16:40

P = 115 kip

File: C:\Program Files (x86)\StructurePoint\spColumn\Examples\Examples-Manual\Example02.col
Project: spColumn Manual Example 2
Column: Wang 15.18.5
Engineer: SP
f_c = 4.5 ksi
f_y = 50 ksi
f_c = 3.825 ksi
f_c = 0.003 in/in
Beta1 = 0.825
Confinement: Tied
phi(a) = 0.8, phi(b) = 0.9, phi(c) = 0.65

f_c = 3824 ksi
E_c = 29000 ksi
e_u = 0.00172414 in/in

Ag = 280 in^2
A_s = 9.36 in^2
X_o = 0.00 in
Y_o = 0.00 in

rho = 3.34%
rho = 3.34%
l_x = 4573.33 in^4
l_y = 9333.33 in^4

Min clear spacing = 3.39 in
Clear cover = 1.50 in
k_x(nonsway) = 1
k_y(nonsway) = 1
k_x(sway) = N/A
k_y(sway) = N/A
1. General Information

<table>
<thead>
<tr>
<th>File Name</th>
<th>C:\Program Files (x86)\Structure...\Example02.col</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project</td>
<td>spColumn Manual Example 2</td>
</tr>
<tr>
<td>Column</td>
<td>Wang 15.18.5</td>
</tr>
<tr>
<td>Engineer</td>
<td>SP</td>
</tr>
<tr>
<td>Code</td>
<td>ACI 318-14</td>
</tr>
<tr>
<td>Bar Set</td>
<td>ASTM A615</td>
</tr>
<tr>
<td>Units</td>
<td>English</td>
</tr>
<tr>
<td>Run Option</td>
<td>Investigation</td>
</tr>
<tr>
<td>Run Axis</td>
<td>Biaxial</td>
</tr>
<tr>
<td>Slenderness</td>
<td>Considered</td>
</tr>
<tr>
<td>Column Type</td>
<td>Structural</td>
</tr>
</tbody>
</table>

2. Material Properties

2.1. Concrete

<table>
<thead>
<tr>
<th>Type</th>
<th>Standard</th>
</tr>
</thead>
<tbody>
<tr>
<td>$f_c$</td>
<td>4.5 ksi</td>
</tr>
<tr>
<td>$E_c$</td>
<td>3823.68 ksi</td>
</tr>
<tr>
<td>$I_c$</td>
<td>3.825 ksi</td>
</tr>
<tr>
<td>$k_c$</td>
<td>0.003 in/in</td>
</tr>
<tr>
<td>$D_c$</td>
<td>0.825</td>
</tr>
</tbody>
</table>

2.2. Steel

<table>
<thead>
<tr>
<th>Type</th>
<th>Standard</th>
</tr>
</thead>
<tbody>
<tr>
<td>$f_y$</td>
<td>50 ksi</td>
</tr>
<tr>
<td>$E_s$</td>
<td>29000 ksi</td>
</tr>
<tr>
<td>$k_s$</td>
<td>0.00172414 in/in</td>
</tr>
</tbody>
</table>

3. Section

3.1. Shape and Properties

<table>
<thead>
<tr>
<th>Type</th>
<th>Rectangular</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>20 in</td>
</tr>
<tr>
<td>Depth</td>
<td>14 in</td>
</tr>
<tr>
<td>$A_t$</td>
<td>280 in$^2$</td>
</tr>
<tr>
<td>$I_t$</td>
<td>4573.33 in$^4$</td>
</tr>
<tr>
<td>$I_y$</td>
<td>9333.33 in$^4$</td>
</tr>
<tr>
<td>$r_t$</td>
<td>4.04145 in</td>
</tr>
<tr>
<td>$r_y$</td>
<td>5.7735 in</td>
</tr>
<tr>
<td>$X_t$</td>
<td>0 in</td>
</tr>
<tr>
<td>$Y_t$</td>
<td>0 in</td>
</tr>
</tbody>
</table>
3.2. Section Figure

Rectangular 20 x 14 in

3.34% reinf.

Figure 1: Column section

4. Reinforcement

4.1. Bar Set: ASTM A615

<table>
<thead>
<tr>
<th>Bar</th>
<th>Diameter</th>
<th>Area</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>in</td>
<td>in²</td>
</tr>
<tr>
<td>#3</td>
<td>0.38</td>
<td>0.11</td>
</tr>
<tr>
<td>#6</td>
<td>0.75</td>
<td>0.44</td>
</tr>
<tr>
<td>#9</td>
<td>1.13</td>
<td>1.00</td>
</tr>
<tr>
<td>#14</td>
<td>1.69</td>
<td>2.25</td>
</tr>
<tr>
<td>#4</td>
<td>0.50</td>
<td>0.20</td>
</tr>
<tr>
<td>#7</td>
<td>0.88</td>
<td>0.60</td>
</tr>
<tr>
<td>#10</td>
<td>1.27</td>
<td>1.27</td>
</tr>
<tr>
<td>#18</td>
<td>2.26</td>
<td>4.00</td>
</tr>
</tbody>
</table>

4.2. Confinement and Factors

Confinement type
- Tied
- For #11 bars or less: #3 ties
- For larger bars: #4 ties

Capacity Reduction Factors
- Axial compression, (a): 0.8
- Tension controlled failure, (b): 0.9
- Compression controlled failure, (c): 0.65

4.3. Arrangement

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Sides different</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bar layout</td>
<td>---</td>
</tr>
<tr>
<td>Cover to</td>
<td>Longitudinal bars</td>
</tr>
<tr>
<td>Clear cover</td>
<td>---</td>
</tr>
<tr>
<td>Bars</td>
<td>---</td>
</tr>
</tbody>
</table>

Total steel area, $A_s$: 9.38 in²
4.4. Bars Provided

<table>
<thead>
<tr>
<th></th>
<th>Bars</th>
<th>Cover</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top</td>
<td>2</td>
<td>#11</td>
</tr>
<tr>
<td>Bottom</td>
<td>2</td>
<td>#11</td>
</tr>
<tr>
<td>Left</td>
<td>1</td>
<td>#11</td>
</tr>
<tr>
<td>Right</td>
<td>1</td>
<td>#11</td>
</tr>
</tbody>
</table>

5. Loading

5.1. Load Combinations

<table>
<thead>
<tr>
<th>Combination</th>
<th>Dead</th>
<th>Live</th>
<th>Wind</th>
<th>EQ</th>
<th>Snow</th>
</tr>
</thead>
<tbody>
<tr>
<td>U1</td>
<td>1.200</td>
<td>1.600</td>
<td>0.000</td>
<td>0.000</td>
<td>0.500</td>
</tr>
</tbody>
</table>

5.2. Service Loads

<table>
<thead>
<tr>
<th>No</th>
<th>Load case</th>
<th>Axial load</th>
<th>Mx @ Top</th>
<th>Mx @ Bottom</th>
<th>My @ Top</th>
<th>My @ Bottom</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Dead</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>1</td>
<td>Live</td>
<td>71.88</td>
<td>0.00</td>
<td>0.00</td>
<td>174.38</td>
<td>-174.38</td>
</tr>
<tr>
<td>1</td>
<td>Wind</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>1</td>
<td>EQ</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>1</td>
<td>Snow</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

5.3. Sustained Load Factors

<table>
<thead>
<tr>
<th>Load case</th>
<th>Factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dead</td>
<td>100</td>
</tr>
<tr>
<td>Live</td>
<td>0</td>
</tr>
<tr>
<td>Wind</td>
<td>0</td>
</tr>
<tr>
<td>EQ</td>
<td>0</td>
</tr>
<tr>
<td>Snow</td>
<td>0</td>
</tr>
</tbody>
</table>

6. Slenderness

6.1. Sway Criteria

X-Axis: Non-sway column

Y-Axis: Non-sway column

6.2. Columns

<table>
<thead>
<tr>
<th>Column</th>
<th>Axis</th>
<th>Height</th>
<th>Width</th>
<th>Depth</th>
<th>I</th>
<th>F_s</th>
<th>E_s</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design</td>
<td>X</td>
<td>22.5</td>
<td>20</td>
<td>14</td>
<td>4573.33</td>
<td>4.5</td>
<td>3823.88</td>
</tr>
<tr>
<td>Design</td>
<td>Y</td>
<td>22.5</td>
<td>20</td>
<td>14</td>
<td>9333.33</td>
<td>4.5</td>
<td>3823.88</td>
</tr>
<tr>
<td>Above</td>
<td>X</td>
<td>(no column specified...)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Above</td>
<td>Y</td>
<td>(no column specified...)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Below</td>
<td>X</td>
<td>(no column specified...)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Below</td>
<td>Y</td>
<td>(no column specified...)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

6.3. X - Beams

<table>
<thead>
<tr>
<th>Beam</th>
<th>Length</th>
<th>Width</th>
<th>Depth</th>
<th>I</th>
<th>F_s</th>
<th>E_s</th>
</tr>
</thead>
<tbody>
<tr>
<td>Above Left</td>
<td>(no beam specified...)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### 6.4. Y - Beams

<table>
<thead>
<tr>
<th>Beam</th>
<th>Length</th>
<th>Width</th>
<th>Depth</th>
<th>I</th>
<th>$f_c$</th>
<th>$E_c$</th>
</tr>
</thead>
<tbody>
<tr>
<td>Above Right</td>
<td>(no beam specified...)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Below Left</td>
<td>(no beam specified...)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Below Right</td>
<td>(no beam specified...)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### 7. Moment Magnification

#### 7.1. General Parameters

<table>
<thead>
<tr>
<th>Factors</th>
<th>Code defaults</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stiffness reduction factor, $\phi_s$</td>
<td>0.75</td>
</tr>
<tr>
<td>Cracked section coefficients, $c_l$(beams)</td>
<td>0.35</td>
</tr>
<tr>
<td>Cracked section coefficients, $c_l$(columns)</td>
<td>0.7</td>
</tr>
</tbody>
</table>

- $0.2 E_I y = E_{Iw}$ (X-axis) \[= 7.66 \times 10^6 \text{ kip-in}^2\] (non-load cases)
- $0.2 E_I y = E_{Iw}$ (Y-axis) \[= 2.36 \times 10^7 \text{ kip-in}^2\] (non-load cases)
- Minimum eccentricity, $E_{min}$ | 1.02 in
- Minimum eccentricity, $E_{max}$ | 1.20 in

#### 7.2. Effective Length Factors

<table>
<thead>
<tr>
<th>Axis</th>
<th>$\Psi_{loop}$</th>
<th>$\Psi_{factor}$</th>
<th>k (Nonsway)</th>
<th>k (Sway)</th>
<th>$k l/r$</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>0.000</td>
<td>0.000</td>
<td>1.000</td>
<td>(N/A)</td>
<td>66.81</td>
</tr>
<tr>
<td>Y</td>
<td>0.000</td>
<td>0.000</td>
<td>1.000</td>
<td>(N/A)</td>
<td>46.77</td>
</tr>
</tbody>
</table>

#### 7.3. Magnification Factors: X - axis

<table>
<thead>
<tr>
<th>Load Combo</th>
<th>$\sum P_e$</th>
<th>$P_e$</th>
<th>$P_e$</th>
<th>$\delta_m$</th>
<th>$\delta_1$</th>
<th>$P_e$</th>
<th>$k l/r$</th>
<th>$P_e$</th>
<th>$\beta_m$</th>
<th>$C_m$</th>
<th>$\delta$</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 U1</td>
<td>(N/A)</td>
<td>(N/A)</td>
<td>(N/A)</td>
<td>(N/A)</td>
<td>(N/A)</td>
<td>(N/A)</td>
<td>115.00</td>
<td>(N/A)</td>
<td>1036.79</td>
<td>0.000</td>
<td>1.000</td>
</tr>
</tbody>
</table>

#### 7.4. Magnification Factors: Y - axis

<table>
<thead>
<tr>
<th>Load Combo</th>
<th>$\sum P_e$</th>
<th>$P_e$</th>
<th>$P_e$</th>
<th>$\delta_m$</th>
<th>$\delta_1$</th>
<th>$P_e$</th>
<th>$k l/r$</th>
<th>$P_e$</th>
<th>$\beta_m$</th>
<th>$C_m$</th>
<th>$\delta$</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 U1</td>
<td>(N/A)</td>
<td>(N/A)</td>
<td>(N/A)</td>
<td>(N/A)</td>
<td>(N/A)</td>
<td>(N/A)</td>
<td>115.00</td>
<td>(N/A)</td>
<td>3199.27</td>
<td>0.000</td>
<td>1.000</td>
</tr>
</tbody>
</table>

#### 8. Factored Moments

**NOTE:** Each loading combination includes the following cases:
- Top - At column top
- Bot - At column bottom

#### 8.1. X - axis

<table>
<thead>
<tr>
<th>Load Combo</th>
<th>$M_{max}$</th>
<th>$M_a$</th>
<th>$M_b$</th>
<th>$M_{max}$</th>
<th>$M_a$</th>
<th>$M_b$</th>
<th>$2^{nd}$ Order</th>
<th>Ratio $2^{nd}$/1$^{st}$</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 U1 Top</td>
<td>0.00</td>
<td>(N/A)</td>
<td>0.00</td>
<td>9.78</td>
<td>(N/A)</td>
<td>11.47</td>
<td></td>
<td>1.174</td>
</tr>
<tr>
<td>1 U1 Bot</td>
<td>0.00</td>
<td>(N/A)</td>
<td>0.00</td>
<td>9.78</td>
<td>(N/A)</td>
<td>11.47</td>
<td></td>
<td>1.174</td>
</tr>
</tbody>
</table>

---

**EXAMPLES**
8.2. Y - axis

<table>
<thead>
<tr>
<th>Load Combo</th>
<th>1st Order M&lt;sub&gt;x&lt;/sub&gt;</th>
<th>2nd Order M&lt;sub&gt;x&lt;/sub&gt;</th>
<th>Ratio 2&lt;sup&gt;nd&lt;/sup&gt;/1&lt;sup&gt;st&lt;/sup&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
</tr>
<tr>
<td>1 U1 Top</td>
<td>279.00</td>
<td>(N/A)</td>
<td>279.00</td>
</tr>
<tr>
<td>1 U1 Bot</td>
<td>279.00</td>
<td>(N/A)</td>
<td>279.00</td>
</tr>
</tbody>
</table>

9. Factored Loads and Moments with Corresponding Capacities

NOTE: Each loading combination includes the following cases:
Top - At column top
Bot - At column bottom

<table>
<thead>
<tr>
<th>No.</th>
<th>Load Combo</th>
<th>P&lt;sub&gt;x&lt;/sub&gt;</th>
<th>M&lt;sub&gt;x&lt;/sub&gt;</th>
<th>M&lt;sub&gt;xy&lt;/sub&gt;</th>
<th>Φ M&lt;sub&gt;x&lt;/sub&gt;</th>
<th>Φ M&lt;sub&gt;xy&lt;/sub&gt;</th>
<th>Φ M&lt;sub&gt;x&lt;/sub&gt;/M&lt;sub&gt;y&lt;/sub&gt;</th>
<th>NA Depth</th>
<th>d&lt;sub&gt;y&lt;/sub&gt; Depth</th>
<th>ε</th>
<th>Φ</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1 U1 Top</td>
<td>115.00</td>
<td>11.47</td>
<td>293.04</td>
<td>13.83</td>
<td>353.32</td>
<td>1.206</td>
<td>5.19</td>
<td>18.77</td>
<td>0.00810</td>
<td>0.900</td>
</tr>
<tr>
<td>2</td>
<td>1 U1 Bot</td>
<td>115.00</td>
<td>11.47</td>
<td>293.04</td>
<td>13.83</td>
<td>353.32</td>
<td>1.206</td>
<td>5.19</td>
<td>18.77</td>
<td>0.00810</td>
<td>0.900</td>
</tr>
</tbody>
</table>
### 5.3 Example 3 - Design of a Slender Column - Sway Frame

#### 5.3.1 Problem Formulation

Design a square column with a clear height of 16 ft. The column is sway and subjected to dead, live and wind loads as shown below.

<table>
<thead>
<tr>
<th></th>
<th>Dead</th>
<th>Live</th>
<th>Wind</th>
</tr>
</thead>
<tbody>
<tr>
<td>$P$ (kip)</td>
<td>380</td>
<td>140</td>
<td>0</td>
</tr>
<tr>
<td>Top $M_x$ (kip-ft)</td>
<td>32</td>
<td>20</td>
<td>50</td>
</tr>
<tr>
<td>Bottom $M_y$ (kip-ft)</td>
<td>54</td>
<td>36</td>
<td>50</td>
</tr>
</tbody>
</table>

The column is to be checked for the following load combinations:

\[
U_1 = 1.2 \ D + 1.6 \ L \\
U_2 = 1.2 \ D + 0.5 \ L + 1.6 \ W
\]

The calculations in the reference are done based on the load combination $U_2$.

In practice, the ratio $\Sigma P_c / P_c$ would have to be calculated before the problem can be attempted, using a trial value of $\Sigma P_c / P_c$. Here, the value of $\Sigma P_c / P_c$ used is 28.67 based on the reference value of $P_c$. There are 14 interior columns, 18 exterior columns and 4 corner columns. Therefore, the value of $\Sigma P_u / P_u = 14 + 18 * 2 / 3 + 4 * 1 / 3 = 27.33$ irrespective of the load combination being used.

#### 5.3.2 Preparing Input

- From the **File** menu, choose **New**. Any input data is cleared and the default values are restored.
- From the **Input** menu, choose **General Information**
  - Input the PROJECT header.

---

- Select English units and ACI 318-14 code.
- Select About X-Axis for run axis, Design for run option and Yes for Consider slenderness?
- Choose OK.

5.3.3 Assigning Properties

- From the Input menu, pick Material Properties.
  - Input 5 for the concrete strength. Other properties are computed and will be accepted.
  - Choose OK.

- From the Input menu, pick Section | Rectangular.
  - Input 18 and 18 for the WIDTH (ALONG X) and DEPTH (ALONG Y) under both START and END options.
  - Choose OK.

- From the Input menu, choose Reinforcement | All Sides Equal
  - Input 4-#10 bars for Minimum, and 40-#10 bars for Maximum and 1.5 in for the cover, and select TRANSVERSE BARS and RECTANGULAR Bar Layout.
  - Choose OK.
• From the **Input** menu, choose **Slenderness | Design Column**.
  - Input 16 for the column **CLEAR HEIGHT**.
  - Check **SWAY FRAME**
  - Under **SWAY CRITERIA**, input **28.67** and **27.33** for the $\Sigma P_c/p_c$ and $\Sigma P_u/p_u$, respectively.
  - Leave **2ND ORDER EFFECT ALONG LENGTH** option checked (default)
  - Select **COMPUTE ‘K’ FACTORS**.
  - Choose **OK**.
From the **Input** menu, choose **Slenderness | Columns Above/Below**.

- Clear the **NO COLUMN SPECIFIED** option.
- Input **11** for the column height (center-to-center) under **HEIGHT (C/C)** and leave the other data as is.
- Choose **Copy to Column Below**.
- Choose **OK**.

From the **Input** menu, choose **Slenderness | X-Beams**.

- Choose **ABOVE LEFT**.
- Clear the **NO BEAM SPECIFIED** option.
- Input **20** for the span (center-to-center) under **SPAN(C/C)**.
- Input **0.00** and **0.00** for the **WIDTH** and **DEPTH**, respectively.
- Input **21436.6** for the moment of inertia under **INERTIA**.
- Leave the other data as it is.
- Choose **ABOVE RIGHT** and click on **COPY FROM BEAM LEFT**.
- Choose **BELOW LEFT** and click on **COPY FROM BEAM ABOVE**.
- Choose **BELOW RIGHT** and click on **COPY FROM BEAM ABOVE**.
- Choose **OK**.

From the **Input** menu, choose **Loads | Service**.

- Under **DEAD**, input **380**, **32** and **-54** for the **AXIAL LOAD**, **X-MOMENTS @ TOP** and **X-MOMENTS @ BOT** respectively.
- Under **LIVE**, input **140**, **20** and **-36** for the **AXIAL LOAD**, **X-MOMENTS @ TOP** and **X-MOMENTS @ BOT**, respectively.
- Under **WIND**, input **0**, **50** and **-50** for the **AXIAL LOAD**, **X-MOMENTS @ TOP** and **X-MOMENTS @ BOT**, respectively.
Under SUSTAINED LOAD keep the default settings of 100% for dead and 0% for all other load cases.

- Choose INSERT to add the entry to the list box.
- Choose OK.
• From the **Input** menu, choose **Loads | Load Combinations**.
  - Select all load combinations by clicking on U1 and dragging to U13. Then choose **DELETE**.
  - Enter 1.2 for Dead, 1.6 for Live, and 0.5 for Snow then choose **INSERT**.
  - Enter 1.2 for Dead, 0.5 for Live, 1.6 for Wind, and 0.5 for Snow then choose **INSERT**.
  - Choose OK.

5.3.4 Solving

• From the **Solve** menu, choose **Execute**.
  - The solver of the program is started and, upon completion, displays the interaction diagram of the section with the load points plotted within the diagram.

5.3.5 Viewing and Printing Results

• From the **View** menu, choose **Results**.
  - Use the explorer in the spResults module or the Previous Table and Next Table buttons in the toolbar to navigate through the tables.
  - Use the close button at the top right corner of the spResults windows to quit the spResults module and get back to spColumn.

• From the **File** menu, choose **Print Report | Default Report**.
  - Select the printer to send the default report to.
  - Choose PRINT.

• From the **File** menu, choose **Print Screen**.
  - Select the printer to send the graphical results to.
  - Choose PRINT.
EXAMPLES

Code: ACI 318-14
Units: English
Run axis: About X-axis
Run option: Design
Slenderness: Considered
Column type: Structural
Bars: ASTM A615
Date: 11/20/17
Time: 14:52:56

File: C:\Program Files (x86)\StructurePoint\spColumn\Examples\Examples-Manual\Example03.col
Project: spColumn Manual Example 3
Column: Hassoun 12.4
Engineer: SP
\( f_c = 5 \text{ ksi} \)
\( f_y = 60 \text{ ksi} \)
\( E_c = 4031 \text{ ksi} \)
\( E_s = 29000 \text{ ksi} \)
\( f_c = 4.25 \text{ ksi} \)
\( e_{yt} = 0.00206897 \text{ in/in} \)
\( e_u = 0.003 \text{ in/in} \)
\( \beta_1 = 0.8 \)
\( \phi(a) = 0.8, \phi(b) = 0.9, \phi(c) = 0.65 \)

\( f_c \) = concrete compressive strength
\( f_y \) = yield strength
\( E_c \) = modulus of elasticity of concrete
\( E_s \) = modulus of elasticity of steel
\( f_c \) = concrete strength
\( e_{yt} \) = tangent modulus of elasticity
\( e_u \) = ultimate strain
\( \beta_1 \) = beta factor
\( \phi(a) \) = factor for axial load
\( \phi(b) \) = factor for bending
\( \phi(c) \) = factor for torsion

Structural Analysis

\( P \) (kip)
\( M_x \) (k-ft)
\( P_{max} \)
\( P_{min} \)

\( f_s = 0 \)
\( f_s = 0.5f_y \)

Axial load - Moment interaction diagram

FS = 0
FS = 0.5fy
FS = 0
FS = 0
FS = 0
FS = 0

X-axis
Y-axis

18 x 18 in

STRUCTUREPOINT - spColumn v6.00 (TM). Licensed to: StructurePoint. License ID: 000000-0000000-4-25EF2-1C3DF
1. General Information

<table>
<thead>
<tr>
<th>File Name</th>
<th>C:\Program Files (x86)\StructurePoint\spColumn v6.00\spColumn\Examples\Examples-Manual\Example03.col</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project</td>
<td>spColumn Manual Example 3</td>
</tr>
<tr>
<td>Column</td>
<td>Hassoun 12.4</td>
</tr>
<tr>
<td>Engineer</td>
<td>SP</td>
</tr>
<tr>
<td>Code</td>
<td>ACI 318-14</td>
</tr>
<tr>
<td>Bar Set</td>
<td>ASTM A615</td>
</tr>
<tr>
<td>Units</td>
<td>English</td>
</tr>
<tr>
<td>Run Option</td>
<td>Design</td>
</tr>
<tr>
<td>Run Axis</td>
<td>X - axis</td>
</tr>
<tr>
<td>Slenderness</td>
<td>Considered</td>
</tr>
<tr>
<td>Column Type</td>
<td>Structural</td>
</tr>
</tbody>
</table>

2. Material Properties

2.1. Concrete

<table>
<thead>
<tr>
<th>Type</th>
<th>Standard</th>
</tr>
</thead>
<tbody>
<tr>
<td>( f_c )</td>
<td>5 ksi</td>
</tr>
<tr>
<td>( E_c )</td>
<td>4030.51 ksi</td>
</tr>
<tr>
<td>( k_c )</td>
<td>4.25 ksi</td>
</tr>
<tr>
<td>( k_r )</td>
<td>0.003 in/in</td>
</tr>
<tr>
<td>( b )</td>
<td>0.8</td>
</tr>
</tbody>
</table>

2.2. Steel

<table>
<thead>
<tr>
<th>Type</th>
<th>Standard</th>
</tr>
</thead>
<tbody>
<tr>
<td>( f_y )</td>
<td>60 ksi</td>
</tr>
<tr>
<td>( E_y )</td>
<td>29000 ksi</td>
</tr>
<tr>
<td>( k_y )</td>
<td>0.00206897 in/in</td>
</tr>
</tbody>
</table>

3. Section

3.1. Shape and Properties

<table>
<thead>
<tr>
<th>Type</th>
<th>Rectangular</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>18 in</td>
</tr>
<tr>
<td>Depth</td>
<td>18 in</td>
</tr>
<tr>
<td>( A_t )</td>
<td>324 in(^2)</td>
</tr>
<tr>
<td>( I_2 )</td>
<td>8748 in(^4)</td>
</tr>
<tr>
<td>( I_1 )</td>
<td>8748 in(^4)</td>
</tr>
<tr>
<td>( r_t )</td>
<td>5.19615 in</td>
</tr>
<tr>
<td>( r_1 )</td>
<td>5.19615 in</td>
</tr>
<tr>
<td>( X_t )</td>
<td>0 in</td>
</tr>
<tr>
<td>( Y_t )</td>
<td>0 in</td>
</tr>
</tbody>
</table>
3.2. Section Figure

![Section Figure](image)

Figure 1: Column section

4. Reinforcement

4.1. Bar Set: ASTM A615

<table>
<thead>
<tr>
<th>Bar</th>
<th>Diameter</th>
<th>Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>#3</td>
<td>0.38 in</td>
<td>0.11 in²</td>
</tr>
<tr>
<td>#6</td>
<td>0.75 in</td>
<td>0.44 in²</td>
</tr>
<tr>
<td>#9</td>
<td>1.13 in</td>
<td>1.00 in²</td>
</tr>
<tr>
<td>#14</td>
<td>1.69 in</td>
<td>2.25 in²</td>
</tr>
<tr>
<td>#4</td>
<td>0.50 in</td>
<td>0.20 in²</td>
</tr>
<tr>
<td>#7</td>
<td>0.88 in</td>
<td>0.60 in²</td>
</tr>
<tr>
<td>#10</td>
<td>1.27 in</td>
<td>1.27 in²</td>
</tr>
<tr>
<td>#18</td>
<td>2.26 in</td>
<td>4.00 in²</td>
</tr>
</tbody>
</table>

4.2. Design Criteria

<table>
<thead>
<tr>
<th>Bar selection</th>
<th>Min. number of bars</th>
</tr>
</thead>
<tbody>
<tr>
<td>$A_{n_{min}} = 0.01 \times A_b$</td>
<td>3.24 in²</td>
</tr>
<tr>
<td>$A_{n_{max}} = 0.09 \times A_b$</td>
<td>25.92 in²</td>
</tr>
<tr>
<td>Design/Required ratio</td>
<td>1.00</td>
</tr>
</tbody>
</table>

4.3. Confinement and Factors

<table>
<thead>
<tr>
<th>Capacity Reduction Factors</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Axial compression, (a)</td>
<td>0.8</td>
</tr>
<tr>
<td>Tension controlled failure, (b)</td>
<td>0.9</td>
</tr>
<tr>
<td>Compression controlled failure, (c)</td>
<td>0.65</td>
</tr>
</tbody>
</table>

4.4. Arrangement

| Pattern | All sides equal |
5. Loading
5.1. Load Combinations

<table>
<thead>
<tr>
<th>Combination</th>
<th>Dead</th>
<th>Live</th>
<th>Wind</th>
<th>EQ</th>
<th>Snow</th>
</tr>
</thead>
<tbody>
<tr>
<td>U1</td>
<td>1.200</td>
<td>1.600</td>
<td>0.000</td>
<td>0.000</td>
<td>0.500</td>
</tr>
<tr>
<td>U2</td>
<td>1.200</td>
<td>0.500</td>
<td>1.600</td>
<td>0.000</td>
<td>0.500</td>
</tr>
</tbody>
</table>

5.2. Service Loads

<table>
<thead>
<tr>
<th>Load case</th>
<th>Axial load kip</th>
<th>Mx @ Top k-ft</th>
<th>Mx @ Bottom k-ft</th>
<th>My @ Top k-ft</th>
<th>My @ Bottom k-ft</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dead</td>
<td>380.00</td>
<td>32.00</td>
<td>-54.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Live</td>
<td>140.00</td>
<td>20.00</td>
<td>-36.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Wind</td>
<td>0.00</td>
<td>0.00</td>
<td>-50.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>EQ</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Snow</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

5.3. Sustained Load Factors

<table>
<thead>
<tr>
<th>Load case</th>
<th>Factor %</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dead</td>
<td>100</td>
</tr>
<tr>
<td>Live</td>
<td>0</td>
</tr>
<tr>
<td>Wind</td>
<td>0</td>
</tr>
<tr>
<td>EQ</td>
<td>0</td>
</tr>
<tr>
<td>Snow</td>
<td>0</td>
</tr>
</tbody>
</table>

6. Slenderness
6.1. Sway Criteria

<table>
<thead>
<tr>
<th>X-Axis</th>
<th>Sway column</th>
</tr>
</thead>
<tbody>
<tr>
<td>2nd order effects along length</td>
<td>Considered</td>
</tr>
<tr>
<td>SP_{x}</td>
<td>28.67 x P_{i}</td>
</tr>
<tr>
<td>SP_{y}</td>
<td>27.33 x P_{i}</td>
</tr>
</tbody>
</table>

6.2. Columns

<table>
<thead>
<tr>
<th>Column</th>
<th>Axis</th>
<th>Height</th>
<th>Width</th>
<th>Depth</th>
<th>I in^4</th>
<th>F_y ksi</th>
<th>E ksi</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design</td>
<td>X</td>
<td>18</td>
<td>18</td>
<td>18</td>
<td>8748</td>
<td>5</td>
<td>4030.51</td>
</tr>
<tr>
<td>Above</td>
<td>X</td>
<td>11</td>
<td>18</td>
<td>18</td>
<td>8748</td>
<td>5</td>
<td>4030.51</td>
</tr>
<tr>
<td>Below</td>
<td>X</td>
<td>11</td>
<td>18</td>
<td>18</td>
<td>8748</td>
<td>5</td>
<td>4030.51</td>
</tr>
</tbody>
</table>

6.3. X - Beams

<table>
<thead>
<tr>
<th>Beam</th>
<th>Length ft</th>
<th>Width</th>
<th>Depth</th>
<th>I in^4</th>
<th>F_y ksi</th>
<th>E ksi</th>
</tr>
</thead>
<tbody>
<tr>
<td>Above Left</td>
<td>20</td>
<td>0</td>
<td>0</td>
<td>21436.6</td>
<td>5</td>
<td>4030.51</td>
</tr>
<tr>
<td>Above Right</td>
<td>20</td>
<td>0.0001</td>
<td>0.0001</td>
<td>21436.6</td>
<td>5</td>
<td>4030.51</td>
</tr>
<tr>
<td>Below Left</td>
<td>20</td>
<td>0.0001</td>
<td>0.0001</td>
<td>21436.6</td>
<td>5</td>
<td>4030.51</td>
</tr>
<tr>
<td>Below Right</td>
<td>20</td>
<td>0.0001</td>
<td>0.0001</td>
<td>21436.6</td>
<td>5</td>
<td>4030.51</td>
</tr>
</tbody>
</table>
7. Moment Magnification

7.1. General Parameters

<table>
<thead>
<tr>
<th>Factors</th>
<th>Code defaults</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stiffness reduction factor, $\Phi_n$</td>
<td>0.75</td>
</tr>
<tr>
<td>Cracked section coefficients, cl(beams)</td>
<td>0.35</td>
</tr>
<tr>
<td>Cracked section coefficients, cl(columns)</td>
<td>0.7</td>
</tr>
</tbody>
</table>

\[0.2 E I_y = E I_w \text{ (X-axis)} \]

Minimum eccentricity, $E_{y,min}$: 2.02e+007 kip-in²

7.2. Effective Length Factors

<table>
<thead>
<tr>
<th>Axis</th>
<th>$\psi_{top}$</th>
<th>$\psi_{bottom}$</th>
<th>k (Nonsway)</th>
<th>k (Sway)</th>
<th>kl/r</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>1.252</td>
<td>1.252</td>
<td>0.802</td>
<td>1.390</td>
<td>51.38</td>
</tr>
</tbody>
</table>

7.3. Magnification Factors: X-axis

8. Factored Moments

8.1. X-axis

8.2. Magnification Factors: X-axis

9. Factored Loads and Moments with Corresponding Capacities

Design/Required ratio $\Phi M/L > 1.00$

NOTE: Each loading combination includes the following cases:

- Top - At column top
- Bot - At column bottom

<table>
<thead>
<tr>
<th>No. Load</th>
<th>Load Combo</th>
<th>$P_o$ kip</th>
<th>$M_o$ k-f</th>
<th>$\Phi M_o$ k-f</th>
<th>$\Phi M_o / M_o$</th>
<th>NA Depth in</th>
<th>$d_o$ Depth in</th>
<th>$\varepsilon_i$</th>
<th>$\Phi$</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>U1 Top</td>
<td>680.00</td>
<td>71.32</td>
<td>311.55</td>
<td>4.368</td>
<td>12.43</td>
<td>15.49</td>
<td>0.00074</td>
<td>0.650</td>
</tr>
<tr>
<td>2</td>
<td>U1 Bot</td>
<td>680.00</td>
<td>124.00</td>
<td>311.55</td>
<td>2.512</td>
<td>12.43</td>
<td>15.49</td>
<td>0.00074</td>
<td>0.650</td>
</tr>
<tr>
<td>3</td>
<td>U2 Top</td>
<td>526.00</td>
<td>168.69</td>
<td>344.47</td>
<td>2.042</td>
<td>10.76</td>
<td>15.49</td>
<td>0.00132</td>
<td>0.650</td>
</tr>
<tr>
<td>4</td>
<td>U2 Bot</td>
<td>526.00</td>
<td>206.47</td>
<td>344.47</td>
<td>1.688</td>
<td>10.76</td>
<td>15.49</td>
<td>0.00132</td>
<td>0.650</td>
</tr>
</tbody>
</table>
5.4 Example 4 - Investigation of Concrete Shear Wall Capacity

5.4.1 Problem Formulation

Investigate the axial load and moment capacity of a shear wall\textsuperscript{79} for a given location of the neutral axis. Use 4-ksi concrete and 60-ksi reinforcing steel.

spColumn provides a comprehensive model editor for irregular shapes. For this example, however, a specific tool provided with spColumn will be used for frequently needed shapes.

- From the Start Menu, go to All Programs | StructurePoint | spColumn and run Design Assistant\textsuperscript{80}.
- Design Assistant uses macros to export data to text files. If a macro warning is displayed when opening Design Assistant, make sure macros are enabled in order for the exporting function to work properly.


\textsuperscript{80} Design Assistant is a Microsoft Excel spreadsheet that can be used to facilitate creation of spColumn text import files for a variety of sections including dumbbell shaped and C-shaped shear walls.
- Choose **Example 4** Tab in the spreadsheet.
- **Input** the data shown below:
  - Under **OVERALL SECTION WIDTH IN X**, input 15.
  - Under **OVERALL SECTION HEIGHT IN Y**, input 144.
  - Under **WEB WIDTH**, input 12.
  - Under **WEB HEIGHT**, input 114.
  - Under **NUMBER OF BOUNDARY BARS IN X**, input 3.
  - Under **NUMBER OF BOUNDARY BARS IN Y**, input 3.
  - Under **WEB BAR SPACING**, input 18.
  - Under **COVER**, input 2.5.
  - Under **REINFORCEMENT AREA PER BOUNDARY BAR**, input 0.79.
  - Under **REINFORCEMENT AREA PER WEB BAR**, input 0.31.
• Press **Export Geometry** Button and **Save Geometry File** box appears. Save the file as **Example4-Geo.txt**

![Image of Save Geometry File dialog box]

• Press **Export Reinforcement** button and **Save Reinforcement File** dialog box appears. Save the file as **Example4-Reinf.txt**

![Image of Save Reinforcement File dialog box]

• Save and close the Design Assistant spreadsheet.
• From the **Start Menu**, go to **All Programs | StructurePoint | spColumn** and run **spColumn**

• From the **File** menu, choose **New**. Any input data is cleared and the default values are restored.

• From the **File** menu, choose **Import | Import Data**. Import Data (from text file) dialog box appears. Make sure that **Geometry** radio button is checked, choose **OK**

![Import Data (from text file) dialog box](image1)

• **Open Import File** box appears. Select **Example4-Geo.txt** file and choose **Open**. The shear wall geometry appears on the spColumn screen.

![Open Import file dialog box](image2)

• From the **File** menu, choose **Import | Import Data**. Import Data (from text file) box appears. Press **Reinforcement** radio button, then Choose **OK**

![Import Data (from text file) box](image3)
- **Open Import File** box appears. Select *Example4-Reinf.txt* file and choose **Open**. The shear wall reinforcement appears on the spColumn screen as well.

- From the **Input** menu, choose **General Information** Tab. Input Project Information and leave all other options in their default settings of ACI 318-14 design code. Choose **OK**
5.4.2 Assigning Properties

- From the Input menu, choose the **Material Properties** tab. **VERIFY CONCRETE STRENGTH**, $f_{c'}$, and **REINFORCING STEEL STRENGTH**, $f_y$, values are entered as 4 ksi, and 60 ksi respectively. Leave all other options in their default settings. Choose OK

- From the **Input** menu, choose **Reinforcement | Confinement** Tab.
  - From the **CONFINEMENT** drop-down menu choose **OTHER**.
  - Input **AXIAL COMPRESSION** (a) as **0.85**.
  - Input **COMPRESSION CONTROLLED FAILURE** (c) as **0.7**.
  - Leave all other options in their default settings. Choose OK
• From the Input menu, choose **Loads | Axial Loads Tab**
  - Input 649.5 for the INITIAL LOAD. The initial axial load was selected through trial and error procedure in order to match neutral axis depth of 24 in. given in the example.
  - Choose INSERT. Then, choose OK

5.4.3 Solving

• From the Solve menu, choose **Execute**.
  - Click NO when the warning message is displayed saying “Reinforcement ratio is less than 1%. Consider column as architectural (i.e. fc is reduced by reinforcement ratio?)”.
  - The solver of the program is started and, upon completion, displays the interaction diagram of the section.

5.4.4 Viewing and Printing Results

• From the View menu, choose **Results**.
  - Use the explorer in the spResults module or the Previous Table and Next Table buttons in the toolbar to navigate through the tables.
  - Use the close button at the top right corner of the spResults windows to quit the spResults module and get back to spColumn.

• From the File menu, choose **Print Report | Default Report**.
  - Select the printer to send the default report to.
  - Choose PRINT.
Code: ACI 318-14
Units: English
Run axis: About X-axis
Run option: Investigation
Slenderness: Not considered
Column type: Structural
Bars: ASTM A615
Date: 11/20/17
Time: 14:53:52

File: C:\Program Files (x86)\StructurePoint\spColumn\Examples\Examples-Manual\Example04.col
Project: spColumn Manual Example 4
Columnn: Alan Ex 4.4  Engineer: SP
f_c = 4 ksi  f_y = 60 ksi  A_g = 1818 in^2  32 bars
E_c = 3605 ksi  E_s = 29000 ksi  A_s = 17.60 in^2  rho = 0.97%
f_c = 3.4 ksi  e_yt = 0.00206897 in/in  X_o = -0.00 in  I_x = 3.36209e+006 in^4
e_u = 0.003 in/in  Y_o = 0.00 in  I_y = 24853.5 in^4
Beta1 = 0.85  Min clear spacing = 1.31 in  Clear cover = N/A
Confinement: Other
phi(a) = 0.85, phi(b) = 0.9, phi(c) = 0.7
1. General Information

<table>
<thead>
<tr>
<th>File Name</th>
<th>C:\Program Files (x86)\Structure\Examples\Example04.col</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project</td>
<td>spColumn Manual Example 4</td>
</tr>
<tr>
<td>Column</td>
<td>Alan Ex 4.4</td>
</tr>
<tr>
<td>Engineer</td>
<td>SP</td>
</tr>
<tr>
<td>Code</td>
<td>ACI 318-14</td>
</tr>
<tr>
<td>Bar Set</td>
<td>ASTM A615</td>
</tr>
<tr>
<td>Units</td>
<td>English</td>
</tr>
<tr>
<td>Run Option</td>
<td>Investigation</td>
</tr>
<tr>
<td>Run Axis</td>
<td>X - axis</td>
</tr>
<tr>
<td>Slenderness</td>
<td>Not Considered</td>
</tr>
<tr>
<td>Column Type</td>
<td>Structural</td>
</tr>
</tbody>
</table>

2. Material Properties

2.1. Concrete

<table>
<thead>
<tr>
<th>Type</th>
<th>Standard</th>
</tr>
</thead>
<tbody>
<tr>
<td>$f_c$</td>
<td>4 ksi</td>
</tr>
<tr>
<td>$E_c$</td>
<td>3605 ksi</td>
</tr>
<tr>
<td>$f_y$</td>
<td>3.4 ksi</td>
</tr>
<tr>
<td>$\nu$</td>
<td>0.003 in/in</td>
</tr>
<tr>
<td>$\beta$</td>
<td>0.65</td>
</tr>
</tbody>
</table>

2.2. Steel

<table>
<thead>
<tr>
<th>Type</th>
<th>Standard</th>
</tr>
</thead>
<tbody>
<tr>
<td>$f_y$</td>
<td>60 ksi</td>
</tr>
<tr>
<td>$E_y$</td>
<td>29000 ksi</td>
</tr>
<tr>
<td>$\nu$</td>
<td>0.00206897 in/in</td>
</tr>
</tbody>
</table>

3. Section

3.1. Shape and Properties

<table>
<thead>
<tr>
<th>Type</th>
<th>Irregular</th>
</tr>
</thead>
<tbody>
<tr>
<td>$A_t$</td>
<td>1818 in²</td>
</tr>
<tr>
<td>$I_y$</td>
<td>3.36209e+008 in⁴</td>
</tr>
<tr>
<td>$I_z$</td>
<td>24853.5 in⁴</td>
</tr>
<tr>
<td>$y_t$</td>
<td>43.0039 in</td>
</tr>
<tr>
<td>$x_t$</td>
<td>3.6974 in</td>
</tr>
<tr>
<td>$X_t$</td>
<td>0 in</td>
</tr>
<tr>
<td>$Y_t$</td>
<td>0 in</td>
</tr>
</tbody>
</table>
3.2. Section Figure

![Section Figure]

Figure 1: Column section

3.3. Exterior Points

<table>
<thead>
<tr>
<th>Points</th>
<th>X</th>
<th>Y</th>
<th>Points</th>
<th>X</th>
<th>Y</th>
<th>Points</th>
<th>X</th>
<th>Y</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>-7.5</td>
<td>72.0</td>
<td>2</td>
<td>7.5</td>
<td>72.0</td>
<td>3</td>
<td>7.5</td>
<td>57.0</td>
</tr>
<tr>
<td>4</td>
<td>6.0</td>
<td>57.0</td>
<td>5</td>
<td>6.0</td>
<td>-57.0</td>
<td>6</td>
<td>7.5</td>
<td>-57.0</td>
</tr>
<tr>
<td>7</td>
<td>7.5</td>
<td>-72.0</td>
<td>8</td>
<td>-7.5</td>
<td>-72.0</td>
<td>9</td>
<td>-7.5</td>
<td>-57.0</td>
</tr>
<tr>
<td>10</td>
<td>-6.0</td>
<td>-57.0</td>
<td>11</td>
<td>-6.0</td>
<td>57.0</td>
<td>12</td>
<td>-7.5</td>
<td>57.0</td>
</tr>
</tbody>
</table>

4. Reinforcement

4.1. Bar Set: ASTM A615

<table>
<thead>
<tr>
<th>Bar</th>
<th>Diameter</th>
<th>Area</th>
<th>Bar</th>
<th>Diameter</th>
<th>Area</th>
<th>Bar</th>
<th>Diameter</th>
<th>Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>#3</td>
<td>0.38</td>
<td>0.11</td>
<td>#4</td>
<td>0.50</td>
<td>0.20</td>
<td>#5</td>
<td>0.63</td>
<td>0.31</td>
</tr>
<tr>
<td>#6</td>
<td>0.75</td>
<td>0.44</td>
<td>#7</td>
<td>0.88</td>
<td>0.60</td>
<td>#8</td>
<td>1.00</td>
<td>0.79</td>
</tr>
<tr>
<td>#9</td>
<td>1.13</td>
<td>1.00</td>
<td>#10</td>
<td>1.27</td>
<td>1.27</td>
<td>#11</td>
<td>1.41</td>
<td>1.56</td>
</tr>
<tr>
<td>#14</td>
<td>1.69</td>
<td>2.25</td>
<td>#18</td>
<td>2.28</td>
<td>4.00</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

4.2. Confinement and Factors

<table>
<thead>
<tr>
<th>Type</th>
<th>Factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confinement type</td>
<td>Other</td>
</tr>
<tr>
<td>For #10 bars or less</td>
<td>#3 ties</td>
</tr>
<tr>
<td>For larger bars</td>
<td>#4 ties</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Capacity Reduction Factors</th>
<th>Factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Axial compression, (a)</td>
<td>0.85</td>
</tr>
<tr>
<td>Tension controlled failure, (b)</td>
<td>0.9</td>
</tr>
<tr>
<td>Compression controlled failure, (c)</td>
<td>0.7</td>
</tr>
</tbody>
</table>
4.3. Arrangement

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Irregular</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bar layout</td>
<td>---</td>
</tr>
<tr>
<td>Cover to</td>
<td>---</td>
</tr>
<tr>
<td>Clear cover</td>
<td>---</td>
</tr>
<tr>
<td>Bars</td>
<td>---</td>
</tr>
</tbody>
</table>

Total steel area, $A_s$: 17.60 in$^2$
Minimum clear spacing: 1.31 in

4.4. Bars Provided

<table>
<thead>
<tr>
<th>Area (in$^2$)</th>
<th>$X$ (in)</th>
<th>$Y$ (in)</th>
<th>Area (in$^2$)</th>
<th>$X$ (in)</th>
<th>$Y$ (in)</th>
<th>Area (in$^2$)</th>
<th>$X$ (in)</th>
<th>$Y$ (in)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.79</td>
<td>5.0</td>
<td>69.5</td>
<td>0.79</td>
<td>5.0</td>
<td>59.5</td>
<td>0.79</td>
<td>0.0</td>
<td>69.5</td>
</tr>
<tr>
<td>0.79</td>
<td>0.0</td>
<td>59.5</td>
<td>0.79</td>
<td>-5.0</td>
<td>69.5</td>
<td>0.79</td>
<td>-5.0</td>
<td>59.5</td>
</tr>
<tr>
<td>0.79</td>
<td>-5.0</td>
<td>-69.5</td>
<td>0.79</td>
<td>-5.0</td>
<td>-69.5</td>
<td>0.79</td>
<td>0.0</td>
<td>-69.5</td>
</tr>
<tr>
<td>0.79</td>
<td>-5.0</td>
<td>-64.5</td>
<td>0.31</td>
<td>3.5</td>
<td>63.0</td>
<td>0.31</td>
<td>3.5</td>
<td>45.0</td>
</tr>
<tr>
<td>0.31</td>
<td>3.5</td>
<td>27.0</td>
<td>0.31</td>
<td>3.5</td>
<td>9.0</td>
<td>0.31</td>
<td>3.5</td>
<td>-9.0</td>
</tr>
<tr>
<td>0.31</td>
<td>3.5</td>
<td>-27.0</td>
<td>0.31</td>
<td>-3.5</td>
<td>45.0</td>
<td>0.31</td>
<td>-3.5</td>
<td>27.0</td>
</tr>
<tr>
<td>0.31</td>
<td>-3.5</td>
<td>9.0</td>
<td>0.31</td>
<td>-3.5</td>
<td>-9.0</td>
<td>0.31</td>
<td>-3.5</td>
<td>-27.0</td>
</tr>
<tr>
<td>0.31</td>
<td>-3.5</td>
<td>-45.0</td>
<td>0.31</td>
<td>-3.5</td>
<td>-63.0</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

5. Axial Loads and Moments with Corresponding Capacities

<table>
<thead>
<tr>
<th>No</th>
<th>$\Phi P_a$ (kip)</th>
<th>$\Phi M_{na}$ (k-ft)</th>
<th>NA Depth (in)</th>
<th>$d_i$ Depth (in)</th>
<th>$\xi$</th>
<th>$\Theta$</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>649.5</td>
<td>8395.14</td>
<td>23.998</td>
<td>141.500</td>
<td>0.01469</td>
<td>0.900</td>
</tr>
<tr>
<td>2</td>
<td>649.5</td>
<td>-8395.14</td>
<td>23.998</td>
<td>141.500</td>
<td>0.01469</td>
<td>0.900</td>
</tr>
</tbody>
</table>
5.5 Example 5 - Capacity of an Irregular Section

5.5.1 Problem Formulation

Compute horizontal moment capacity $M_x$ of the unsymmetrical beam cross section shown below. Use 3-ksi concrete and 60-ksi reinforcing steel.

Note: when instructed to move to a location (15, 25), move the cursor until the cells in the Status bar show “x=15” and “y=25”.

From the File menu, choose New. Any input data is cleared and the default values are restored.

5.5.2 Preparing Input

- From the Input menu, choose General Information.
  - Select English units and ACI 318-14 code.
  - Select BIAXIAL for RUN AXIS, Investigation for run option and NO for CONSIDER SLENDERNESS.
  - Choose OK.

5.5.3 Assigning Properties

- From the Input menu, choose Material Properties.
  - Under CONCRETE, input 3 for the STRENGTH. Other properties are computed and will be accepted.
  - Choose OK.

- From the Input menu, choose Section | Irregular. When spSection module is loaded its window occupies the desktop. Open the DRAWING AREA box by selecting the arrow under the Grid On/Off button.
  - Under Limits, input 0 and 24 for the MINIMUM X and MAXIMUM X, respectively.
  - Under limits, input -20 and 4 for the MINIMUM Y and MAXIMUM Y, respectively.
  - Under GRID, input 4 and 4 for X and Y grid STEP, respectively.
  - Choose OK.
- Click Polygon icon under Draw Menu. The default shape type is Solid.
- In the drawing area, move the cursor to the location (0, 0) and click the left mouse button. A node is inserted.
- Move to (12, 0) and click the left mouse button.
- Move to (12, -20) and click the left mouse button.
- Move to (24, -20) and click the left mouse button.
- Move to (24, 4) and click the left mouse button.
- Move to (0, 4) and click the left mouse button.
- Move to (0, 0) and click the left mouse button.

- Select Single icon under Reinforcement Menu.

  - Under Options Menu on the left, select #9 from the drop-down list for BAR SIZE. Under Commands Menu, enter 14.142 for X-COORD and -17.5 for Y-COORD. Choose OK.
  
  - Under Options Menu on the left, select #8 from the drop-down list for BAR SIZE. Under Commands Menu, enter 18.0 for X-COORD and -17.5 for Y-COORD. Choose OK.
  
  - Under Options Menu on the left, select #8 from the drop-down list for BAR SIZE. Under Commands Menu, enter 22.0 for X-COORD and -17.5 for Y-COORD. Choose OK.

- From the General Menu, choose Save and Exit. You are returned to spColumn and the section is shown in the Information bar.
• From the **Input** menu, choose **Input | Loads | Factored**
  - Enter LOAD as 0 (zero), X-MOMENT as $-225$ k-ft and Y-MOMENT as 0. Choose INSERT.
  - Choose OK.

### 5.5.4 Solving

• From the **Solve** menu, choose **Execute**.
  - A message is displayed saying “Reinforcement ratio is less than 1% Consider column as architectural (i.e. fc is reduced by reinforcement ratio?)”. Click NO for this option.
  - The solver of the program is started and, upon completion, displays the interaction diagram of the section.

### 5.5.5 Viewing and Printing Results

• From the **View** menu, choose **Results**.
  - Use the explorer in the spResults module or the **Previous Table** and **Next Table** buttons in the toolbar to navigate through the tables.
  - Use the close button at the top right corner of the spResults windows to quit the spResults module and get back to spColumn.

• From the **File** menu, choose **Print Report | Default Report**.
  - Select the printer to send the default report to.
  - Choose PRINT.

• From the **File** menu, choose **Print Screen**.
  - Select the printer to send the graphical results to.
  - Choose PRINT
  - Change the interaction diagram to show the P-M diagram at $180^\circ$ using the $\square$ icon.
EXAMPLES

Code: ACI 318-14
Units: English
Run axis: Biaxial
Run option: Investigation
Slenderness: Not considered
Column type: Structural
Bars: ASTM A615
Date: 11/20/17
Time: 14:54:27

COLUMN

fc = 3 ksi  fy = 60 ksi  Ag = 336 in^2  3 bars
Ec = 3122 ksi  Es = 29000 ksi  As = 2.58 in^2  rho = 0.77%
fc = 2.55 ksi  e_yt = 0.00206897 in/in  Xo = 16.29 in  Ix = 18002.3 in^4
e_u = 0.003 in/in  Yo = -6.57 in  Iy = 9956.56 in^4
Beta1 = 0.85
Confinement: Tied
phi(a) = 0.8, phi(b) = 0.9, phi(c) = 0.65
Code: ACI 318-14
Units: English
Run axis: Biaxial
Run option: Investigation
Slenderness: Not considered
Column type: Structural
Bars: ASTM A615
Date: 11/21/17
Time: 13:20:31

File: C:\Program Files (x86)\StructurePoint\spColumn\Examples\Examples-Manual\Example05.col
Project: spColumn Manual Example 5
Column: MacGregor4.7
f_c = 3 ksi f_y = 60 ksi  Ag = 336 in^2  3 bars
E_c = 3122 ksi  E_s = 29000 ksi  A_s = 2.58 in^2  rho = 0.77%
f_c = 2.55 ksi  e_yt = 0.00206897 in/in  X_o = 16.29 in  I_x = 18002.3 in^4
e_u = 0.003 in/in  Y_o = -6.57 in  I_y = 9956.56 in^4
Beta1 = 0.85
Min clear spacing = 2.79 in  Clear cover = N/A
Confinement: Tied
phi(a) = 0.8, phi(b) = 0.9, phi(c) = 0.65
1. General Information

<table>
<thead>
<tr>
<th>File Name</th>
<th>C:\Program Files (x86)\StructurePoint\spColumn v6.00\spColumn\Examples\Examples-Manual\Example05.col</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project</td>
<td>spColumn Manual Example 5</td>
</tr>
<tr>
<td>Column</td>
<td>MacGregor 4.7</td>
</tr>
<tr>
<td>Engineer</td>
<td>SP</td>
</tr>
<tr>
<td>Code</td>
<td>ACI 318-14</td>
</tr>
<tr>
<td>Bar Set</td>
<td>ASTM A615</td>
</tr>
<tr>
<td>Units</td>
<td>English</td>
</tr>
<tr>
<td>Run Option</td>
<td>Investigation</td>
</tr>
<tr>
<td>Run Axis</td>
<td>Biaxial</td>
</tr>
<tr>
<td>Slenderness</td>
<td>Not Considered</td>
</tr>
<tr>
<td>Column Type</td>
<td>Structural</td>
</tr>
</tbody>
</table>

2. Material Properties

2.1. Concrete

<table>
<thead>
<tr>
<th>Type</th>
<th>Standard</th>
</tr>
</thead>
<tbody>
<tr>
<td>$f_c$</td>
<td>3 ksi</td>
</tr>
<tr>
<td>$E_c$</td>
<td>3122.02 ksi</td>
</tr>
<tr>
<td>$v_c$</td>
<td>2.55 ksi</td>
</tr>
<tr>
<td>$w_c$</td>
<td>0.003 in/in</td>
</tr>
<tr>
<td>$b_c$</td>
<td>0.65</td>
</tr>
</tbody>
</table>

2.2. Steel

<table>
<thead>
<tr>
<th>Type</th>
<th>Standard</th>
</tr>
</thead>
<tbody>
<tr>
<td>$f_y$</td>
<td>60 ksi</td>
</tr>
<tr>
<td>$E_y$</td>
<td>29000 ksi</td>
</tr>
<tr>
<td>$w_y$</td>
<td>0.00200897 in/in</td>
</tr>
</tbody>
</table>

3. Section

3.1. Shape and Properties

<table>
<thead>
<tr>
<th>Type</th>
<th>Irregular</th>
</tr>
</thead>
<tbody>
<tr>
<td>$A_s$</td>
<td>338 in²</td>
</tr>
<tr>
<td>$I_s$</td>
<td>18002.3 in⁴</td>
</tr>
<tr>
<td>$J_s$</td>
<td>9956.56 in⁴</td>
</tr>
<tr>
<td>$R_y$</td>
<td>7.31972 in</td>
</tr>
<tr>
<td>$R_t$</td>
<td>5.44359 in</td>
</tr>
<tr>
<td>$X_t$</td>
<td>16.2857 in</td>
</tr>
<tr>
<td>$Y_t$</td>
<td>-6.57143 in</td>
</tr>
</tbody>
</table>
3.2. Section Figure

![Section Figure]

Figure 1: Column section

3.3. Exterior Points

<table>
<thead>
<tr>
<th>Points</th>
<th>X (in)</th>
<th>Y (in)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>4</td>
<td>24.0</td>
<td>-20.0</td>
</tr>
</tbody>
</table>

3.4. Reinforcement

4.1. Bar Set: ASTM A615

<table>
<thead>
<tr>
<th>Bar</th>
<th>Diameter (in)</th>
<th>Area (in²)</th>
</tr>
</thead>
<tbody>
<tr>
<td>#3</td>
<td>0.38</td>
<td>0.11</td>
</tr>
<tr>
<td>#6</td>
<td>0.75</td>
<td>0.44</td>
</tr>
<tr>
<td>#9</td>
<td>1.13</td>
<td>1.00</td>
</tr>
<tr>
<td>#14</td>
<td>1.69</td>
<td>2.25</td>
</tr>
</tbody>
</table>

4.2. Confinement and Factors

<table>
<thead>
<tr>
<th>Type</th>
<th>Factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confinement type</td>
<td>Tied</td>
</tr>
<tr>
<td>For #10 bars or less</td>
<td>#3 ties</td>
</tr>
<tr>
<td>For larger bars</td>
<td>#4 ties</td>
</tr>
<tr>
<td>Capacity Reduction Factors</td>
<td></td>
</tr>
<tr>
<td>Axial compression, (a)</td>
<td>0.8</td>
</tr>
<tr>
<td>Tension controlled failure, (b)</td>
<td>0.9</td>
</tr>
<tr>
<td>Compression controlled failure, (c)</td>
<td>0.65</td>
</tr>
</tbody>
</table>

4.3. Arrangement

<table>
<thead>
<tr>
<th>Pattern</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Irregular</td>
<td></td>
</tr>
</tbody>
</table>
### 4.4. Bars Provided

<table>
<thead>
<tr>
<th>Area</th>
<th>X</th>
<th>Y</th>
</tr>
</thead>
<tbody>
<tr>
<td>in²</td>
<td>in</td>
<td>in</td>
</tr>
<tr>
<td>1.00</td>
<td>14.1</td>
<td>-17.5</td>
</tr>
<tr>
<td>0.79</td>
<td>18.0</td>
<td>-17.5</td>
</tr>
<tr>
<td>0.79</td>
<td>22.0</td>
<td>-17.5</td>
</tr>
</tbody>
</table>

### 5. Factored Loads and Moments with Corresponding Capacities

<table>
<thead>
<tr>
<th>No</th>
<th>P&lt;sub&gt;x&lt;/sub&gt;</th>
<th>M&lt;sub&gt;ax&lt;/sub&gt;</th>
<th>M&lt;sub&gt;ay&lt;/sub&gt;</th>
<th>P&lt;sub&gt;max&lt;/sub&gt; M&lt;sub&gt;ay&lt;/sub&gt;</th>
<th>P&lt;sub&gt;max&lt;/sub&gt; M&lt;sub&gt;ax&lt;/sub&gt;</th>
<th>NA Depth</th>
<th>d&lt;sub&gt;z&lt;/sub&gt; Depth</th>
<th>ε&lt;sub&gt;z&lt;/sub&gt;</th>
<th>( \Phi )</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.00</td>
<td>-225.00</td>
<td>0.00</td>
<td>-234.43</td>
<td>0.00</td>
<td>0.897</td>
<td>7.21</td>
<td>23.53</td>
<td>0.00685</td>
</tr>
</tbody>
</table>

*Section capacity exceeded. Revise design.*
5.6 Example 6 - Investigation of a Rectangle Short Column

5.6.1 Problem Formulation

Determine the adequacy of a 200 mm x 350 mm column with 6-15M bars. Note that since the least column dimension is less than 300mm, the maximum section axial design capacity is capped in CSA A23.3-14 as required by clause 10.10.4.

The concrete used is 30 MPa and the reinforcing steel is 400 MPa.

The factored load values for the column under consideration are as follows:

\[
\begin{align*}
  P \text{ (kN)} & \quad 500 \text{ kN} \\
  M_{ux} \text{ (kN-m)} & \quad 37.5 \text{ kN-m}
\end{align*}
\]

From the File menu, choose New. Any input data is cleared and the default values are restored.

5.6.2 Preparing Input

- From the Input menu, choose General Information.
  - Input the PROJECT header.
  - Select METRIC units and CSA A23.3-14 code.
  - Select About X-Axis for run axis, Investigation for run option and No for Consider Slenderness?
  - Choose OK.

5.6.3 Assigning Properties

- From the Input menu, choose Material Properties.

---

82. Based on STRUCTUREPOINT Hand Verification Example based on CSA A23.3-14 Concrete Design Handbook
- Input 30 for the CONCRETE STRENGTH, and 400 for the REINFORCING STEEL STRENGTH. Other properties are computed and will be accepted.
- Choose OK.

• From the **Input** menu, choose **Section | Rectangular**.
  - Input 350 and 200 for the section width (along X) and depth (along Y).
  - Choose OK.

![Rectangular Section](image)

• From the **Options** menu, choose **Reinforcement**.
  - For Bar Set, choose CSA G30.18 from the drop down list.
  - Choose OK.

• From the **Input** menu, choose **Reinforcement | Sides Different**
  - Input 3–#15 bars for TOP and BOTTOM and 0–#15 for LEFT and RIGHT. Input 50 in for the cover and select LONGITUDINAL BARS.
  - Choose OK.

![Sides Different](image)

• From the **Input** menu, choose **Loads | Factored**.
  - Input 500 for the AXIAL LOAD, 37.5 for the X-MOMENTS.
  - Choose INSERT to add the entry to the list box.
  - Choose OK.
5.6.4  **Solving**

- From the **Solve** menu, choose **Execute**.
  - The solver of the program is started and, upon completion, displays the interaction diagram of the section with the load point plotted within the diagram.

5.6.5  **Viewing and Printing Results**

- From the **View** menu, choose **Results**.
  - Use the explorer in the spResults module or the **Previous Table** and **Next Table** buttons in the toolbar to navigate through the tables.
  - Use the close button at the top right corner of the spResults windows to quit the spResults module and get back to spColumn.

- From the **File** menu, choose **Print Report | Default Report**.
  - Select the printer to send the default report to.
  - Choose PRINT.

- From the **File** menu, choose **Print Screen**.
  - Select the printer to send the graphical results to.
  - Choose PRINT.
EXAMPLES

350 x 200 mm

Code: CSA A23.3-14
Units: Metric
Run axis: About X-axis
Run option: Investigation
Slenderness: Not considered
Column type: Structural
Bars: CSA G30.18
Date: 11/20/17
Time: 14:55:44

STRUCTUREPOINT - spColumn v6.00 (TM). Licensed to: StructurePoint. License ID: 000000-000000-4-25EF2-1C3DF

File: C:\Program Files (x86)\StructurePoint\spColumn\Examples\Examples-Manual\Example06.col
Project: spColumn Manual Example 6

Column: Rect-200x350

f_c = 30 MPa
f_y = 400 MPa
E_c = 26621 MPa
E_s = 200000 MPa
f_c = 24.15 MPa
e_yt = 0.002 mm/mm
e_u = 0.0035 mm/mm
Beta1 = 0.895

Engineer: SP
Ag = 70000 mm^2
As = 1200 mm^2
X_o = 0 mm
I_x = 2.33e+008 mm^4
Y_o = 0 mm
I_y = 7.15e+008 mm^4
Clear cover = 50 mm

Confinement: Tied
phi(a) = 0.6, phi(s) = 0.85, phi(c) = 0.65, phi(rho) = 1.00, Min. Dimension(h) = 200 mm
1. General Information

<table>
<thead>
<tr>
<th>File Name</th>
<th>C:\Program Files (x86)\StructurePoint\spColumn Manual Example 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project</td>
<td>spColumn Manual Example 6</td>
</tr>
<tr>
<td>Column</td>
<td>Rect-200x350</td>
</tr>
<tr>
<td>Engineer</td>
<td>SP</td>
</tr>
<tr>
<td>Code</td>
<td>CSA A23.3-14</td>
</tr>
<tr>
<td>Bar Set</td>
<td>CSA G30.18</td>
</tr>
<tr>
<td>Units</td>
<td>Metric</td>
</tr>
<tr>
<td>Run Option</td>
<td>Investigation</td>
</tr>
<tr>
<td>Run Axis</td>
<td>X - axis</td>
</tr>
<tr>
<td>Slenderness</td>
<td>Not Considered</td>
</tr>
<tr>
<td>Column Type</td>
<td>Structural</td>
</tr>
</tbody>
</table>

2. Material Properties

2.1. Concrete

<table>
<thead>
<tr>
<th>Type</th>
<th>Standard</th>
</tr>
</thead>
<tbody>
<tr>
<td>$f_c$</td>
<td>30 MPa</td>
</tr>
<tr>
<td>$E_c$</td>
<td>26621.1 MPa</td>
</tr>
<tr>
<td>$f_y$</td>
<td>24.15 MPa</td>
</tr>
<tr>
<td>$e_c$</td>
<td>0.0035 mm/mm</td>
</tr>
<tr>
<td>$f_t$</td>
<td>0.895</td>
</tr>
</tbody>
</table>

2.2. Steel

<table>
<thead>
<tr>
<th>Type</th>
<th>Standard</th>
</tr>
</thead>
<tbody>
<tr>
<td>$f_y$</td>
<td>400 MPa</td>
</tr>
<tr>
<td>$E_s$</td>
<td>200000 MPa</td>
</tr>
<tr>
<td>$e_s$</td>
<td>0.002 mm/mm</td>
</tr>
</tbody>
</table>

3. Section

3.1. Shape and Properties

<table>
<thead>
<tr>
<th>Type</th>
<th>Rectangular</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>350 mm</td>
</tr>
<tr>
<td>Depth</td>
<td>200 mm</td>
</tr>
<tr>
<td>$A_t$</td>
<td>70000 mm²</td>
</tr>
<tr>
<td>$I_x$</td>
<td>2.33333e+008 mm⁴</td>
</tr>
<tr>
<td>$I_y$</td>
<td>7.14583e+008 mm⁴</td>
</tr>
<tr>
<td>$r_x$</td>
<td>57.735 mm</td>
</tr>
<tr>
<td>$r_y$</td>
<td>101.036 mm</td>
</tr>
<tr>
<td>$X_c$</td>
<td>0 mm</td>
</tr>
<tr>
<td>$Y_c$</td>
<td>0 mm</td>
</tr>
</tbody>
</table>
3.2. Section Figure

![Section Figure](image-url)

Rectangular 350 x 200 mm 1.71% rein.

Figure 1: Column section

4. Reinforcement

4.1. Bar Set: CSA G30.18

<table>
<thead>
<tr>
<th>Bar</th>
<th>Diameter (mm)</th>
<th>Area (mm²)</th>
</tr>
</thead>
<tbody>
<tr>
<td>#10</td>
<td>11.30</td>
<td>100.00</td>
</tr>
<tr>
<td>#25</td>
<td>25.20</td>
<td>500.00</td>
</tr>
<tr>
<td>#45</td>
<td>43.70</td>
<td>1500.00</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Bar</th>
<th>Diameter (mm)</th>
<th>Area (mm²)</th>
</tr>
</thead>
<tbody>
<tr>
<td>#15</td>
<td>16.00</td>
<td>200.00</td>
</tr>
<tr>
<td>#30</td>
<td>29.90</td>
<td>700.00</td>
</tr>
<tr>
<td>#55</td>
<td>56.40</td>
<td>2500.00</td>
</tr>
<tr>
<td>#20</td>
<td>19.50</td>
<td>300.00</td>
</tr>
<tr>
<td>#35</td>
<td>35.70</td>
<td>1000.00</td>
</tr>
</tbody>
</table>

4.2. Confinement and Factors

<table>
<thead>
<tr>
<th>Confinement type</th>
<th>Tied</th>
</tr>
</thead>
<tbody>
<tr>
<td>For #5 bars or less</td>
<td>#10 ties</td>
</tr>
<tr>
<td>For larger bars</td>
<td>#10 ties</td>
</tr>
</tbody>
</table>

Material Resistance Factors

- Axial compression, (a) 0.6
- Steel (Fₚₚ) 0.85
- Concrete (Fₚₚ) 0.65

Minimum dimension, h 200 mm

4.3. Arrangement

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Sides different</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bar layout</td>
<td>***</td>
</tr>
<tr>
<td>Cover to</td>
<td>Longitudinal bars</td>
</tr>
<tr>
<td>Clear cover</td>
<td>***</td>
</tr>
<tr>
<td>Bars</td>
<td>***</td>
</tr>
</tbody>
</table>

Total steel area, Aₚ 1200 mm²

ρ 1.71 %

Minimum clear spacing 68 mm
4.4. Bars Provided

<table>
<thead>
<tr>
<th></th>
<th>Bars</th>
<th>Cover mm</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top</td>
<td>3 #15</td>
<td>50</td>
</tr>
<tr>
<td>Bottom</td>
<td>3 #15</td>
<td>50</td>
</tr>
<tr>
<td>Left</td>
<td>0 #15</td>
<td>50</td>
</tr>
<tr>
<td>Right</td>
<td>0 #15</td>
<td>50</td>
</tr>
</tbody>
</table>

5. Factored Loads and Moments with Corresponding Capacities

<table>
<thead>
<tr>
<th>No</th>
<th>$P_i$ kN</th>
<th>$M_{u}$ kNm</th>
<th>$M_{a}$ kNm</th>
<th>$M_{u}/M_{a}$</th>
<th>NA Depth mm</th>
<th>$d_i$ Depth mm</th>
<th>$\xi$</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>500.00</td>
<td>37.50</td>
<td>39.25</td>
<td>1.047</td>
<td>101</td>
<td>142</td>
<td>0.00140</td>
</tr>
</tbody>
</table>
CHAPTER 6

spSection MODULE

6.1 Introduction ................................................................. 154
6.2 Main Menu ................................................................. 155
6.3 View Menu ................................................................. 155
6.4 Toolbar - General ......................................................... 158
6.5 Toolbar - Modify .......................................................... 158
6.6 Toolbar - Draw ............................................................ 159
6.7 Toolbar - Reinforcement .............................................. 159
6.8 Toolbar - Reshape ....................................................... 160
6.9 Toolbar - Misc ............................................................ 160
6.10 Toolbar - DXF ............................................................ 161
6.1 Introduction

spSection is an add-on module to the spColumn program. It enables the user to investigate irregularly shaped reinforced concrete sections subject to a combination of loadings. spSection considers a polygonal section reinforced with bars located at any location. The section may contain one opening.

spSection is accessed from within spColumn. Once spColumn is started, you can activate spSection by selecting the **Section | Irregular** command from the **Input** menu. This starts spSection, locks the spColumn window and maximizes the spSection window. The section geometry may then be defined by drawing it on the screen or by inputting the coordinates of the polygon nodes. Once the section definition is complete, return to spColumn by selecting **Save and Exit** from the **Main** menu or the Toolbar. The following is a list of the spSection window components.
6.2 Main Menu

Import
Imports the DXF File.

Export
Exports to the DXF File.

Errors
Lists the errors in the spSection model.

Validate
Checks if the section is valid for analysis by spColumn.

Save and Exit
Saves changes and exits.

Exit without Saving
Discards changes and exits.

6.3 View Menu

Toolbar
Provides five options to determine the location and size of the toolbar.

Settings
Provides the user with options to modify general and color settings.

In General Settings, user controls are provided for display, at exit choices, and precision options.

Display:

- Coordinate system sign: Provides a cross-hair indicating the X and Y axes.
- Object Centroid: Provides a cross-hair at the object centroid.
- Grid labels: Show or hide grid labels
- Flying text: Displays the parameters related to the operation in flying text box while performing that operation.
At Exit:

- Combine all shapes: When checked, it combines all shapes at exit.
- Align model centroid to coordinate system origin: When checked, it aligns model centroid to the coordinate system centroid at exit.

Precision:

- General: Shows on 0 to 3 trailing decimal places when entering dimensions at the left panel textboxes.
- Flying text: Shows on 0 to 3 trailing decimal places when displaying flying text.

In Colors Settings:

- Shapes: Color options for solid, selected solids, openings, and selected openings.
- Reinforcement: Color options for bar, selected bar, and overlapped bar.
- Misc: Color options for main grid lines, other grid lines, and screen background.
View Controls

Shows or hides the view controls. Arrows in the upper right corner provide controls for the location or the tool and extent of functions. The icons show in blue when active. View controls provide the following operator functions:

- Show and hide 3D rotation cube.
- Rotate section in 3D (shift + middle mouse button)
- Zoom to workspace
- Zoom to model
- Zoom to window
- Zoom in (mouse wheel)
- Zoom out (mouse wheel)
- Pan (middle mouse button)
- Grid On/Off: Shows or hides the grids. The arrow at the bottom of the icon opens Drawing Area dialog box which enables the user to edit the limits of drawing area and grid steps in X, and Y directions.
- Snap On/Off: Activates or deactivates the snap feature, the arrow at the bottom of the icon opens Snap dialog box. Snap options are: Grid, shapes, cover, reinforcements, intersections, and coordinate system origin.

- Ortho mode On/Off: Restrict cursor movement to horizontal and vertical direction when creating or modifying sections.

Status Bar

Shows or hides the status bar. Status bar is located at the bottom of the screen and displays the bars set, active command and its instruction, the coordinates of the cursor, and the units.
6.4 Toolbar - General

Save and Exit

Saves changes and exits.

Exit without Saving

Discards changes and exits.

Undo

Undo last operation (Ctrl + Z).

Redo

Redo last operation (Ctrl + Y).

6.5 Toolbar - Modify

Mirror

Mirrors selected items about line or point.

Delete

Deletes selected items.

Copy

Copies selected items to new location.

Rotate

Rotates selected items from a base point by a specified angle.

Move

Moves selected items to new location.

Select

Selects items to perform operations.
6.6 Toolbar - Draw

**Rectangle**

Creates rectangular shapes of solid or opening by clicking the start and end points. Alternately, the shape can be created by typing precise start point coordinates and dimensions at the left panel when Draw | Rectangle icon is active.

**Polygon**

Creates polygon shapes by specifying its vertices in the drawing area until the closed polygon shape is obtained or by typing precise point coordinates and then pressing close button at the left panel when Draw | Polygon icon is active.

**Circle**

Creates circular shapes in one of the three methods namely;

- Circle | Draw circle by radius: Create circular shape by specifying center point and radius.
- Circle 2 points | Draw circle by diameter: Create circular shape by specifying its diameter.
- Circle 3 points | Draw circle by tangent points: Create circular shape by specifying three tangent points.

**Combine**

Combines all shapes or just selected shapes.

6.7 Toolbar - Reinforcement

**Single – Add single reinforcement bar**

Creates a single reinforcement bar at a point. When the reinforcement single icon is active, single bar can be created by clicking at any point on the screen. Alternatively, single reinforcement bar can also be created by entering precise coordinates at the left panel.

**Linear – Add bars in linear pattern**

Creates a linear bar pattern based on the specified bar number or bar spacing. When the reinforcement linear icon is active, linear bar pattern can be created by specifying start and next points on the screen. Alternatively, linear bar pattern can also be created by entering precise coordinates of the start point and next points at the left panel.
Rectangular – Add bars in rectangular pattern

Creates a rectangular bar pattern based on the specified number of bars in the X and Y directions respectively. When the reinforcement rectangular icon is active, rectangular bar pattern can be created by specifying start and end points of the diagonal on the screen. Alternatively, rectangular bar pattern can also be created by entering precise coordinates of the start point and the translation vector of the diagonal for the rectangle, at the left panel.

Circular – Add bars in circular pattern

Creates a circular bar pattern based on the specified bar number or bar spacing. When the reinforcement circular icon is active, circular bar pattern can be created by specifying the center point of the circle and the end point of its radius on the screen. Alternatively, circular bar pattern can also be created by entering precise coordinates of the center point, the radius and its angle with x-axis, at the left panel.

Cover

Shows and hides the bar cover guide. The cover type i.e. clear or to bar center and the required value can be specified while using each of the above mentioned commands for reinforcement.

6.8 Toolbar - Reshape

Add – Add nodes

Creates additional nodes on shape edges.

Select – Select nodes

Selects nodes to move or delete.

6.9 Toolbar - Misc

Measure

Measures distance between two points.

Validate

Checks if the section is valid for analysis by spColumn.
Settings

Modifies settings for view, display, combine, precision, and colors. Refer to View Menu for more information on settings.

6.10 Toolbar - DXF

Export DXF

Exports the model to DXF file.

Import DXF

Imports a model from DXF file.
CHAPTER 7

spReporter MODULE

7.1 Introduction ........................................................................................................... 164
7.2 Toolbar .................................................................................................................. 165
7.3 Export / Print Panel ............................................................................................ 166
7.4 Explorer panel ....................................................................................................... 167
7.1 Introduction

spReporter is a module of the spColumn program. It enables the user to view, customize, print and export reports in different formats.

spReporter is accessed from within spColumn. Once a successful run has been performed, you can open spReporter by selecting the Reporter command from the View menu. Alternatively, spReporter can also be accessed by pressing the F7 key or by clicking on the spReporter button in the program toolbar. Immediately after opening spReporter, you can export and/or print the default report by pressing Export/Print button. Various options to customize the report before printing and/or exporting it are also provided. Once the work in spReporter is complete click the close button in the top right corner to exit the spReporter window.
7.2 Toolbar

**Previous page**
Displays the previous page of the report.

**Next page**
Displays the next page of the report.

**Page number box**
Displays the page with the page number entered in the box.

**Zoom in**
Zooms in on the report (Ctrl + Mouse wheel up).

**Zoom out**
Zooms out on the report (Ctrl + Mouse wheel down).

**Zoom box**
Zooms on the report preview to the extent typed in the box or selected from the dropdown list.

**Fit to window width and enable scrolling**
Fits the width of report to the preview space width and enables scrolling.

**Fit one full page to window**
Fits one full page in the preview space.

**Pan**
When toggled on and if the report is bigger than preview window, enables panning the report.

**Text selection**
When toggled on enables selecting text in the report.

**Settings**
Modifies settings for report and explorer panel.
– Report Settings
   Regenerate automatically: Enables automatic regeneration of report when content selection is modified by the user.
   Split long tables: Displays table headings in all pages when tables are split along several pages.
– Explorer Settings
   Location: Displays explorer panel on the left or right side of screen depending on selection.
   Hide inactive items: Hides unused tables from the explorer view.

Explorer
   Shows or hides the explorer panel.

7.3 Export / Print Panel

Export
   Exports the report in the selected format.

Print
   Prints the report in the selected format when the option is available.
Type
Provides 5 format options to print and/or export the reports
- **Word**: Produces a Microsoft Word file with .docx extension.
- **PDF**: Produces an Adobe Acrobat file with .pdf extension.
- **Text**: Produces a Text file with .txt extension.
- **Excel**: Produces a Microsoft Excel file with .xlsx extension.
- **CSV**: Produces a Comma Separated file with .csv extension.

Printer
Provides the option to select available printers and change printer properties.

Settings
Provides the options to modify print settings.
- **Paper**: Provides the options to select from available paper sizes.
- **Orientation**: Provides the options to select between landscape or portrait paper orientation.
- **Margins**: Provides the options to use narrow, normal, wide or custom margins to the report.
- **Print range**: Provides the options to select the pages to print and/or export.

### 7.4 Explorer panel

The explorer panel consists of all the available report items classified into sections and arranged hierarchically. Each item listed in the explorer panel is preceded by a checkbox. The user can check/uncheck the checkbox to include or exclude from the report, the items or sections.
Expand all
   Expands item list.

Collapse all
   Collapses item list.
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>8.1 Introduction</td>
<td>170</td>
</tr>
<tr>
<td>8.2 Toolbar</td>
<td>170</td>
</tr>
<tr>
<td>8.3 Explorer panel</td>
<td>172</td>
</tr>
</tbody>
</table>
8.1 Introduction

spResults is a module of the spColumn program. It enables the user to view program input and output in tables and export them in different formats.

spResults is accessed from within spColumn. Once a model has been successfully executed, you can open spResults by selecting the Results command from the View menu. Alternatively, spResults can also be accessed by pressing the F6 key or by clicking on the spResults button in the program toolbar. Once the work in spResults is complete click the close button in the top right corner to exit spResults window.

8.2 Toolbar

Previous table
Displays the previous table.

Next table
Displays the next table.
Table number box

Displays the table with the table number entered in the box.

Auto fit column width to view area

When toggled on always fits the width of table to the preview space width.

Maintain maximum column width

Switches all table columns to their default maximum width.

Export current table

Exports the table being viewed in the selected format.

Settings

Modifies settings for tables and explorer panel.

- Tables settings
  
  Highlight critical items: Enables highlighting of critical items in the “Loads and Capacities” table.
  
  Highlighting color: Provides color options for highlighting critical items.

- Explorer settings
  
  Location: Displays explorer panel on the left or right side of screen depending on selection
  
  Hide inactive items: Hides unused tables from the explorer view.

Explorer

Shows or hides the explorer panel.
8.3 Explorer panel

The explorer panel consists of all the available items of the result classified into sections and arranged hierarchically. Any item in the explorer panel can be clicked on to display the corresponding table in the preview space.

**Expand all**
Expands item list.

**Collapse all**
Collapses item list.
APPENDIX

A.1 Import File Formats ........................................................................................ 174
  A.1.1 Service Loads Data: ............................................................................... 174
  A.1.2 Factored Loads Data: ............................................................................ 174
  A.1.3 Reinforcement Data: .............................................................................. 175
  A.1.4 Geometry Data: ...................................................................................... 175
A.2 spColumn Text Input (CTI) file format .......................................................... 176
A.3 Conversion Factors - English to SI .............................................................. 191
A.4 Conversion Factors - SI to English .............................................................. 192
A.5 Material Strength Value Limits ...................................................................... 193
A.6 Contact Information ....................................................................................... 194
A.1 Import File Formats

Geometry, reinforcement or load data may be imported from a text file. The import file must be saved in pure ASCII (text) format. Data fields on each line should be separated by spaces or TABs. Comments or blank lines should not be placed within the import file.

A.1.1 Service Loads Data:

No_Of_Load_Points
P1_D M1x_DT M1x_DB M1y_DB M1y_DB
P1_L M1x_LT M1x_LB M1y_LT M1y_LB
P1_W M1x_WT M1x_WB M1y_WT M1y_WB
P1_EQ M1x_EQT M1x_EQB M1y_EQT M1y_EQB
P1_S M1x_ST M1x_SB M1y_ST M1y_SB
...
Pn_D Mnx_DT Mnx_DB Mny_DB Mny_DB
Pn_L Mnx_LT Mnx_LB Mny_LT Mny_LB
Pn_W Mnx_WT Mnx_WB Mny_WT Mny_WB
Pn_EQ Mnx_EQT Mnx_EQB Mny_EQT Mny_EQB
Pn_S Mnx_ST Mnx_SB Mny_ST Mny_SB

Each service load point has five lines of data (one line for each load case, i.e. Dead, Live, Wind, Earthquake, and Snow). Each data line has five values. For a service load point \( i \), \( P_i \), \( M_i \), \( M_{i, DT} \), \( M_{i, DB} \), \( M_{i, LT} \), \( M_{i, LB} \), \( M_{i, WT} \), \( M_{i, WB} \), \( M_{i, EQT} \), \( M_{i, EQB} \), \( M_{i, ST} \), \( M_{i, SB} \) are the axial load, \( M_x \) at top, \( M_x \) at bottom, \( M_y \) at top and \( M_y \) at bottom, respectively. The notation \( D, L, W, EQ, \) and \( S \) designate the Dead, Live, Wind, Earthquake, and Snow load cases, respectively.

A.1.2 Factored Loads Data:

No_Of_Load_Points
P1 M1x M1y
P2 M2x M2y
...
Pn Mnx Mny
For a factored load point $i$, $P_i$ is the factored axial load, $M_{ix}$ is the factored moment about $x$ and $M_{iy}$ is the factored moment about $y$.

### A.1.3 Reinforcement Data:

No_of_Bars  
A1 X1 Y1  
...  
An Xn Yn  

For a bar $i$, $A_i$ is the bar area, $X_i$ is its x-coordinate, and $Y_i$ is its y-coordinate.

### A.1.4 Geometry Data:

No_of_Section_Nodes  
Xs1 Ys1  
Xs2 Ys2  
...  
Xsn Ysn  
No_of_Opening_Nodes  
Xo1 Yo1  
Xo2 Yo2  
...  
Xon Yon  

For a section node $s_i$, $X_{si}$ is the x-coordinate of the node and $Y_{si}$ is its y-coordinate.  
For an opening node $o_i$, $X_{oi}$ is the x-coordinate of the node and $Y_{oi}$ is its y-coordinate.  
If the section does not contain an opening, you must have a zero for the value of No_of_Opening_Nodes.
A.2  spColumn Text Input (CTI) file format

spColumn is able to read and save its input data into two file formats, COL file or CTI file. CTI files are plain text files that can be edited by any text editing software.

Caution must be used when editing a CTI file because some values may be interrelated. If one of these values is changed, then other interrelated values should be changed accordingly. While this is done automatically when a model is edited in the spColumn user graphic user interface (GUI), one must update all the related values in a CTI file manually in order to obtain correct results. For example, if units are changed from English to Metric in GUI, all the related input values are updated automatically. If this is done by editing a CTI file, however, not only the unit flag but also all the related input values must be updated manually.

The best way to create a CTI file is by using the spColumn GUI and selecting CTI file type in the Save As menu command. Then, any necessary modifications to the CTI file can be applied with any text editor. However, it is recommended that users always verify modified CTI files by loading them in the spColumn GUI to ensure that the modifications are correct before running manually revised CTI files in batch mode.

The CTI file is organized by sections. Each section contains a title in square brackets, followed by values required by the section. The CTI file contains the following sections.

[spColumn Version]
[Project]
[Column ID]
[Engineer]
[Investigation Run Flag]
[Design Run Flag]
[Slenderness Flag]
[User Options]
[Irregular Options]
[Ties]
[Investigation Reinforcement]
[Design Reinforcement]
[Investigation Section Dimensions]
[Design Section Dimensions]
[Material Properties]
[Reduction Factors]
[Design Criteria]
[External Points]
[Internal Points]
[Reinforcement Bars]
[Factored Loads]
[Slenderness: Column]
[Slenderness: Column Above And Below]
[Slenderness: Beams]
[EI]
[SldOptFact]
[Phi_Delta]
[Cracked I]
[Service Loads]
[Load Combinations]
[BarGroupType]
[User Defined Bars]
[Sustained Load Factors]

Each section of a CTI file and allowable values of each parameter are described in details below. Corresponding GUI commands are presented in parenthesis.

#spColumn Text Input (CTI) File

The number sign, #, at the beginning of a line of text indicates that the line of text is a comment. The # sign must be located at the beginning of a line. Comments may be added anywhere necessary in a CTI file to make the file more readable. If a comment appears in multiple lines, each line must be started with a # sign

[spColumn Version]

Reserved. Do not edit.

[Project]

There is one line of text in this section.

Project name (menu Input | General Information…)

[Column ID]
There is one line of text in this section.

Column ID (menu Input | General Information…)

[Engineer]

There is one line of text in this section.

Engineer name (Menu Input | General Information…)

[Investigation Run Flag]

Reserved. Do not edit.

[Design Run Flag]

Reserved. Do not edit.

[Slenderness Flag]

Reserved. Do not edit.

[User Options]

There are 26 values separated by commas in one line in this section. These values are described below in the order they appear from left to right.

1. 0-Investigation Mode; 1-Design Mode; (Run Option on menu Input | General Information…)
2. 0-English Unit; 1-Metric Units; (Units on menu Input | General Information…)
3. 0-ACI 318-02; 1-CSA A23.3-94; 2-ACI 318-05; 3-CSA A23.3-04; 4-ACI 318-08; 5-ACI 318-11; 6-ACI 318-14; 7-CSA A23.3-14 (Design Code on menu Input | General Information…)
4. 0-X Axis Run; 1-Y Axis Run; 2-Biaxial Run; (Run Axis on menu Input | General Information…)
5. Reserved. Do not edit.
6. 0-Slenderness is not considered; 1-Slenderness in considered; (Consider slenderness? on menu Input | General Information…)
7. 0-Design for minimum number of bars; 1-Design for minimum area of reinforcement; (Bar selection on menu Input | Reinforcement | Design Criteria…)
8. Reserved. Do not edit.
9. 0-Rectangular Column Section; 1-Circular Column Section; 2-Irregular Column Section; (menu Input | Section)
10. 0-Rectangular reinforcing bar layout; 1-Circular reinforcing bar layout; (Bar Layout on menu Input | Reinforcement | All Sides Equal)
11. 0-Structural Column Section; 1-Architectural Column Section; 2-User Defined Column Section; (Column Type on menu Input | Reinforcement | Design Criteria…)
12. 0-Tied Confinement; 1-Spiral Confinement; 2-Other Confinement; (Confinement dropdown list on menu Input | Reinforcement | Confinement…)
13. Load type for investigation mode: (menu Input | Loads) 0-Factored; 1-Service; 2-Control Points; 3-Axial Loads
14. Load type for design mode: (menu Input | Loads) 0-Factored; 1-Service; 2-Control Points; 3-Axial Loads
15. Reinforcement layout for investigation mode: (menu Input | Reinforcement) 0-All Side Equal; 1-Equal Spacing; 2-Sides Different; 3-Irregular Pattern
16. Reinforcement layout for design mode: (menu Input | Reinforcement) 0-All Side Equal; 1-Equal Spacing; 2-Sides Different; 3-Irregular Pattern
17. Reserved. Do not edit.
18. Number of factored loads (menu Input | Loads | Factored…)
19. Number of service loads (menu Input | Loads | Service…)
20. Number of points on exterior column section
21. Number of points on interior section opening
22. Reserved. Do not edit.
23. Reserved. Do not edit.
24. Cover type for investigation mode: (menu Input | Reinforcement) 0-To transverse bar; 1-To longitudinal bar
25. Cover type for design mode: (menu Input | Reinforcement) 0-To transverse bar; 1-To longitudinal bar
26. Number of load combinations; (menu Input | Load | Load Combinations…)

[Irregular Options]
There are 13 values separated by commas in one line in this section. These values are described below in the order they appear from left to right. (menu Input | Section | Irregular | Section Editor menu Main | Drawing Area)

1. Reserved. Do not edit.
2. Reserved. Do not edit.
3. Reserved. Do not edit.
4. Reserved. Do not edit.
5. Area of reinforcing bar that is to be added through irregular section editor
6. Maximum X value of drawing area of irregular section editor
7. Maximum Y value of drawing area of irregular section editor
8. Minimum X value of drawing area of irregular section editor
9. Minimum Y value of drawing area of irregular section editor
10. Grid step in X of irregular section editor
11. Grid step in Y of irregular section editor
12. Grid snap step in X of irregular section editor
13. Grid snap step in Y of irregular section editor

[Ties]
There are 3 values separated by commas in one line in this section. These values are described below in the order they appear from left to right. (Menu Input | Reinforcement | Confinement…)

1. Index (0 based) of tie bars for longitudinal bars smaller that the one specified in the 3rd item in this section in the drop-down list
2. Index (0 based) of tie bars for longitudinal bars bigger that the one specified in the 3rd item in this section in the drop-down list
3. Index (0 based) of longitudinal bar in the drop-down list

[Investigation Reinforcement]
This section applies to investigation mode only. There are 12 values separated by commas in one line in this section. These values are described below in the order they appear from left to right.

If Side Different (Menu Input | Reinforcement | Side Different…) is selected:

1. Number of top bars
If All Sides Equal (Menu Input | Reinforcement | All Sides Equal…) or Equal Spacing (Menu Input | Reinforcement | Equal Spacing…) is selected:

1. Number of bars (No. of Bars text box)
2. Reserved. Do not edit.
3. Reserved. Do not edit.
4. Reserved. Do not edit.
5. Index (0 based) of bar (Bar Size drop-down list)
6. Reserved. Do not edit.
7. Reserved. Do not edit.
8. Reserved. Do not edit.
9. Clear cover to bar (Clear Cover text box)
10. Reserved. Do not edit.
11. Reserved. Do not edit.
12. Reserved. Do not edit.

If Irregular Pattern (Menu Input | Reinforcement | Irregular Pattern…) is selected:

Reserved. Do not edit.

[Design Reinforcement]

This section applies to design mode only. There are 12 values separated by commas in one line in this section. These values are described below in the order they appear from left to right.
APPENDIX

If Side Different (Menu Input | Reinforcement | Side Different…) is selected:

1. Minimum number of top and bottom bars
2. Maximum number of top and bottom bars
3. Minimum number of left and right bars
4. Maximum number of left and right bars
5. Index (0 based) of minimum size for top and bottom bars
6. Index (0 based) of maximum size for top and bottom bars
7. Index (0 based) of minimum size for left and right bars
8. Index (0 based) of maximum size for left and right bars
9. Clear cover to top and bottom bars
10. Reserved. Do not edit.
11. Clear cover to left and right bars
12. Reserved. Do not edit.

If All Sides Equal (Menu Input | Reinforcement | All Sides Equal…) or Equal Spacing (Menu Input | Reinforcement | Equal Spacing…) is selected:

1. Minimum number of bars
2. Maximum number of bars
3. Reserved. Do not edit.
4. Reserved. Do not edit.
5. Index (0 based) of minimum size of bars
6. Index (0 based) of maximum size of bars
7. Reserved. Do not edit.
8. Reserved. Do not edit.
9. Clear cover
10. Reserved. Do not edit.
11. Reserved. Do not edit.
12. Reserved. Do not edit.

[Investigation Section Dimensions]

This section applies to investigation mode only. There are 2 values separated by commas in one line in this section. These values are described below in the order they appear from left to right.
If rectangular section (Menu Input | Section | Rectangular…) is selected:

1. Section width (along X)
2. Section depth (along Y)

If circular section (Menu Input | Section | Circular…) is selected:

1. Section diameter
2. Reserved. Do not edit.

If irregular section (Menu Input | Section | Irregular) is selected:

1. Reserved. Do not edit.
2. Reserved. Do not edit.

[Design Section Dimensions]

This section applies to design mode only. There are 6 values separated by commas in one line in this section. These values are described below in the order they appear from left to right.

If rectangular section (Menu Input | Section | Rectangular…) is selected:

1. Section width (along X) Start
2. Section depth (along Y) Start
3. Section width (along X) End
4. Section depth (along Y) End
5. Section width (along X) Increment
6. Section depth (along Y) Increment

If circular section (Menu Input | Section | Circular…) is selected:

1. Diameter start
2. Reserved. Do not change.
3. Diameter end
4. Reserved. Do not change.
5. Diameter increment
6. Reserved. Do not change.

[Material Properties]
There are 11 values separated by commas in one line in this section. These values are described below in the order they appear from left to right. (Menu Input | Material Properties…)

1. Concrete strength, $f'c$
2. Concrete modulus of elasticity, $E_c$
3. Concrete maximum stress, $f_c$
4. Beta(1) for concrete stress block
5. Concrete ultimate strain
6. Steel yield strength, $f_y$
7. Steel modulus of elasticity, $E_s$
8. Precast material for concrete. Only applicable for CSA A23.3-14 and CSA A23.3-04.
   0-Non-precast; 1-Precast
9. Standard material for concrete
   0-Non-standard; 1-Standard
10. Standard material for reinforcing steel
    0-Non-standard; 1-Standard
11. Compression-controlled strain limit

[Reduction Factors]

There are 5 values separated by commas in one line in this section. These values are described below in the order they appear from left to right. (Menu Input | Reinforcement | Confinement…)

1. Phi(a) for axial compression
2. Phi(b) for tension-controlled failure
3. Phi(c) for compression-controlled failure
4. Reserved. Do not edit
5. Minimum dimension of tied irregular sections for CSA-A23.3-14; 0-for all other cases

[Design Criteria]

There are 4 values separated by commas in one line in this section. These values are described below in the order they appear from left to right. (Menu Input | Reinforcement | Design Criteria…)

1. Minimum reinforcement ratio
2. Maximum reinforcement ratio
3. Minimum clear spacing between bars
4. Design/Required ratio

[External Points]
This section applies to irregular section in investigation mode only. The first line contains the number of points on exterior section perimeter. Each of the following lines contains 2 values: X and Y coordinates (separated by comma) of a point.

Number of Points, n
Point_1_X, Point_1_Y
Point_2_X, Point_2_Y
...
Point_n_X, Point_n_Y

[Internal Points]
This section applies to irregular section in investigation mode only. The first line contains the number of points on an interior opening perimeter. Each of the following lines contains 2 values: X and Y coordinates (separated by comma) of a point. If no opening exists, then the first line must be 0.

Number of Points, n
Point_1_X, Point_1_Y
Point_2_X, Point_2_Y
...
Point_n_X, Point_n_Y

[Reinforcement Bars]
This section applies to irregular section in investigation mode only. The first line contains the number of reinforcing bars. Each of the following lines contains 3 values: area, X and Y coordinates (separated by comma) of a bar.

Number of bars, n
Bar_1_area, Bar_1_X, Bar_1_Y
Bar_2_area, Bar_2_X, Bar_2_Y
...
Bar_n_area, Bar_n_X, Bar_n_Y
[Factored Loads]

The first line contains the number of factored loads defined. Each of the following lines contains 3 values: axial load, X-moment, and Y-moment separated by commas. (Menu Input | Loads | Factored Loads…)

Number of Factored Loads, n
Load_1, X-Moment_1, Y-Moment_1
Load_2, X-Moment_2, Y-Moment_2
...
Load_n, X-Moment_n, Y-Moment_n

[Slenderness: Column]

This section contains 2 lines describing slenderness parameters for column being designed. The first line is for X-axis parameters, and the second line is for Y-axis parameters.

There are 8 values¹ separated by commas in each line. These values are described below in the order they appear from left to right. (Menu Input | Slenderness | Design Column…)

1. Column clear height
2. k(nonway)
3. k(sway)
4. 0-Sway frame; 1-Nonsway frame
5. 0-Compute ‘k’ factors; 1-Input k factors
6. \((\Sigma P_c)/P_c\)
7. \((\Sigma P_u)/P_u\)
8. 0-Do not ignore moment magnification along column length in sway frames; 1-Ignore moment magnification along column length in sway frames. Use for ACI 318-11 and ACI 318-08 only. For all other codes the value must be 0.

[Slenderness: Column Above And Below]

This section contains 2 lines describing slenderness parameters for column above and column below. The first line is for column above, and the second line is for column below. (Menu Input | Slenderness | Columns Above/Below…)

¹ Value No 8 introduced in spColumn v4.60.
There are 6 values separated by commas in line 1 for column above. These values are described below in the order they appear from left to right.

1. 0-Column specified; 1-No column specified
2. Column Height
3. Column width (along X)
4. Column depth (along Y)
5. Concrete compressive strength, f’c
6. Concrete modulus of elasticity, Ec

There are 6 values separated by commas in line 2 for column below. These values are described below in the order they appear from left to right.

1. 0-Column specified; 1-No column specified
2. Column Height
3. Column width (along X)
4. Column depth (along Y)
5. Concrete compressive strength, f’c
6. Concrete modulus of elasticity, Ec

**[Slenderness: Beams]**

This section contains 8 lines. Each line describes a beam.

Line 1: X-Beam (perpendicular to X), Above Left
Line 2: X-Beam (perpendicular to X), Above Right
Line 3: X-Beam (perpendicular to X), Below Left
Line 4: X-Beam (perpendicular to X), Below Right
Line 5: Y-Beam (perpendicular to Y), Above Left
Line 6: Y-Beam (perpendicular to Y), Above Right
Line 7: Y-Beam (perpendicular to Y), Below Left
Line 8: Y-Beam (perpendicular to Y), Below Right

There are 7 values separated by commas for each beam in each line. (Menu Input | Slenderness | X-Beams…, Input | Slenderness | Y-Beams…) These values are described below in the order they appear from left to right.
1. 0-beam specified; 1-no beam specified
2. Beam span length (c/c)
3. Beam width
4. Beam depth
5. Beam section moment of inertia
6. Concrete compressive strength, \( f'c \)
7. Concrete modulus of elasticity, \( E_c \)

\[ \text{[EI]} \]
Reserved. Do not edit.

\[ \text{[SldOptFact]} \]
There is 1 value in this section for slenderness factors. (Code Default and User Defined radio buttons on menu Input | Slenderness | factors…)
0-Code default; 1-User defined

\[ \text{[Phi_Delta]} \]
There is 1 value in this section for slenderness factors. (Menu Input | Slenderness | factors…)
Stiffness reduction factor

\[ \text{[Cracked I]} \]
There are 2 values separated by commas in one line in this section. These values are described below in the order they appear from left to right. (Menu Input | Slenderness | factors…)
  1. Beam cracked section coefficient
  2. Column cracked section coefficient

\[ \text{[Service Loads]} \]
This section describes defined service loads. (Menu Input | Loads | Service…) The first line contains the number of service loads. Each of the following lines contains values for one service load.
There are 25 values for each service load in one Line separated by commas. These values are described below in the order they appear from left to right.

1. Dead Axial Load
2. Dead X-moment at top
3. Dead X-moment at bottom
4. Dead Y-moment at top
5. Dead Y-moment at bottom
6. Live Axial Load
7. Live X-moment at top
8. Live X-moment at bottom
9. Live Y-moment at top
10. Live Y-moment at bottom
11. Wind Axial Load
12. Wind X-moment at top
13. Wind X-moment at bottom
14. Wind Y-moment at top
15. Wind Y-moment at bottom
16. EQ. Axial Load
17. EQ. X-moment at top
18. EQ. X-moment at bottom
19. EQ. Y-moment at top
20. EQ. Y-moment at bottom
21. Snow Axial Load
22. Snow X-moment at top
23. Snow X-moment at bottom
24. Snow Y-moment at top
25. Snow Y-moment at bottom

[Load Combinations]

This section describes defined load combinations. (Menu Input | Loads | Load Combinations…) The first line contains the number of load combinations. Each of the following lines contains load factors for one load combination.
Number of load combinations, \( n \)
Dead_1, Live_1, Wind_1, E.Q._1, Snow_1
Dead_2, Live_2, Wind_2, E.Q._2, Snow_2
...
Dead_n, Live_n, Wind_n, E.Q._n, Snow_n

[BarGroupType]
There is 1 value in this section. (Bar Set drop-down list on menu Options | Reinforcement…)
0-User defined
1-ASTM615
2-CSA G30.18
3-prEN 10080
4-ASTM615M

[User Defined Bars]
This section contains user-defined reinforcing bars. (Menu Options | Reinforcement…) The first line contains the number of defined bars. Each of the following lines contains values for one bar separated by commas.
Number of user-defined bars, \( n \)
Bar_1_size, Bar_1_diameter, Bar_1_area, Bar_1_weight
Bar_2_size, Bar_2_diameter, Bar_2_area, Bar_2_weight
...
Bar_n_size, Bar_n_diameter, Bar_n_area, Bar_n_weight

[Sustained Load Factors]
There are 5 values separated by commas in one line in this section. Each value respectively represents percentage of Dead, Live, Wind, EQ, and Snow load case that is considered sustained (Menu Input | Loads | Service…).
## A.3 Conversion Factors - English to SI

<table>
<thead>
<tr>
<th>To convert from</th>
<th>To</th>
<th>Multiply by</th>
</tr>
</thead>
<tbody>
<tr>
<td>in.</td>
<td>m (1000 mm)</td>
<td>0.025400</td>
</tr>
<tr>
<td>ft</td>
<td>m</td>
<td>0.304800</td>
</tr>
<tr>
<td>lb</td>
<td>N (0.001 kN)</td>
<td>4.448222</td>
</tr>
<tr>
<td>kip (1000 lbs)</td>
<td>kN</td>
<td>4.448222</td>
</tr>
<tr>
<td>plf (lb/ft)</td>
<td>N/m</td>
<td>14.593904</td>
</tr>
<tr>
<td>psi (lb/in.²)</td>
<td>kPa</td>
<td>6.894757</td>
</tr>
<tr>
<td>ksi (kips/in.²)</td>
<td>MPa</td>
<td>6.894757</td>
</tr>
<tr>
<td>psf (lb/ft²)</td>
<td>N/m² (Pa)</td>
<td>47.88026</td>
</tr>
<tr>
<td>pcf (lb/ft³)</td>
<td>kg/m³</td>
<td>16.018460</td>
</tr>
<tr>
<td>ft-kips</td>
<td>kN • m</td>
<td>1.355818</td>
</tr>
</tbody>
</table>
## A.4 Conversion Factors - SI to English

<table>
<thead>
<tr>
<th>To convert from</th>
<th>To</th>
<th>Multiply by</th>
</tr>
</thead>
<tbody>
<tr>
<td>m (1000 mm)</td>
<td>in</td>
<td>39.37008</td>
</tr>
<tr>
<td>m</td>
<td>ft</td>
<td>3.28084</td>
</tr>
<tr>
<td>N (0.001 kN)</td>
<td>lb</td>
<td>0.224809</td>
</tr>
<tr>
<td>kN</td>
<td>kip (1000 lbs)</td>
<td>0.224809</td>
</tr>
<tr>
<td>kN/m</td>
<td>plf (lb/ft)</td>
<td>68.52601</td>
</tr>
<tr>
<td>MPa</td>
<td>psi (lb/in²)</td>
<td>145.0377</td>
</tr>
<tr>
<td>MPa</td>
<td>ksi (kips/in²)</td>
<td>0.145038</td>
</tr>
<tr>
<td>kN/m² (kPa)</td>
<td>psf (lb/ft²)</td>
<td>20.88555</td>
</tr>
<tr>
<td>kg/m³</td>
<td>pcf (lb/ft³)</td>
<td>0.062428</td>
</tr>
<tr>
<td>kN • m</td>
<td>ft-kips</td>
<td>0.737562</td>
</tr>
</tbody>
</table>
## A.5 Material Strength Value Limits

<table>
<thead>
<tr>
<th></th>
<th>Standard Material</th>
<th>Non-Standard Material</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Min.</td>
<td>Max.</td>
</tr>
<tr>
<td>$f'_c$</td>
<td>2 ksi</td>
<td>12 ksi</td>
</tr>
<tr>
<td>$f_y$</td>
<td>10 ksi</td>
<td>80 ksi</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Standard Material</th>
<th>Non-Standard Material</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Min.</td>
<td>Max.</td>
</tr>
<tr>
<td>$f'_c$</td>
<td>10 MPa</td>
<td>80 MPa</td>
</tr>
<tr>
<td>$f_y$</td>
<td>100 MPa</td>
<td>500 MPa</td>
</tr>
</tbody>
</table>
A.6 Contact Information

Web Site: http://www.StructurePoint.org
info@StructurePoint.org

E-mail:
support@StructurePoint.org

StructurePoint, LLC.
5420 Old Orchard Road
Skokie, IL 60077
USA

Phone: (847) 966-4357
Fax: (847) 966-1542